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1. Introduction
This chapter provides information you need to know before using the machine.

• Key benefits 5
• Features by models 7
• Useful to know 9
• About this user’s guide 10
• Safety information 11
• Machine overview 16
• Control panel overview 19
• Turning on the machine 20
• Installing the driver locally 21
• Reinstalling the driver 22



Key benefits
Environmentally friendly

• To save toner and paper, this machine supports Eco feature (see "Eco 
printing" on page 45).

• To save paper, you can print multiple pages on one single sheet of paper 
(see "Using advanced print features" on page 198).

• To save paper, you can print on both sides of the paper (double-sided 
printing) (or Manual) (see "Using advanced print features" on page 198).

• To save electricity, this machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

Fast high resolution printing

• You can print in a full range of colors using cyan, magenta, yellow, and black.

• You can print with a resolution of up to 9,600 x 600 dpi effective output (600 
x 600 x 4 bit).

• Fast, on-demand printing.

- CLP-41xN/CLP-41xNW Series

▪ For single-side printing, 18 ppm (A4) or 19 ppm (Letter).

- CLP-68xND/ CLP-68xDW Series

▪ For single-side printing, 24 ppm (A4) or 25 ppm (Letter).

▪ For duplex printing, 12 ppm (A4) or 12 ppm (Letter).

Convenience

• You can print on the go from your smartphone or computer using Google 
Cloud Print™ enabled apps (see "Google Cloud Print™" on page 174).

• Easy Capture Manager allows you to easily edit and print whatever you 
captured using the Print Screen key on the keyboard (see "Easy Capture 
Manager" on page 216).

• Samsung Easy Printer Manager and Printing Status is a program that 
monitors and informs you of the machine’s status and allows you to 
customize the machine’s settings (see "Using Samsung Easy Printer 
Manager" on page 223 or "Using Samsung Printer Status" on page 226).

• Samusng AnyWeb Print helps you screen-capture, preview, scrap, and print 
the screen of Windows Internet Explorer more easily, than when you use the 
ordinary program (see "Samsung AnyWeb Print" on page 217).

• Smart Update allows you to check for the latest software and install the 
latest version during the printer driver installation process. This is available 
only for Windows.



Key benefits
• If you have Internet access, you can get help, support application, machine 

drivers, manuals, and order information from the Samsung website, 
www.samsung.com > find your product > Support or Downloads.

Wide range of functionality and application support

• Supports various paper sizes (see "Print media specifications" on page 104).

• Print watermark: You can customize your documents with words, such as 
“CONFIDENTIAL” (see "Using advanced print features" on page 198).

• Print posters: The text and pictures of each page of your document are 
magnified and printed across the multiple sheets of paper and can then be 
taped together to form a poster (see "Using advanced print features" on 
page 198).

• You can print in various operating systems (see "System requirements" on 
page 109).

• Your machine is equipped with a USB interface and/or a network interface.

Supports various wireless network setting method 

• Using the WPS (Wi-Fi Protected Setup™) button

- You can easily connect to a wireless network using the WPS button on 
the machine and the access point (a wireless router).

• Using the USB cable or a network cable

- You can connect and set various wireless network settings using a USB 
cable or a network cable.

• Using the Wi-Fi Direct

- You can conveniently print from your mobile device using the Wi-Fi or 
Wi-Fi Direct feature.

 

See "Introducing wireless set up methods" on page 149.

 

http://www.samsung.com


Features by models
Some features and optional goods may not be available depending on 
model or country.

Operating System

(●: Included, Blank: Not available) 

Software
 

You can install the printer driver and software when you insert the 
software CD into your CD-ROM drive.

For windows, select the printer driver and software in the Select 
Software to Install window.

 

(●: Included, Blank: Not available) 

Operating System
CLP-41xN Series

CLP-41xNW Series
CLP-68xND Series
CLP-68xDW Series

Windows ● ●

Mac ● ●

Linux ● ●

Unix ● ●

Software
CLP-41xN Series

CLP-41xNW Series
CLP-68xND Series
CLP-68xDW Series

SPL printer driver ● ●

PCL printer driver ● ●

PS printer driver ● ●

XPS printer driver ● ●

Samsung 
Easy Printer 
Manager

Device 
Settings

● ●

Samsung Printer Status ● ●

Direct Printing Utilitya

a. Download the software from the Samsung website and install it: (http://
www.samsung.com > find your product > Support or Downloads). Before installing, 
check whether your computer’s OS support the software.

● ●

Samsung AnyWeb Printa ● ●

SyncThru™ Web Service ● ● 

SyncThru Admin Web 
Service

● ● 

Easy Eco Driver ● ●

Easy Capture Manager ● ●

Samsung Easy Color 

Managera

● ●

http://www.samsung.com
http://www.samsung.com


Features by models
Variety feature

(●: Included, ○: optional, Blank: Not available ) 

Features
CLP-41xN Series

CLP-41xNW Series
CLP-68xND Series
CLP-68xDW Series

Hi-Speed USB 2.0 ● ●

IEEE 1284B parallel connectora

a. If you use the parallel port, you cannot use the USB cable.

○

Network Interface Ethernet 10/
100/1000 Base TX wired LAN

● ● 

Network Interface 802.11b/g/n 

wireless LANb

b. Depending on your country, wireless LAN card may not be available. For some counties, 
only 802.11 b/g can be applied. Contact your local Samsung dealer or the retailer where 
you bought your machine.

● 

CLP-41xNW Series 
only

● 

CLP-68xDW Series 
only

Eco printing ● ●

Duplex (2-sided) printing ●

Duplex (2-sided) printing 

(manual)c d

c. Available for Windows OS users only.

●

USB memory interface ●

Memory module ○ ○

Optional tray (Tray2) ○

Mass Storage Device (HDD)

AirPrint ●

Google Cloud Print™ ● ●

d. Only tray1 is supported.



Useful to know

The machine does not print.

• Open the print queue list and remove the document from 
the list (see "Canceling a print job" on page 43).

• Remove the driver and install it again (see "Installing the 
driver locally" on page 21).

• Select your machine as your default machine in your 
Windows (see "Setting your machine as a default machine" 
on page 197).

Where can I purchase accessories or supplies?

• Inquire at a Samsung distributor or your retailer.

• Visit www.samsung.com/supplies. Select your country/
region to view product service information.

The status LED flashes or remains constantly 
on.

• Turn the product off and on again.

• Check the meanings of LED indications in this manual and 
troubleshoot accordingly (see "Understanding the status 
LED" on page 93).

A paper jam has occurred.

• Open and close the door (see "Front view" on page 17).

• Check the instructions on removing jammed paper in this 
manual and troubleshoot accordingly (see "Clearing paper 
jams" on page 81).

Printouts are blurry.

• The toner level might be low or uneven. Shake the toner 
cartridge (see "Redistributing toner" on page 60).

• Try a different print resolution setting (see "Opening 
printing preferences" on page 43).

• Replace the toner cartridge (see "Replacing the toner 
cartridge" on page 62).

Where can I download the machine’s driver?

• You can get help, support application, machine drivers, 
manuals, and order information from the Samsung 
website, www.samsung.com > find your product > 
Support or Downloads.

http://www.samsung.com
http://www.samsung.com


101. Introduction

About this user’s guide
This user's guide provides information for your basic understanding of the 
machine as well as detailed steps to explain machine usage.

• Read the safety information before using the machine.

• If you have a problem using the machine, refer to the troubleshooting 
chapter.

• Terms used in this user’s guide are explained in the glossary chapter.

• All illustrations in this user’s guide may differ from your machine depending 
on its options or model you purchased.

• The screenshots in this user’s guide may differ from your machine 
depending on the machine’s firmware/driver version.

• The procedures in this user’s guide are mainly based on Windows 7.

1 

Conventions

Some terms in this guide are used interchangeably, as below:

• Document is synonymous with original.

• Paper is synonymous with media, or print media.

• Machine refers to printer or MFP.

2 

General icons

Icon Text Description

Caution
Gives users information to protect the machine from 
possible mechanical damage or malfunction.

Note
Provides additional information or detailed 
specification of the machine function and feature.
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Safety information
These warnings and precautions are included to prevent injury to you and 
others, and to prevent any potential damage to your machine. Be sure to read 
and understand all of these instructions before using the machine. After reading 
this section, keep it in a safe place for future reference.

3 

Important safety symbols

Explanation of all icons and signs used in this chapter

4 

Operating environment

 Warning

Warning
Hazards or unsafe practices that may result in severe 
personal injury or death.

Caution
Hazards or unsafe practices that may result in minor 
personal injury or property damage.

Do not attempt.

Do not use if the power cord is damaged or if the electrical outlet is 
not grounded.

This could result in electric shock or fire. 

Do not place anything on top of the machine (water, small metal or 
heavy objects, candles, lit cigarettes, etc.).

This could result in electric shock or fire. 

• If the machine gets overheated, it releases smoke, makes 
strange noises, or generates an odd odor, immediately turn off 
the power switch and unplug the machine.

• The user should be able to access the power outlet in case of 
emergencies that might require the user to pull the plug out.

This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power cord. 

Stepping on or allowing the power cord to be crushed by a heavy 
object could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not handle the 
plug with wet hands. 

This could result in electric shock or fire. 
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 Caution
5 

Operating method

 Caution
During an electrical storm or for a period of non-operation, 
remove the power plug from the electrical outlet. 

This could result in electric shock or fire. 

Be careful, the paper output area is hot. 

Burns could occur. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections and 
request assistance from qualified service personnel.

Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these instructions 
have been followed, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.

Otherwise, this could result in electric shock or fire.

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

Call an electrician to change the electrical outlet, or this could 
result in electric shock.

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

This could result in electric shock or fire and/or injury to your pet. 

Do not forcefully pull the paper out during printing. 

It can cause damage to the machine.

Be careful not to put your hand between the machine and paper 
tray.

You may get injured.

Be care when replacing paper or removing jammed paper. 

New paper has sharp edges and can cause painful cuts.

When printing large quantities, the bottom part of the paper 
output area may get hot. Do not allow children to touch. 

Burns can occur.

When removing jammed paper, do not use tweezers or sharp metal 
objects. 

It can damage the machine.

Do not allow too many papers to stack up in the paper output tray.

It can damage the machine. 
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6 

Installation / Moving

 Warning

 CautionDo not block or push objects into the ventilation opening.

This could result in elevated component temperatures which can 
cause damage or fire.

Use of controls or adjustments or performance of procedures other 
than those specified herein may result in hazardous radiation 
exposure.

This machine's power reception device is the power cord. 

To switch off the power supply, remove the power cord from the 
electrical outlet. 

Do not place the machine in an area with dust, humidity, or water 
leaks. 

This could result in electric shock or fire. 

Before moving the machine, turn the power off and disconnect all 
cords. The information below are only suggestions based on the 
units weight.

If you have a medical condition that prevents you from lifting, do 
not lift the machine. Ask for help, and always use the appropriate 
amount of people to lift the device safety.

Then lift the machine:

•  If the machine weighs under 20 kg (44.09 lbs), lift with 1 person.

•  If the machine weighs 20 kg (44.09 lbs) - 40kg (88.18 lbs), lift 
with 2 people.

•  If the machine weighs more than 40 kg (88.18 lbs), lift with 4 or 
more people.

The machine could fall, causing injury or machine damage.

Do not place the machine on an unstable surface.

The machine could fall, causing injury or machine damage.

Use only No.26 AWGa or larger, telephone line cord, if necessary.

Otherwise, it can cause damage to the machine.

Make sure you plug the power cord into a grounded electrical 
outlet.

Otherwise, this could result in electric shock or fire.
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7 

Maintenance / Checking

 Caution

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters (6 
feet) with a 110V machine, then the gauge should be 16 AWG or 
larger.

Otherwise, it can cause damage to the machine, and could result 
in electric shock or fire.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

If the machine is not well-ventilated, this could result in fire.

Do not overload wall outlets and extension cords.

This can diminish performance, and could result in electric shock 
or fire.

The machine should be connected to

the power level which is specified on the label.

If you are unsure and want to check the power level you are using, 
contact the electrical utility company.

a. AWG: American Wire Gauge

Unplug this product from the wall outlet before cleaning the 
inside of the machine. Do not clean the machine with benzene, 
paint thinner or alcohol; do not spray water directly into the 
machine. 

This could result in electric shock or fire. 

When you are working inside the machine replacing supplies or 
cleaning the inside, do not operate the machine.

You could get injured.

Keep cleaning supplies away from children. 

Children could get hurt.

Do not disassemble, repair or rebuild the machine by yourself. 

It can damage the machine. Call a certified technician when the 
machine needs repairing.

To clean and operate the machine, strictly follow the user's guide 
provided with the machine.

Otherwise, you could damage the machine.
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8 

Supply usage

 Caution

Keep the power cable and the contact surface of the plug clean 
from dust or water.

Otherwise, this could result in electric shock or fire. 

• Do not remove any covers or guards that are fastened with 
screws. 

• Fuser units should only be repaired by a certified service 
technician. Repair by non-certified technicians could result in 
fire or electric shock.

• The machine should only be repaired by a Samsung service 
technician.

Do not disassemble the toner cartridge.

Toner dust can be dangerous if inhaled or ingested.

Do not burn any of the supplies such as toner cartridge or fuser 
unit.

This could cause an explosion or uncontrollable fire.

When storing supplies such as toner cartridges, keep them away 
from children.

Toner dust can be dangerous if inhaled or ingested.

Using recycled supplies, such as toner, can cause damage to the 
machine.

In case of damage due to the use of recycled supplies, a service 
fee will be charged.

When toner gets on your clothing, do not use hot water to wash 
it.

Hot water sets toner into fabric. Use cold water.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

Toner dust can be dangerous if inhaled or ingested.
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Machine overview
9 

Accessories

Power cord Quick installation guide

Software CDa

a. The software CD contains the print drivers, user’s guide, and software applications.

Misc. accessoriesb

b. Miscellaneous accessories included with your machine may vary by country of purchase and specific model.
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10 

Front view

 

• This illustration may differ from your machine depending on your model. 
There are various types of machine.

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

 

CLP-41xN Series/CLP-41xNW Series

1 Output support 7 Front cover release button
2 Output tray 8 Toner cartridges
3 Control panel 9 Toner cartridge handle
4 Control board cover 10 Intermediate Transfer Belt (ITB)
5 Tray 1 11 Paper width guides on a manual feeder
6 Front cover 12 Manual feeder

1 2

3

4

5

6

7

11

8

9

10

12

CLP-68xND Series/ CLP-68xDW Series

1 Output support 9 Multi-purpose tray

2 Output tray 10 Front cover

3 Control panel 11 Front cover release button

4 Control board cover 12 Toner cartridges

5 USB memory port 13 Toner cartridge handle

6 Optional traya

a. This is an optional feature. CLP-68xND Series/CLP-68xDW Series only.

14 Intermediate Transfer Belt (ITB)

7
Tray 1

15 Paper width guides on a multi-
purpose tray

8 Push-release of Multi-purpose 
tray

16
Multi-purpose support tray

1 2

3

4

6 5

8

10

11 12
13

14

15

 16

 7

9
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11 

Rear view

 

• This illustration may differ from your machine depending on your model. There are various types of machine.

• Some features and optional goods may not be available depending on model or country (see "Features by models" on page 7).

 

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

1 Waster toner container 5 Power-switch
2 Rear cover 6 USB porta

a. The optional IEEE 1284B parallel connector can be used by plugging in both the USB port and the 5V output port.

3 Rear cover handle 7 Network port
4 Power receptacle 8 5V output port for IEEE 1284B parallel connector a b

b. This is an optional feature. CLP-68xND Series/CLP-68xDW Series only.

23
5

6

7

1

4

23

6

7

8

1
4

5



191. Introduction

Control panel overview
 

• This control panel may differ from your machine depending on its model. 
There are various types of control panels.

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

 

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

1
Display screen

Shows the current status and prompts during an 
operation. 

2

89

10

4

7

6

5

11

3

1

3

4

7

89

11

12

10

6

5

2

1

2
Toner 
colors

Show the status of each toner cartridge. If the toner 
cartridge is low or needs to be replaced, the Status 
LED turns red and the display shows the message. 
However the arrow mark shows which color toner is 
of concern or may be installed with a new cartridge 
(see "Toner-related messages" on page 97).

3 Menu  
Enters menu mode and scrolls through the available 
menus (see "Accessing the menu" on page 25).

4 Arrow
Navigates available values by moving to the next or 
previous options.

5 OK Confirms the selection on the screen. 

6 Back  Sends you back to the upper menu level.

7 Cancel
Stops current operation.

8 Power
You can turn the power on and off with this button. 
Or wake up from the power save mode.

9 LED

Indicates the status of your machine (see 
"Understanding the status LED" on page 93). 

a Indicates the wireless status of your machine (see 
"Understanding the status LED" on page 93). 

10
WPSa

Configures the wireless network connection easily 
without a computer (see "Using the WPS button" on 
page 150).

Demo 
page

Prints a demo page by pressing this button.

11 Eco
Enters eco mode to reduce toner consumption and 
paper usage (see "Eco printing" on page 45).

12
Numeric keypad Use the keypad to enter numbers and characters (see 

"Keypad letters and numbers" on page 196).

a. CLP-41xNW Series/CLP-68xDW Series only.
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Turning on the machine
1 Connect the machine to the electricity supply first.

Turn the switch on if the machine has a power switch.

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

2 Power is turned on automatically.

 

 If you want to turn the power off, press the  (Power) button.

 

1

2
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Installing the driver locally
A locally connected machine is a machine directly attached to your computer 
using the cable. If your machine is attached to a network, skip the following 
steps below and go on to installing a network connected machine’s driver (see 
"Installing driver over the network" on page 137).

 

• If you are a Mac, Linux, or UNIX operating systems user, refer to the 
"Installation for Mac" on page 128, "Installation for Linux" on page 130, or 
"Installing the UNIX printer driver package" on page 142.

• The installation window in this User’s Guide may differ depending on the 
machine and interface in use.

• Only use a USB cable no longer than 3 meters (118 inches).

 

12 

Windows

1 Make sure that the machine is connected to your computer and 
powered on.

 

If the “Found New Hardware Wizard” appears during the installation 
procedure, click Cancel to close the window.

 

2 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

 X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

3 Select Install Now.

4 Follow the instructions in the installation window.

 

You can select the software applications in the Select Software to Install 
Window.
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Reinstalling the driver
If the printer driver does not work properly, follow the steps below to reinstall 
the driver.

13 

Windows

1 Make sure that the machine is connected to your computer and 
powered on.

2 From the Start menu, select Programs or All Programs > Samsung 
Printers > your printer driver name > Uninstall.

3 Follow the instructions in the uninstall window.

4 Insert the software CD into your CD-ROM drive and install the driver 
again (see "Installing the driver locally" on page 21).



2. Menu Overview and 
Basic Setup

This chapter provides information about the overall menu structure and the basic setup options.

• Menu overview 25
• Machine’s basic settings 28
• Media and tray 30
• Basic printing 42
• Using USB memory device 48



252. Menu Overview and Basic Setup

Menu overview
The control panel provides access to various menus to set up the machine or use the machine’s functions.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Some menu names may differ from your machine depending on its options or the models.

• The menus are described in the Advanced Guide (see "Useful Setting Menus" on page 177).

 

1 

Accessing the menu

1 Press  (Menu) button on the control panel.

2 Press the arrows until the needed menu item appears and press OK.

3 If the setting item has sub menus, repeat step 2.

4 Press OK to save the selection.

5 Press (Cancel) to return to the ready mode.
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Information Layout Paper Graphic System Setup
Menu Map

Configuration

Supplies Info.

Demo Page

PCL Font List

PS Font List

Usage Counter

Accounta

a. This is used only available when Job Accounting is enabled from the SyncThru™ Web Admin Service.

Orientation

Portrait

Landscape

Margin

Common Margin

Manual Feederb

MP Trayc

Tray 1

Tray 2d

Emulation Mar.

Duplexc

Off

Long Edge

Short Edge

b. CLP-41xN Series/CLP-41xNW Series only.
c. CLP-68xND Series/CLP-68xDW Series only.
d. This is an optional feature. CLP-68xND Series/CLP-68xDW Series only.

Copies

Manual Feederb

Paper Size

Paper Type

MP Trayc

Paper Size

Paper Type

Tray 1

Paper Size

Paper Type

Paper Source

Auto

Tray 1

Tray 2d

MP Trayc

Manual Feederb

Resolution

Normal

Best

Clear Text

Off

Minimum

Normal

Maximum

Edge Enhance

Off

Normal

Maximum

Trapping

Off

Medium

Maximum

Screen

Normal

Enhanced

Detailed

Date & Time

Clock Mode

Language

Power Save

Wakeup Event

Job Timeout

Import Settingc

Export Settingc

Altitude Adj.

Normal

High 1

High 2

High 3

Humidity

Normal

High 1

High 2

High 3

Auto Continue

Auto CR

Auto Tray Swi.c

Paper Substit.

Tray Protectc

Skip BlankPage

Maintenance

CLR Empty Msg.e

Supplies Life

TonerLow Alert

Paper Stacking

Ram Diskc

Eco Setup

Default Mode

Change Temp.

Vapor Mode

Auto Power Off

e. This option only appears when small amount of toner is left in the cartridge.
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Emulation Image Mgr. Network Direct USBa

a. CLP-68xND Series/CLP-68xDW Series only. This option is available When USB memory is inserted into the USB memory port on your machine.

Job Manageb

b. CLP-68xND Series/CLP-68xDW Series only. This option is available when the optional memory installed or Ram disk is checked.

Emulation Type

Setup

Custom Color

Default

Print Density

Auto Color Reg

Tone Adjust.

Default

Auto Tone Adj.

Cal. ID Sensor

TCP/IP (IPv4)

DHCP

BOOTP

Static

TCP/IP (IPv6)

IPv6 Activate

DHCPv6 Config

Ethernet Speed

Automatic

10Mbps Half

10Mbps Full

100Mbps Half

100Mbps Full

1Gbps Full

802.1x

Wirelessc

Wi-Fi ON/OFF

c. CLP-41xNW Series/CLP-68xDW Series only.

Wi-Fi Direct

On/Off

Device Name

IP Address

Group Owner

Network Key

Status

WPS Setting

PBC

PIN

WLAN Settingd

Wizard

Custom

WLAN 
Default

d. CLP-68xDW Series only.

WLAN Signal

Excellent

Very Good

Good

Low

Very Low

No Signal

Clear Settings

Network Conf.

Net. Activate

Http Activate

WINS

SNMP V1/V2

SNTP

UPnP(SSDP)

MDNS

SetIP

SLP

USB Print

File Manage

Check Space

Active Job

Secured Job

Stored Job

Print

Delete

File Policy

Rename

Overwrite
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Machine’s basic settings
 

You can set the machine’s settings by using the Device Settings in 
Samsung Easy Printer Manager program.

• For Windows and Mac users, you set from Samsung Easy Printer 

Manager > (Switch to advanced mode) > Device Settings, see 
"Device Settings" on page 225.

 

After installation is complete, you may want to set the machine's default 
settings. 

To change the machine’s default settings, follow these steps:

 

It may be necessary to press OK to navigate to lower-level menus for some 
models.

 

1 Select (Menu) button on the control panel.

2 Press System Setup.

3 Select the option you want, then press OK.

• Language: Change the language that is displayed on the control 
panel.

• Date & Time: You can set the time and date. They are printed on 
reports. If, however, they are not correct, you need to change it for 
the correct time being.

 

Enter the correct time and date using arrows or numeric keypad (see 
"Keypad letters and numbers" on page 196).

• Month = 01 to 12

• Day = 01 to 31

• Year = requires four digits

• Hour = 01 to 12

• Minute = 00 to 59

 

• Clock Mode: You can set your machine to display the current time 
using either a 12-hour or 24-hour format.

• Power Save: When you are not using the machine for a while, use 
this feature to save power.

 

• When you press the power button or start printing, the product will wake 
up from the power saving mode.

• When you press any button except power button, the machine wake up 

from the power save mode. Press (Menu) > System Setup >  

Wakeup Event > On on the control panel. 

 

• Altitude Adj.: Print quality is affected by atmospheric pressure, 
which atmospheric pressure is determined by the height of the 
machine above sea level. Before you set the altitude value, 
determine the altitude where you are (see "Altitude adjustment" on 
page 195).
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4 Select the option you want, then press OK.

5 Press OK to save the selection.

6 Press (Cancel) to return to ready mode.

 

Refer to below links to set other settings useful for using the machine.

• See "Setting the paper size and type" on page 40.

• See "Keypad letters and numbers" on page 196.
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Media and tray
This chapter provides information on how to load print media into your 
machine.

 

• Using print media that does not meet these specifications may cause 
problems or require repairs. Such repairs are not covered by Samsung’s 
warranty or service agreements.

• Make sure not to use the inkjet photo paper with this machine. It could 
cause damage to the machine. 

• Using inflammable print media can cause a fire.

• Use designated print media (see "Print media specifications" on page 
104).

• Make sure not to use the inkjet photo paper with this machine. It could 
cause damage to the machine. 

 

 

The use of inflammable media or foreign materials left in the printer may 
lead to overheating of the unit and, in rare cases may cause a fire.

 

2 

Tray overview

To change the size, you need to adjust the paper guides.

1 Tray extend lever

2 Paper length guide

3 Paper width guide

4 Paper width guides on a manual feeder

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

2

3

1

4

2

3

1
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For Legal-sized paper:

Push button as shown and pull out the tray. 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Tray overview" on 
page 30).

 

 

If you do not adjust the guide, it may cause paper registration, image skew, 
or jamming of the paper.

 

3 

Loading paper in the tray

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

Tray 1 / optional tray

1 Pull out the paper tray.

LGL
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2 Squeeze and the paper width guide and paper length lever to locate 
them in the correct paper size slot marked at the bottom of the tray to 
adjust to the size (see "Tray overview" on page 30).

3 Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

4 After inserting paper into the tray, squeeze the paper width guides and 
paper length guide.

1 Paper length guide

2 Paper width guide

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

2

1

2

1
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• Do not push the paper width guide too far causing the media to warp.

• If you do not adjust the paper width guide, it may cause paper jams.

• Do not use a paper with a leading-edge curl, it may cause a paper jam or 
the paper can be wrinkled.

 

5 Insert the tray back into the machine.

6 When you print a document, set the paper type and size for the tray (see 
"Setting the paper size and type" on page 40).

 

The settings made from the machine driver override the settings on the 
control panel.

a To print in application, open an application and start the print menu.
b Open Printing Preferences (see "Opening printing preferences" on 

page 43).
c Press the Paper tab in Printing Preferences, and select an appropriate 

paper type. 
d Select Auto Select in paper source, then press OK.
e Start printing in application.

 

Multi-purpose (or Manual feeder ) tray

The multi-purpose (or manual feeder) tray can hold special sizes and types of 
print material, such as postcards, note cards, and envelopes (see "Print media 
specifications" on page 104). 

Tips on using the multi-purpose (or manual feeder) tray

• Load only one type, size and weight of print media at a time in the multi-
purpose (or manual feeder) tray.

• To prevent paper jams, do not add paper while printing when there is still 
paper in the multi-purpose (or manual feeder) tray. This also applies to other 
types of print media.
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• Always load the specified print media only to avoid paper jams and print 
quality problems (see "Print media specifications" on page 104). 

• Flatten any curl on postcards, envelopes, and labels before loading them 
into the multi-purpose (or manual feeder) tray.

1 Pull out the paper tray for manual feeding.

OR

Press the push-release of multi-purpose tray and it down to open.

2 Load the paper.

3 Squeeze the multi-purpose (or manual feeder) tray paper width guides 
and adjust them to the width of the paper. Do not force them too much, 
or the paper will bent resulting in a paper jam or skew.

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

 2

 1
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• When printing the special media, you must follow the loading guideline 
(See "Printing on special media" on page 35).

• When papers overlap when printing using multi-purpose tray, open tray 
1 and remove overlapping papers then try printing again. 

 

4 When you print a document, set the paper type and size for the multi-
purpose (or manual feeder) tray (see "Setting the paper size and type" on 
page 40).

 

The settings made from the machine driver override the settings on the 
control panel.

a To print in application, open an application and start the print menu.
b Open Printing Preferences (See "Opening printing preferences" on 

page 43).
c Press the Paper tab in Printing Preferences, and select an appropriate 

paper type. 
For example, if you want to use a label, set the paper type to Label.

d Select Manual Feeder (or MP Tray) in paper source, then press OK.
e Start printing in application.

If your machine has multi-purpose tray, press OK on the control panel 
each time you load a sheet of paper.

 

4 

Printing on special media

The table below shows the special media usable in tray. 

The media is also shown in the Printing Preferences. To get the highest 
printing quality, select the proper media type from the Printing preferences 
window > Paper tab > Paper Type (see "Opening printing preferences" on page 
43).

For example, if you want to print on labels, select Labels for Paper Type.

 

• When using special media, we recommend you feed one sheet at a time 
(see "Print media specifications" on page 104).

• Illustrations on this user’s guide may differ from your machine 
depending on its options or models. Check your machine type (see 
"Front view" on page 17).

 

To see for paper weights for each sheet, refer to "Print media specifications" on 
page 104.

Types Tray 1 Optional traya Manual feeder/ Multi-
purpose tray

Plain ● ● ●

Thick ● ● ●

Thicker ● ●
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(●: Supported, Blank: Not supported) 

Envelope

Printing successfully on envelopes depends upon the quality of the envelopes. 

To print an envelope, place it as shown in the following figure.

• When selecting envelopes, consider the following factors:

- Weight: should not exceed 90 g/m2 otherwise; jams may occur.

- Construction: should lie flat with less than 6 mm curl and should not 
contain air.

- Condition: should not be wrinkled, nicked, nor damaged.

- Temperature: should resist the heat and pressure of the machine 
during operation.

• Use only well-constructed envelopes with sharp and well-creased folds.

• Do not use stamped envelopes.

Thin ● ● ●

Cotton ● ●

Color ● ●

Preprinted ● ●

Recycled ● ● ●

Envelope ● ●

Transparency ● ●

Labels ● ●

CardStock ● ● ●

Bond ● ● ●

Archive ● ● ●

Letterhead ● ● ●

Punched ● ● ●

Glossy Photo ● ● ●

a. CLP-68xND Series/CLP-68xDW Series only.

Types Tray 1 Optional traya Manual feeder/ Multi-
purpose tray

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series
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• Do not use envelopes with clasps, snaps, windows, coated lining, self-
adhesive seals, or other synthetic materials.

• Do not use damaged or poorly made envelopes.

• Be sure the seam at both ends of the envelope extends all the way to the 
corner of the envelope.

1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s fusing 
temperature for 0.1 second about 170°C (338 °F). The extra flaps and strips 
might cause wrinkling, creasing, or jams, and may even damage the fuser.

• For the best print quality, position margins no closer than 15 mm from the 
edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparency

 

In case of color printing using transparencies, the picture quality would be 
lower than mono printing when the printouts are used on the overhead 
projector.

 

To avoid damaging the machine, use only transparencies designed for use in 
laser printers.

• Must withstand the machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.

• Do not leave unused transparencies in the paper tray for long. Dust and dirt 
may accumulate on them, resulting in spotty printing.

• To avoid smudging caused by fingerprints, handle them carefully.

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series
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• To avoid fading, do not expose printed transparencies to prolonged 
sunlight.

• Ensure that transparencies are not wrinkled, curled, or have any torn edges.

• Do not use transparencies that separate from the backing sheet.

• To prevent transparencies from sticking to each other, do not let the printed 
sheets stack up as they are being printed out.

• Recommended media: Transparency for a color laser printer by Xerox, such 
as 3R 91331(A4), 3R 2780 (Letter).

Labels

To avoid damaging the machine, use only labels designed for use in laser 
printers.

• When selecting labels, consider the following factors:

- Adhesives: Should be stable at your machine’s fusing temperature 
about 170°C (338°F).

- Arrangement: Only use labels with no exposed backing between them. 
Labels can peel off sheets that have spaces between the labels, causing 
serious jams.

- Curl: Must lie flat with no more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series
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• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can cause 
paper jams. Exposed adhesive can also cause damage to machine 
components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the machine.

• Do not use labels that are separating from the backing sheet or are wrinkled, 
bubbled, or otherwise damaged.

Card stock/ Custom-sized paper

• In the software application, set the margins to at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Preprinted paper

When loading preprinted paper, the printed side should be facing up with an 
uncurled edge at the front. If you experience problems with paper feeding, turn 
the paper around. Note that print quality is not guaranteed.

• Must be printed with heat-resistant ink that will not melt, vaporize, or 
release hazardous emissions when subjected to the machine’s fusing 
temperature for 0.1 second (about 170°C (338°F)).

• Preprinted paper ink must be non-flammable and should not adversely 
affect machine rollers.

• Before you load preprinted paper, verify that the ink on the paper is dry. 
During the fusing process, wet ink can come off preprinted paper, reducing 
print quality.

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series

AAAAA

CLP-41xN Series/CLP-41xNW Series CLP-68xND Series/ CLP-68xDW Series
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Glossy Photo

• Recommended media: Glossy paper (Letter) for this machine by HP 
Brochure Paper (Product: Q6611A) only.

• Recommended media: Glossy paper (A4) for this machine by HP Superior 
Paper 160 glossy (Product: Q6616A).

5 

Setting the paper size and type

After loading paper in the paper tray, set the paper size and type using the 
control panel buttons. 

 

• You can set the machine’s settings by using the Device Settings in 
Samsung Easy Printer Manager program.

- For Windows and Mac users, you set from Samsung Easy Printer 

Manager > (Switch to advanced mode) > Device Settings, 
see "Device Settings" on page 225.

• It may be necessary to press OK to navigate to lower-level menus for 
some models.

 

1 Select (Menu) button on the control panel.

2 Press Paper and select the tray you want.

3 Press Paper Size or Paper Type.

4 Select the option you want.

5 Press OK to save the selection.

6 Press (Cancel) to return to ready mode.

 

• The settings set from the machine driver override the settings on the 
control panel.
a To print from an application, open an application and start the print 

menu.
b Open Printing Preferences (see "Opening printing preferences" on 

page 43).

c Press the Paper tab and select an appropriate paper. 

• If you want to use special-sized paper such as billing paper, select the 
Paper tab > Size > Edit... and set Custom Paper Size Settings in the 
Printing Preferences (see "Opening printing preferences" on page 43).
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6 

Using the output support

 

The surface of the output tray may become hot if you print a large number 
of pages at once. Make sure that you do not touch the surface, and do not 
allow children near it.

 

The printed pages stack on the output support, and the output support will help 
the printed pages to align. Unfold the output support. 

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).
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Basic printing 
 

For special printing features, refer to the Advanced Guide (see "Using 
advanced print features" on page 198).

 

7 

Printing

 

If you are a Mac, Linux, or Unix operating systems user, refer to the 
Advanced Guide (see "Mac printing" on page 207, "Linux printing" on page 
209, or "Unix printing" on page 211).

 

The following Printing Preferences window is for Notepad in Windows 7.

1 Open the document you want to print.

2 Select Print from the File menu.

3 Select your machine from the Select Printer list.

4 The basic print settings including the number of copies and print range 
are selected within the Print window. 

 

To take advantage of the advanced printing features, click Properties or 
Preferences from the Print window (see "Opening printing preferences" on 
page 43).

 

5 To start the print job, click OK or Print in the Print window.
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8 

Canceling a print job

If the print job is waiting in the print queue or print spooler, cancel the job as 
follows:

• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Cancel) on the control 

panel.

9 

Opening printing preferences

 

• The Printing Preferences window that appears in this user’s guide may 
differ depending on the machine in use. 

• When you select an option in Printing Preferences, you may see a 
warning mark  or . An  mark means you can select that certain 

option but it is not recommended, and an  mark means you cannot 
select that option due to the machine’s setting or environment.

 

1 Open the document you want to print.

2 Select Print from the file menu. The Print window appears. 

3 Select your machine from the Select Printer. 

4 Click Properties or Preferences. 

 

The screenshot may differ depending on model.

 

 

• You can apply Eco features to save paper and toner before printing (see 
"Easy Eco Driver" on page 219).

• You can check the machine’s current status pressing the Printer Status 
button (see "Using Samsung Printer Status" on page 226).
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Using a favorite setting

The Favorites option, which is visible on each preferences tab except for the 
Samsung tab, allows you to save the current preferences for future use.

To save a Favorites item, follow these steps:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box.

3 Click Save. 

4 Enter name and description, and then select the desired icon.

5 Click OK. When you save Favorites, all current driver settings are saved.

 

To use a saved setting, select it in the Favorites tab. The machine is now set 
to print according to the settings you have selected.

To delete saved settings, select it in the Favorites tab and click Delete. 

 

10 

Using help

Click the option you want to know on the Printing Preferences window and 
press F1 on your keyboard.
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11 

Eco printing

The Eco function cuts toner consumption and paper usage. The Eco function 
allows you to save print resources and lead you to eco-friendly printing.

If you press the Eco button from the control panel, eco mode is enabled. The 
default setting of Eco mode is duplex (CLP-68xND Series/CLP-68xDW Series 
only), Multiple Pages per Side (2-up), skip blank pages.

 

You can set the machine’s settings by using the Device Settings in 
Samsung Easy Printer Manager program.

• For Windows and Mac users, you set from Samsung Easy Printer 

Manager > (Switch to advanced mode) > Device Settings, see 
"Device Settings" on page 225.

 

Setting Eco mode on the control panel

 

• The settings set from the machine’s driver override the settings on the 
control panel.

• It may be necessary to press OK to navigate to lower-level menus for 
some models.

 

1 Select (Menu) > System Setup > Eco Setup on the control panel.

2 Select the option you want and press OK.

• Default Mode: Select this to turn on or off the eco mode.

- Off: Set the eco mode off.

- On: Set the eco mode on.

 

If you set the eco mode on with a password from the SyncThru™ Web 
Service (Settings tab > Machine Settings > System > Eco Settings) or 
Samsung Easy Printer Manager (Device Settings > Eco), the On force 
message appears. You have to enter the password to change the eco mode 
status.

 

• Change Temp.: Follow the settings from Syncthru™ Web Service or 
Samsung Easy Printer Manager. Before you select this item, you 
must set the eco function in SyncThru™ Web Service (Settings tab > 
Machine Settings > System > Eco Settings) or Samsung Easy 
Printer Manager (Device Settings > Eco). 

- Default Eco: The machine is set to Default Eco mode.

- Custom Eco: Change any necessary values.

3 Press OK to save the selection.
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Setting eco mode on the driver

 

To take advantage of the advanced printing features, click Properties or 
Preferences from the Print window (see "Opening printing preferences" on 
page 43).

 

Open the Eco tab to set Eco mode. When you see the eco image ( ), that 
means the eco mode is currently enabled.

Eco options

• Printer Default: Follows the settings from the machine's control panel.

• None: Disables Eco mode.

• Eco Printing: Enables eco mode. Activate the various Eco items you want to 
use.

• Password: If the administrator fixed to enable the Eco mode, you have to 
enter the password to change the status.

 

Password button: You can set from SyncThru™ Web Service (Settings tab > 
Machine Settings > System > Eco Settings) or Samsung Easy Printer 

Manager (Device Settings > Eco), the password button is activated. To 
change the print settings, click on this button, enter the password or need 
to contact the administrator.

 

Result simulator

Result Simulator shows the results of reduced emission of carbon dioxide, used 
electricity, and the amount of saved paper in accordance with the settings you 
selected.

• The results are calculated on the basis that the total number of printed 
paper is one hundred without a blank page when the Eco mode is disabled.

• Refers to the calculation coefficient about CO2, energy, and paper from IEA, 
the index of Ministry of Internal Affairs and Communication of Japan and 
www.remanufacturing.org.uk. Each model has a different index. 

• The power consumption in printing mode refers to the average printing 
power consumption of this machine. 

• The actual amount displayed is only an estimate as the actual amount may 
differ depending on the operating system used, computing performance, 
application software, connection method, media type [thickness], media 
size, job complexity, etc.

12 

Secure printing

 

CLP-68xND Series/ CLP-68xDW Series only.

 

When you use a printing device in an office, school or other public place, you can 
protect your personal documents or confidential information by using the 
secure printing feature.



Basic printing

472. Menu Overview and Basic Setup

Starting secure printing on the driver

Open the Printing Preferences window (see "Opening printing preferences" on 
page 43), and the select Advanced tab >  Print Mode >  Confidential. Enter the 
job name, user ID, and password. Even though you have started the secure 
printing job, the device will not print the document until you enter your 
password on the printer.

 

You can use this feature after installing the optional memory. Check the 
mass storage (HDD) or RAM disk option in Device Options, then you can 
select the various features from Print Mode (see "Setting Device 
Options" on page 68).

 

Printing secure documents from the control panel

1 Select (Menu) > Job Manage > Stored Job on the printer’s control 
panel.

2 Select the document to print.

3 Enter the password that you set from the printer driver.

4 Print or delete the document.
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Using USB memory device
 

CLP-68xND Series/ CLP-68xDW Series only.

 

13 

About USB memory device

USB memory devices are available with a variety of memory capacities to give 
you more room for storing documents, presentations, music and videos, high 
resolution photographs, or whatever other files you want to store or move.

Your machine supports USB memory devices with FAT16/FAT32 and sector size 
of 512 bytes.

Check your USB memory device’s file system from your dealer.

You must use only an authorized USB memory device with an A plug type 
connector.

Use only a USB memory device with metal-shielded connector.

Only use a USB memory device that has obtained compatibility certification, 
otherwise, the machine might not recognize it.

Insert a USB memory device into the USB memory port on your machine.

 

• Do not remove the USB memory device while it is in use. The machine 
warranty does not cover damage caused by user’s misuse.

• If your USB memory device has certain features such as security settings 
and password settings, your machine may not automatically detect it. 
For details about these features, see the user’s guide of the USB memory 
device.

 

A B
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14 

Printing from a USB memory device

You can directly print files stored on a USB memory device.

Direct Print option supported file types:

• PRN: Only files created by provided driver with your machine are 
compatible.

 

If you print PRN files created from other machine, the printout would be 
different.

 

• TIFF: TIFF 6.0 Baseline

• JPEG: JPEG Baseline

• PDF: PDF 1.4 and below

• XPS

To print a document from a USB memory device:

1 Insert a USB memory device into the USB memory port on your machine. 

2 Select (Menu) button on the control panel.

3 Press Direct USB > USB Print.

4 Press the arrow until the folder or file you want and press OK.

 

If you see [+] or [D] in the front of a folder name, there are one or more files 
or folders in the selected folder.

 

5 Press the number of copies to be printed or enter the number.

6 Press OK.

15 

Managing USB memory

You can delete image files stored on a USB memory device one by one or all at 
once by reformatting the device.

1 Insert a USB memory device into the USB memory port on your machine. 

2 Select (Menu) button on the control panel.

3 Press Direct USB > File Manage.

4 Press the arrow until Delete or Format you want and press OK.

5 Press the folder or file you want and press OK.

 

If you see [+] or [D] in the front of a folder name, there are one or more files 
or folders in the selected folder.
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6 To delete or format, press Yes > OK.

 

After deleting files or reformatting a USB memory device, files cannot be 
restored. Therefore, confirm that you no longer need the data before 
deleting it.

 

16 

Viewing the USB Memory Status

You can check the amount of memory space available for saving documents.

1 Insert a USB memory device into the USB memory port on your machine. 

2 Select (Menu) button on the control panel.

3 Press Direct USB > Check Space.

The available memory space appears on the display.

17 

Backing up data

Data in the machine’s memory can be accidentally erased due to power failure 

or storage failure. Backup helps you protect your the system settings by storing 
them as backup files on a USB memory device.

Backing up data

1 Insert a USB memory device into the USB memory port on your machine. 

2 Select (Menu) button on the control panel.

3 Press System Setup.

4 Press the arrow until Export Setting you want and press OK.

5 Press Setup Data > OK.

The data is backed up to the USB memory device.

Restoring data

1 Insert a USB memory device into the USB memory port on your machine. 

2 Select (Menu) button on the control panel.

3 Press System Setup.

4 Press the arrow until Import Setting you want and press OK.

5 Press Setup Data > OK.
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6 To restore the backup file to the machine, press Yes > OK.
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Ordering supplies and accessories
 

Available accessories may differ from country to country. Contact your sales representatives to obtain the list of available supplies, and maintenance parts.

 

To order Samsung-authorized supplies, accessories, and maintenance parts, contact your local Samsung dealer or the retailer where you purchased your machine. 
You can also visit www.samsung.com/supplies, and then select your country/region to obtain the contact information for service.

http://www.samsung.com/supplies
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Available consumables
When supplies reach the end of their life spans, you can order the followings of consumables for your machine:

 

 

Type Model Average yielda

a. Declared yield value in accordance with ISO/IEC 19798. The number of pages may be affected by operating environment, printing interval, graphics, media type and media size.

Part name

Toner cartridge • CLP-41xN Series

• CLP-41xNW Series

• Average continuous black cartridge yield: Approx. 2,500 standard pages (Black)

• Average continuous color cartridge yield: Approx. 1,800 standard pages 
(Yellow/Magenta/Cyan)

• CLT-K504S: Black

• CLT-Y504S: Yellow

• CLT-M504S: Magenta

• CLT-C504S: Cyan

• CLP-68xND Series

• CLP-68xDW Series

• Average continuous black cartridge yield: Approx. 2,000 standard pages (Black)

• Average continuous color cartridge yield: Approx. 1,500 standard pages 
(Yellow/Magenta/Cyan)

• CLT-K506S: Black

• CLT-Y506S: Yellow

• CLT-M506S: Magenta

• CLT-C506S: Cyan

• Average continuous black cartridge yield: Approx. 6,000 standard pages (Black)

• Average continuous color cartridge yield: Approx. 3,500 standard pages 
(Yellow/Magenta/Cyan)

• CLT-K506L: Black

• CLT-Y506L: Yellow

• CLT-M506L: Magenta

• CLT-C506L: Cyan

Waste toner container • CLP-41xN Series

• CLP-41xNW Series

• Approx. 14,000 pages (Black)

• Approx. 3,500 pages (Yellow/Magenta/Cyan)

CLT-W504

• CLP-68xND Series

• CLP-68xDW Series

CLT-W506
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Depending on the options, percentage of image area and job mode used, 
the toner cartridge’s lifespan may differ.

 

 

When purchasing new toner cartridges or other consumables, these must 
be purchased in the same country as the machine you are using. Otherwise, 
new toner cartridges or other consumables will be incompatible with your 
machine due to different configurations of toner cartridges and other 
consumables according to the specific country conditions.

 

 

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured toner. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or repair 
required as a result of using non-genuine Samsung toner cartridges will not 
be covered under the machine’s warranty.
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Available accessories
You can purchase and install accessories to enhance your machine’s performance and capacity.

 

Some features and optional goods may not be available depending on models or countries (see "Features by models" on page 7).

 

 

 

Accessory Function Part name

Memory module Extends your machine’s memory capacity. ML-MEM370: 512 MB

IEEE 1284B parallel 

connectora

a. CLP-68xND Series/CLP-68xDW Series only.

Allows you to use various interface.

 

• When installing the printer driver with an IEEE 1284B 
parallel connector, the machine might not be found and 
after installing the printer driver, only basic printing 
features are available.

• If you want to check the machine's status or set the settings, 
connect the machine to a computer with a USB cable or a 
network.

• If you use the IEEE 1284B parallel connector, you can not use 
the USB cable.

 

ML-PAR100

Optional traya
If you are experiencing frequent paper supply problems, you can 

attach an additional 520 bsheets tray. 

b. Plain paper 80 g/m2 (20 lb bond).

CLP-S680A
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Available maintenance parts
To purchase maintenance parts, contact the source where you bought the machine. Replacing maintenance parts can be performed only by an authorized service 
provider, dealer, or the retailer where you bought the machine. The warranty does not cover the replacement of any maintenance parts once it has reached its 
“Average yield”.

Maintenance parts are replaced at specific intervals to avoid print quality and paper feed problems resulting from worn parts, see table below. The purpose of which 
is to maintain your machine in top working condition. The maintenance parts below should be replaced when the life span of each item has been met.

Parts

Average yielda

a. It will be affected by the operating system used, computing performance, application software, connecting method, media, media size and 
job complexity.

• CLP-41xN Series

• CLP-41xNW Series

• CLP-68xND Series

• CLP-68xDW Series

Transfer roller Approx. 100,000 pages Approx. 100,000 pages 

Fuser Unit Approx. 50,000 pages Approx. 100,000 pages

Pick-Up roller Approx. 200,000 pages Approx. 300,000 pages

Retard roller Approx. 100,000 pages Approx. 100,000 pages

Intermediate Transfer Belt (ITB) Approx. 100,000 pages Approx. 100,000 pages
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Storing the toner cartridge
Toner cartridges contain components that are sensitive to light, temperature 
and humidity. Samsung suggests users follow these recommendations to 
ensure optimal performance, highest quality, and longest life from your new 
Samsung toner cartridge.

Store this cartridge in the same environment in which the printer will be used. 
This should be in controlled temperature and humidity conditions. The toner 
cartridge should remain in its original and unopened package until installation 
– if original packaging is not available, cover the top opening of the cartridge 
with paper and store in a dark cabinet.

Opening the cartridge package prior to use dramatically shortens its useful shelf 
and operating life. Do not store on the floor. If the toner cartridge is removed 
from the printer, follow the instructions below to store the toner cartridge 
properly.

• Store the cartridge inside the protective bag from the original package. 

• Store lying flat (not standing on end) with the same side facing up as if it 
were installed in the machine.

• Do not store consumables in any of the following conditions:

- Temperature greater than 40°C (104°F).

- Humidity range less than 20% or greater than 80%.

- An environment with extreme changes in humidity or temperature.

- Direct sunlight or room light.

- Dusty places.

- A car for a long period of time.

- An environment where corrosive gases are present.

- An environment with salty air.

1 

Handling instructions

• Do not touch the surface of the photoconductive drum in the cartridge.

• Do not expose the cartridge to unnecessary vibrations or shock.

• Never manually rotate the drum, especially in the reverse direction; this can 
cause internal damage and toner spillage.

2 

Toner cartridge usage

Samsung Electronics does not recommend or approve the use of non-Samsung 
brand toner cartridges in your printer including generic, store brand, refilled, or 
remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine caused 
by the use of a refilled, remanufactured, or non-Samsung brand toner 
cartridges.
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Estimated cartridge life

Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print yield may vary 
depending on the print density of the pages you print on, operating 
environment, percentage of image area, printing interval, media type and/or 
media size. For example, if you print a lot of graphics, the consumption of the 
toner is higher and you may need to change the cartridge more often.
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Redistributing toner
When the toner cartridge is near the end of its life:

• White streaks or light printing occurs and/or density variation side to side. 

• The Status LED blinks red. The toner-related message saying that the toner is low may appear on the display.

• The computers’s Samsung Printing Status program window appears on the computer telling you which color cartridge is low on toner (see "Using Samsung 
Printer Status" on page 226).

If this happens, you can temporarily improve print quality by redistributing the remaining toner in the cartridge. In some cases, white streaks or light printing will still 

occur even after you have redistributed the toner. Check the type of the toner cartridge for your machine (see "Available consumables" on page 54).

 

Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

 

• To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary. 

• Do not touch the green area of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.

• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.
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Replacing the toner cartridge
For CLP-41xN Series/CLP-41xNW Series:

 Click this link to open an animation about replacing a toner cartridge.

For CLP-68xND Series/CLP-68xDW Series: 

 Click this link to open an animation about replacing a toner cartridge.

The machine uses four colors and has a different toner cartridge for each one: yellow (Y), magenta (M), cyan (C), and black (K).

• The status LED and the toner-related message on the display indicate when each individual toner cartridges should be replaced. 

• The computers’s Samsung Printing Status program window appears on the computer telling you which color cartridge is empty on toner (see "Using Samsung 
Printer Status" on page 226).

Check the type of the toner cartridge for your machine (see "Available consumables" on page 54).

 

• Shake the toner cartridge thoroughly, it will increase the initial print quality.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

 

• To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary. 

• Do not touch the green area of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.

• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.

 

../common/swf/replace_toner.htm
../common/swf/replace_toner.htm
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Replacing the waste toner container
When the life span of the waste toner container has expired, waste toner container-related message appears on the screen display of the control panel, indicating 
the waste toner container needs to be replaced. Check the waste toner container for your machine (see "Available consumables" on page 54).

 

• Toner particles can be released inside the machine but it does not mean the machine is damaged. Contact a service representative when print quality problems 
occur.

• When you pull out the waste toner container out of the machine, move the container carefully not to drop it from your hands.

• Make sure that you lay the waste toner container on a flat surface so that the toner does not spill.

 

 

Do not tilt or turn over the container.
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Installing accessories
4 

Precautions

• Disconnect the power cord

Never remove the control board cover while the power is turned on.

To avoid the possibility of an electrical shock, always disconnect the power 
cord when installing or removing ANY internal or external accessories.

• Discharge static electricity

The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

 

When installing accessories, the battery inside the machine is a service 
component. Do not change it by yourself. There is a risk of an explosion if 
battery is replaced by an incorrect type. Dispose used batteries according to 
the instructions.

 

5 

Setting Device Options

When you install the optional devices such as optional tray, memory, etc, this 
machine automatically detects and sets the optional devices. If you cannot use 
the optional devices you installed in this driver, you need to set the optional 
devices in Device Options.

1 Click the Windows Start menu.

2 For Windows XP/2003, select Printers and Faxes.

• For Windows 2008/Vista, select Control Panel > Hardware and 
Sound > Printers.

• For Windows 7, select Control Panel > Hardware and Sound > 
Devices and Printers.

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers.

3 Right-click your machine. 

4 For Windows XP/2003/2008/Vista, press Properties.

For Windows 7 and Windows Server 2008 R2, from context menus, select 
the Printer properties.
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If Printer properties item has ▶ mark, you can select other printer drivers 
connected with selected printer.

 

5 Select Device Options. 

 

The Properties window may differ depending on the driver or operating 
system you are using.

 

6 Select the appropriate option.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

• Tray Options: Select the optional tray you installed. You can select 
the tray. 

• Storage Options: Select the optional memory you installed. If this 
feature is checked, you can select the Print Mode in printer driver 
("Using optional device features" on page 213).

• Printer Configuration: Select the printer language (SPL/PCL 6) for 
the print job. 

• Administrator Settings: You can select the Printer Status and EMF 
Spooling.

• Admin Job Accounting: Allows you to associate user and account 
identification information with each document you print.

- User permission: If you check this option, only users with user 
permission can start a print job.

- Group permission: If you check this option, only groups with 
group permission can start a print job.

 

• If you want to encrypt job accounting password, check Job Accounting 
Password Encryption.

• Administrators can enable job accounting and configure permissions in 
the control panel or SyncThru™ Web Service. 

 

• Custom Paper Size Settings: You can specify custom paper size.

7 Click OK until you exit the Properties or Printer properties window.
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Upgrading a memory module

Your machine has a dual in-line memory module (DIMM). Use this memory module slot to install additional memory. We recommend the use of only genuine 
Samsung DIMM's. You may void your warranty if it is determined that your machine problem is being caused by third party DIMM's.

The order information is provided for optional accessories (see "Available accessories" on page 56).

 

After installing the optional memory, you can use the advanced printing features, such as proofing a job and specifying of printing a secure print job in the printer 
properties window. You can controll the active job queue and file policy in Job Manage menu (see "Using optional device features" on page 213).

 

1

2

1

2
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Monitoring the supplies life
If you experience frequent paper jams or printing problems, check the number of pages the machine has printed or scanned. Replace the corresponding parts, if 
necessary.

 

It may be necessary to press OK to navigate to lower-level menus for some models.

 

1 Select (Menu) > System Setup > Maintenance > Supplies Life on the control panel.

2 Select the option you want and press OK.

3 Press (Cancel) to return to ready mode.
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Setting the toner low alert
If the amount of toner in the cartridge is low, a message or LED informing the user to change the toner cartridge appears. You can set the option for whether or not 
this message or LED appears.

 

You can set the machine’s settings by using the Device Settings in Samsung Easy Printer Manager program.

• For Windows and Mac users, you set from Samsung Easy Printer Manager > (Switch to advanced mode) > Device Settings, see "Device Settings" on 
page 225.

 

1 Select (Menu) > System Setup > Maintenance > TonerLow Alert on the control panel.

2 Select the option you want.

3 Press OK to save the selection.
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Cleaning the machine
If printing quality problems occur or if you use your machine in a dusty environment, you need to clean your machine regularly to keep it in the best printing 
condition and use your machine longer.

 

• Cleaning the cabinet of the machine with cleaning materials containing large amounts of alcohol, solvents, or other strong substances can discolor or distort the 
cabinet. 

• If your machine or the surrounding area is contaminated with toner, we recommend you use a cloth or tissue dampened with water to clean it. If you use a vacuum 
cleaner, toner blows in the air and might be harmful to you.

 

7 

Cleaning the outside

Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth slightly with water, but be careful not to let any water drip onto or into the machine.
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Cleaning the inside

During the printing process, paper, toner, and dust particles can accumulate inside the machine. This buildup can cause print quality problems, such as toner specks 
or smearing. Cleaning the inside of the machine clears and reduces these problems.

 

• To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary. 

• Do not touch the green area of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Use a dry lint free cloth when cleaning the inside of the machine, be careful not to damage the transfer roller or any other inside parts. Do not use solvents such 
as benzene or thinner. Printing quality problems can occur and cause damage to the machine.

 

 

• Use a dry lint-free cloth to clean the machine.

• Turn the machine off and unplug the power cord. Wait for the machine to cool down. If your machine has a power switch, turn the power switch off before 
cleaning the machine.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).
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Cleaning the pickup roller

 

• Turn the machine off and unplug the power cord. Wait for the machine to cool down. If your machine has a power switch, turn the power switch off before 
cleaning the machine.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).
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Tips for moving & storing your machine
• When moving the machine, do not tilt or turn it upside down. Otherwise, the inside of the machine may be contaminated by toner, which can cause damage to 

the machine or reduce print quality.

• When moving the machine, make sure at least two people are holding the machine securely. 



4. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Tips for avoiding paper jams 80
• Clearing paper jams 81
• Understanding the status LED 93
• Understanding display messages 95
 

This chapter gives helpful information for what to do if you encounter an error. If your machine 
has a display screen, check the message on the display screen first to solve the error.

If you cannot find a solution to your problem in this chapter, refer to the Troubleshooting 
chapter in the Advanced Guide (see "Troubleshooting" on page 232).

If you cannot find a solution in the User's Guide or the problem persists, call for service. 
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Tips for avoiding paper jams
By selecting the correct media s, most paper jams can be avoided. To avoid paper jams, refer to the following guidelines:

• Ensure that the adjustable guides are positioned correctly (see "Tray overview" on page 30).

• Do not remove paper from the tray while your machine is printing.

• Flex, fan, and straighten paper before loading. 

• Do not use creased, damp, or highly curled paper.

• Do not mix papers in a tray.

• Use only recommended print media (see "Print media specifications" on page 104).
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Clearing paper jams
 

To avoid tearing the paper, pull the jammed paper out slowly and gently. 

 

1 

In tray 1

 

 

Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

../common/swf/jam_tray1.htm
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In optional tray (CLP-68xND Series/CLP-68xDW Series  only)

../common/swf/jam_mp.htm
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If you do not see the paper in this area, stop and go to next step:
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In the manual feeder/multi-purpose tray 

CLP-41xN Series/CLP-41xNW Series

../common/swf/jam_mp.htm
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CLP-68xND Series/CLP-68xDW Series 

../common/swf/jam_mp.htm
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If you do not see the paper in this area, stop and go to next step:

1 2 3
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Inside the machine

 

 

The fuser area is hot. Take care when removing paper from the machine.

 

 

Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

../common/swf/jam_tray1.htm
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In exit area

CLP-41xN Series/CLP-41xNW Series

 

 

The fuser area is hot. Take care when removing paper from the machine.

 

../common/swf/jam_exitarea.htm
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If you do not see the paper in this area, stop and go to next step:
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CLP-68xND Series/CLP-68xDW Series 

 

 

The fuser area is hot. Take care when removing paper from the machine.

 

../common/swf/jam_exitarea.htm
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If you do not see the paper in this area, stop and go to next step:
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In the duplex unit area (CLP-68xND Series/CLP-68xDW Series  only)

 .

../common/swf/jam_duplex.htm
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Understanding the status LED
The color of the LED indicates the machine's current status.

 

• Some LEDs may not be available depending on model or country (see "Control panel overview" on page 19).

• To resolve the error, look at the error message and its instructions from the troubleshooting part (see "Understanding display messages" on page 95).

• You also can resolve the error with the guideline from the computers’s Samsung Printing Status program window (see "Using Samsung Printer Status" on page 
226).

• If the problem persists, call a service representative.

 

 

LED Status Description

( ) 
Status

Off The machine is off-line.

Green
Blinking When the backlight blinks, the machine is receiving or printing data.

On • The machine is on-line and can be used.

Red

Blinking

• A minor error has occurred and the machine is waiting for the error to be cleared. Check the display message. When the problem 
is cleared, the machine resumes.

• Small amount of toner is left in the cartridge. The estimated cartridge lifea of toner is close. Prepare a new cartridge for 
replacement. You may temporarily increase the printing quality by redistributing the toner (see "Redistributing toner" on page 

60).b

On

• A toner cartridge has almost reached its estimated cartridge lifea. It is recommended to replace the toner cartridge (see 
"Replacing the toner cartridge" on page 62).

• The cover is opened. Close the cover.

• There is no paper in the tray when receiving or printing data. Load paper in the tray. 

• The machine has stopped due to a major error. Check the display message (see "Understanding display messages" on page 95). 

• A paper jam has occurred (see "Clearing paper jams" on page 81).



Understanding the status LED

944. Troubleshooting

 

( ) 

WPSb

( ) 
Wireless
b

Blue

Blinking The machine is connecting to a wireless network.

On The machine is connected to a wireless network (see "Wireless network setup" on page 148).

Off
The machine is disconnected from a wireless network.

( ) 
Power 

Blue
On The machine is in power save mode.

Off The machine is in ready mode or machine’s power is off.

Eco Green
On Eco mode is on (see "Eco printing" on page 45).

Off Eco mode is off. 

a. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/IEC 19798. The number of pages 
may be affected by operating environment, percentage of image area, printing interval, graphics, media and media size. Some amount of toner may remain in the cartridge even when red LED is 
on and the printer stops printing.

b. Some LEDs may not be available depending on model or country (see "Control panel overview" on page 19).

LED Status Description
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Understanding display messages
Messages appear on the control panel display to indicate the machine’s status 
or errors. Refer to the tables below to understand the messages’ and their 
meaning, and correct the problem, if necessary.

 

• You can resolve the error with the guideline from the computers’s 
Printing Status program window (see "Using Samsung Printer Status" on 
page 226).

• If a message is not in the table, reboot the power and try the printing job 
again. If the problem persists, call a service representative.

• When you call for service, provide the service representative with the 
contents of display message.

• Some messages may not appear on the display depending on the 
options or models.

• [error number] indicates the error number. 

• [tray type] indicates the tray number. 

• [media type] indicates the media type.

• [media size] indicates the media size.

• [color] indicates the color of toner.
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Paper Jam-related messages

Message Meaning Suggested solutions

Paper Jam 

in exit area

Paper has jammed in the 
exit area.

Clear the jam (see "In 
exit area" on page 88).

Paper Jam

inside machine

Paper has jammed in the 
inside machine.

Clear the jam (see 
"Inside the machine" 
on page 87).

Paper Jam

in Tray1

Paper has jammed in the 
tray.

Clear the jam (see "In 
tray 1" on page 81).

Paper Jam

in Tray2

Paper has jammed in the 
optional tray.

Clear the jam (see "In 
optional tray (CLP-
68xND Series/CLP-
68xDW Series only)" on 
page 82).

Paper Jam

 in MP tray

Paper has jammed in the 
multi-purpose tray.

Clear the jam (see "CLP-
68xND Series/CLP-
68xDW Series" on page 
85).
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Paper Jam or

empty 

• Paper has jammed in 
manual feeder.

• There is no paper in tray.

• Clear the jam (see 
"CLP-41xN Series/
CLP-41xNW Series" 
on page 84).

• Load paper in tray 
(see "Multi-purpose 
(or Manual feeder ) 
tray" on page 33).

Paper Jam 

inside of duplex

Paper has jammed during 
duplex printing. This is 
applicable only to 
machines with this feature. 

Clear the jam (see "In 
the duplex unit area 
(CLP-68xND Series/
CLP-68xDW Series 
only)" on page 92).

Message Meaning Suggested solutions
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Toner-related messages

Message Meaning Suggested solutions
Install [color] 

toner cartridge

A toner cartridge is not 
installed.

Reinstall the toner cartridge.

A toner cartridge is not 
being detected

Reinstall the toner cartridge two or 
three times to confirm it is seated 
properly. If the problem persists, 
contact the service representatives.

Not remove protective 
film from toner.

Remove the protective film from the 
toner cartridge. Refer to Quick 
Installation Guide provided with your 
machine.

Not Compatible

[color] toner cart.

The indicated toner 
cartridge is not 
suitable for your 
machine.

Install the corresponding toner 
cartridge with a Samsung-genuine 
cartridge (see "Replacing the toner 
cartridge" on page 62).

Prepare Toner

▼

Small amount of toner 
is left in the indicated 
cartridge. The 
estimated cartridge 

lifea of toner is close.

Prepare a new cartridge for a 
replacement. You may temporarily 
increase the printing quality by 
redistributing the toner (see 
"Redistributing toner" on page 60).

Replace Toner

▼

The indicated toner 
cartridge has almost 
reached its estimated 

cartridge lifea. 

• You can choose Stop or Continue 
as shown on the control panel. If 
you select Stop, the printer stops 
printing. If you select Continue, the 
printer keeps printing but the 
printing quality cannot be 
guaranteed.

• Replace the toner cartridge for the 
best print quality when this 
message appears. Using a cartridge 
beyond this stage can result in 
printing quality issues (see 
"Replacing the toner cartridge" on 
page 62).

The indicated toner 
cartridge has reached 
its estimated cartridge 

lifea. 

Replace the toner cartridge (see 
"Replacing the toner cartridge" on 
page 62).

a. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates 
the average capacity of print-outs and is designed pursuant to ISO/IEC 19798 (see "Available 
consumables" on page 54). The number of pages may be affected by operating environment, 
percentage of image area, printing interval, media, percentage of image area, and media size. 
Some amount of toner may remain in the cartridge even when replace new cartridge appears 
and the machine stops printing.

Message Meaning Suggested solutions
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Samsung does not recommend using a non-genuine Samsung toner 
cartridge such as refilled or remanufactured. Samsung cannot guarantee a 
non-genuine Samsung toner cartridge's quality. Service or repair required 
as a result of using non-genuine Samsung toner cartridges will not be 
covered under the machine warranty.

 

9 

Tray-related messages

10 

Network-related messages

11 

Misc. messages

Message Meaning Suggested solutions

Paper Empty

in [tray number] 

There is no paper in the 
indicated tray.

Load paper in the tray (see 
"Loading paper in the tray" 
on page 31).

Paper Jam

or Empty

• Paper has jammed 
in manual feeder.

• There is no paper in 
tray.

• Clear the jam (see "CLP-
41xN Series/CLP-41xNW 
Series" on page 84).

• Load paper in tray (see 
"Multi-purpose (or 
Manual feeder ) tray" on 
page 33).

Message Meaning Suggested solutions

Network Problem:

IP Conflict

The IP address is used 
elsewhere. 

Check the IP address or 
obtain a new IP address.

Wireless 

Network Error

Wireless module is not 
installed.

Reboot the power and try 
the printing job again. If the 
problem persists, please call 
for service. 

802.1x 

Network Error

Fail to authenticate. Check the network 
authentication protocol. If 
the problem persists, 
contact your network 
administrator.

Message Meaning Suggested solutions

Adjusting Color

Registration...

The machine is adjusting 
the color registration.

Wait a few minutes.
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994. Troubleshooting

Calibrating

image density…

The machine is calibrating 
the image density. 

Wait a few minutes.

Door Open

Close it

The cover is not securely 
latched.

Close the cover until it locks 
into place. 

Error [error 
number]

Install [color] 
toner

The indicated toner 
cartridge is installed 
improperly, or the 
connector is polluted.

Reinstall the Samsung-
genuine toner cartridge two 
or three times to confirm it is 
seated properly. If the 
problem persists, please call 
for service. 

Error  [error 
number]

Turn off then on

The machine unit cannot 
be controlled.

Reboot the power and try the 
printing job again. If the 
problem persists, please call 
for service. 

Error  [error 
number]

Call for service

Install TR.

belt unit.

The transfer belt is not 
installed.

Install a Samsung-genuine 
transfer belt.

Not compatible

transfer belt

The transfer belt of the 
machine is not for your 
machine.

Install the a Samsung-
genuine part designed for 
your machine.

Message Meaning Suggested solutions

Not installed

Waste tank

The is waste toner 
container not installed.

Install a Samsung-genuine 
waste toner container.

Not proper room

temp. Move set

The machine is in a room 
with improper room 
temperature. 

Move the machine to a room 
with proper room 

temperature.

Output bin Full

Remove paper

The output tray is full. Remove papers from the 
output tray, the machine 
resumes printing. If the 
problem persists, call for 
service.

Prepare new

Transfer belt

The life of the transfer belt 
will expired soon.

Replace the transfer belt with 
a new one. If the problem 
persists, please call for 
service. Replace new

Transfer belt

The life of the transfer belt 
has expired.

Replace 

Fuser Soon

The life of the fuser unit will 
be expired soon.

Replace the fuser unit with a 
new one. If the problem 
persists, please call for 
service. Replace new

Fuser unit

The life of the fuser unit will 
be expired.

• Replace new
Tray1 roller

• Replace new
Tray2 roller

The life of the tray pick-up 
roller will expired soon.

Replace the tray pick-up roller 
with a new one. If the 
problem persists, please call 
for service. The life of the tray pick-up 

roller will expired.

Message Meaning Suggested solutions
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1004. Troubleshooting

Transfer Belt

Error

The transfer belt cannot be 
controlled.

Reboot the power and try the 
printing job again. If the 
problem persists, please call 
for service. 

Waste toner Full

Replace new one

The waste toner container 
is full.

Replace the waste toner 
container.

Message Meaning Suggested solutions
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Specifications
1 

General specifications

 

The specification values listed below are subject to change without notice. See www.samsung.com for possible changes in information.

 

 

Items Description

Dimension Width x Length x Height • CLP-41xN Series/CLP-41xNW Series: 420 x 426 x 264 mm (16.54 x 16.77 x 10.39 inches) 

• CLP-68xND Series/CLP-68xDW Series: 420 x 452.5 x 311.3 mm (16.54 x 17.81 x 12.26 
inches) 

Weight Machine with consumables • CLP-41xN Series/CLP-41xNW Series: 16.62 Kg (36.64 lbs)

• CLP-68xND Series/CLP-68xDW Series: 20.15 Kg (44.42 lbs)

Noise Levela Ready mode Less than 32 dB (A)

Print mode • CLP-41xN Series/CLP-41xNW Series: Less than 50 dB (A)

• CLP-68xND Series/CLP-68xDW Series: Less than 52 dB (A)

Temperature Operation 15 to 30 °C (59 to 86 °F)

Storage (packed) -20 to 50 °C (-4 to 122 °F)

Humidity Operation 20 to 80% RH

Storage (packed) 10 to 90% RH

Power ratingb 110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V

http://www.samsung.com
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Power consumption Average operating mode • CLP-41xN Series/CLP-41xNW Series: Less than 380 W

• CLP-68xND Series/CLP-68xDW Series: Less than 450 W

Ready mode • CLP-41xN Series/CLP-41xNW Series: Less than 50 W

• CLP-68xND Series/CLP-68xDW Series: Less than 14 W

Power save mode • CLP-41xN Series/CLP-68xND Series: Less than 1.0 W

• CLP-41xNW Series: Less than 1.5 W

• CLP-68xDW Series: Less than 2.0 W

Power off mode Less than 0.1 W

Wirelessc Module SPW-B4319U

a. Sound Pressure Level, ISO 7779. Configuration tested: basic machine installation, A4 paper, simplex printing.
b. See the rating label on the machine for the correct voltage (V), frequency (hertz) and of current (A) for your machine.
c. Wireless models only (see "Features by models" on page 7).

Items Description
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2 

Print media specifications 

 

Type Size Dimensions

Weight/Capacitya

CLP-41xN Series
CLP-41xNW Series 

CLP-68xND Series
CLP-68xDW Series

Tray1 Manual feeder Tray1/ Optional tray Multi-purpose tray

Plain paper b c Letter 216 x 279 mm (8.5 x 11 inches) 70 to 89 g/m2 (19 to 
24 lbs bond)

• 250 sheets of 80 g/

m2 (21 lbs bond)

70 to 89 g/m2 (19 to 
24 lbs bond)

• 1 sheet 

70 to 90 g/m2 (19 to 24 lbs 
bond)

• Tray1: 250 sheets of 

80 g/m2 (21 lbs bond)

• Optional tray: 520 

sheets of 80 g/m2 
(20 lbs bond)

70 to 90 g/m2 (19 to 
24 lbs bond)

• 50 sheets

Legal 216 x 356 mm (8.5 x 14 inches)
US Folio 216 x 330 mm (8.5 x 13 inches)
A4 210 x 297 mm (8.27 x 11.69 inches)
Oficio 216 x 343 mm (8.5 x 13.5 inches)
JIS B5 182 x 257 mm (7.17 x 10.12 inches)
ISO B5 176 x 250 mm (6.93 x 9.84 inches) 
Executive 184 x 267 mm (7.25 x 10.5 inches)
Statement 140 x 216 mm (5.5 x 8.5 inches)
A5 148 x 210 mm (5.83 x 8.27 inches)

A6

105 x 148 mm (4.13 x 5.83 inches) 70 to 89 g/m2 (19 to 
24 lbs bond)

• 150 sheets of 80 g/

m2 (21 lbs bond)

70 to 90 g/m2 (19 to 24 lbs 
bond)

• 150 sheets of 80 g/m2 
(21 lbs bond)

Not available in optional 
tray.
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Envelope Envelope 
Monarch

98 x 191 mm (3.87 x 7.5 inches) 75 to 90 g/m2 (20 to 
24 lbs bond)

• 20 sheets

75 to 90 g/m2 (20 to 
24 lbs bond)

• 1 sheet

75 to 90 g/m2 (20 to 24 lbs 
bond)

• 20 sheets

Not available in optional 
tray.

75 to 90 g/m2 (20 to 
24 lbs bond)

• 5 sheets
Envelope No. 
10

105 x 241 mm (4.12 x 9.5 inches)

Envelope No. 
9

98 x 225 mm (3.87 x 8.87 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)
Envelope C5 162 x 229 mm (6.38 x 9.02 inches)
Envelope C6 114 x 162 mm (4.49 x 6.38 inches)

Thick paper b c
Refer to the 
Plain paper 
section 

Refer to the Plain paper section 90 to 104 g/m2 (24 to 28 
lbs bond)

• 50 sheets of 105 g/

m2 (28 lbs bond)

90 to 104 g/m2 (24 to 
28 lbs bond)

• 1 sheet

91 to 105 g/m2 (24 to 28 
lbs bond)

• 50 sheets of 105 g/m2 
(28 lbs bond)

91 to 105 g/m2 (24 to 28 
lbs bond)

• 10 sheets

Thicker paper b 
c

Refer to the 
Plain paper 
section 

Refer to the Plain paper section 164 to 220 g/m2 (43 to 
59 lbs bond)

• 50 sheets of 220 g/

m2 (59 lbs bond)

164 to 220 g/m2 (43 to 
59 lbs bond)

• 1 sheet

164 to 220 g/m2 (43 to 59 
lbs bond)

• 50 sheets of 220 g/m2 
(59 lbs bond)

Not available in optional 
tray.

164 to 220 g/m2 (43 to 
59 lbs bond)

• 10 sheets

Thin paper Refer to the 
Plain paper 
section 

Refer to the Plain paper section 60 to 69 g/m2 (16 to 19 
lbs bond)

• 250 sheets of 70 g/

m2 (19 lbs bond)

60 to 69 g/m2 (16 to 19 
lbs bond)

• 1 sheet

60 to 70 g/m2 (16 to 19 lbs 
bond)

• 250 sheets of 70 g/m2 
(19 lbs bond)

60 to 70 g/m2 (16 to 19 
lbs bond)

• 50 sheets

Type Size Dimensions

Weight/Capacitya

CLP-41xN Series
CLP-41xNW Series 

CLP-68xND Series
CLP-68xDW Series

Tray1 Manual feeder Tray1/ Optional tray Multi-purpose tray
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Cotton, Color, 
Pre-printed

Refer to the 
Plain paper 
section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 
lbs bond)

• 250 sheets of 80 g/

m2 (21 lbs bond)

75 to 90 g/m2 (20 to 24 
lbs bond)

• 1 sheet

75 to 90 g/m2 (20 to 24 lbs 
bond)

• 250 sheets of 80 g/m2 
(21 lbs bond)

Not available in optional 
tray.

75 to 90 g/m2 (20 to 24 
lbs bond)

• 50 sheets

Recycled Refer to the 
Plain paper 
section 

Refer to the Plain paper section 70 to 90 g/m2 (19 to 24 
lbs bond)

• 250 sheets of 80 g/

m2 (21 lbs bond)

70 to 90 g/m2 (19 to 24 
lbs bond)

• 1 sheet

70 to 90 g/m2 (19 to 24 lbs 
bond)

• 250 sheets of 80 g/m2 
(21 lbs bond)

70 to 90 g/m2 (19 to 24 
lbs bond)

• 50 sheets

Transparency Letter, Legal, 
A4

Refer to the Plain paper section 138 to 146 g/m2 (35 to 
39 lbs bond)

• 50 sheets

138 to 146 g/m2 (35 to 
39 lbs bond)

• 1 sheet

138 to 146 g/m2 (35 to 39 
lbs bond)

• 50 sheets

Not available in optional 
tray.

138 to 146 g/m2 (35 to 
39 lbs bond)

• 10 sheets

Labels d Letter, Legal, 
US Folio, A4, 
JIS B5, ISO 
B5, 
Executive, A5

Refer to the Plain paper section 120 to 150 g/m2 (32 to 
40 lbs bond)

• 50 sheets

120 to 150 g/m2 (32 to 
40 lbs bond)

• 1 sheet

120 to 150 g/m2 (32 to 40 
lbs bond)

• 50 sheets

Not available in optional 
tray.

120 to 150 g/m2 (32 to 
40 lbs bond)

• 10 sheets

Type Size Dimensions

Weight/Capacitya

CLP-41xN Series
CLP-41xNW Series 

CLP-68xND Series
CLP-68xDW Series

Tray1 Manual feeder Tray1/ Optional tray Multi-purpose tray
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Card stock b c Letter, Legal, 
US Folio, A4, 
JIS B5, ISO 
B5, 
Executive, A5

Refer to the Plain paper section 121 to 163 g/m2 (32 to 
43 lbs bond)

• 50 sheets

121 to 163 g/m2 (32 to 
43 lbs bond)

• 1 sheet

121 to 163 g/m2 (32 to 43 
lbs bond)

• 50 sheets

121 to 163 g/m2 (32 to 
43 lbs bond)

• 10 sheets

 

Index card 3 x 5 is 

supported

 

Bond paper Refer to the 
Plain paper 
section 

Refer to the Plain paper section 105 to 120 g/m2 (28 to 
32 lbs bond)

• 50 sheets

105 to 120 g/m2 (28 to 
32 lbs bond)

• 1 sheet

105 to 120 g/m2 (28 to 32 
lbs bond)

• 50 sheets

105 to 120 g/m2 (28 to 
32 lbs bond)

• 10 sheets
Archive, 
Punched 
paper, 
Letterhead

Refer to the 
Plain paper 
section 

Refer to the Plain paper section • 250 sheets • 1 sheet • 250 sheets • 50 sheets

Type Size Dimensions

Weight/Capacitya

CLP-41xN Series
CLP-41xNW Series 

CLP-68xND Series
CLP-68xDW Series

Tray1 Manual feeder Tray1/ Optional tray Multi-purpose tray
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Glossy Photo b Letter, A4, 
Postcard 4x6

Refer to the Plain paper section 111 to 130 g/m2 (30 to 
35 lbs bond)

• 30 sheets

111 to 130 g/m2 (30 to 
35 lbs bond)

• 1 sheet

111 to 130 g/m2 (30 to 35 
lbs bond) for tray1

• Tray1: 30 sheets

• Optional tray: 50 sheets

111 to 130 g/m2 (30 to 
35 lbs bond)

• 5 sheets

Refer to the Plain paper section 131 to 175 g/m2 (35 to 
47 lbs bond)

• 30 sheets

131 to 175 g/m2 (35 to 
47 lbs bond)

• 1 sheet

131 to 175 g/m2 (35 to 47 
lbs bond)

• Tray1: 30 sheets

• Optional tray: 50 sheets

131 to 175 g/m2 (35 to 
47 lbs bond)

• 5 sheets

Refer to the Plain paper section 176 to 220 g/m2 (47 to 
59 lbs bond)

• 30 sheets

176 to 220 g/m2 (47 to 
59 lbs bond)

• 1 sheet

176 to 220 g/m2 (47 to 59 
lbs bond)

• Tray1: 30 sheets

• Optional tray: 50 sheets

176 to 220 g/m2 (47 to 
59 lbs bond)

• 5 sheets

Minimum size (custom) • Tray1: 98 x 127 mm (3.86 x 5 
inches)

• Optional tray: 148.5 x 210 mm 
(5.85 x 8.27inches)

• Multi-Purpose tray/ Manual 
Feeder: 76 x 127 mm (3 x 5 
inches)

60 to 220 g/m2 ( 16 to 59 
lbs bond)

60 to 220 g/m2 ( 16 to 
59 lbs bond)

• 60 to 220 g/m2 ( 16 to 
59 lbs bond) for tray1

• 60 to 163 g/m2 ( 16 to 
43 lbs bond) for 
optional tray.

60 to 220 g/m2 ( 16 to 
59 lbs bond)

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 
b. Post card 4 x 6 is supported for tray1, Manual feeder, or Multi-purpose tray.
c. Index card (3 x 5) is supported for Manual feeder and Multi-purpose tray.
d. The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness.

Type Size Dimensions

Weight/Capacitya

CLP-41xN Series
CLP-41xNW Series 

CLP-68xND Series
CLP-68xDW Series

Tray1 Manual feeder Tray1/ Optional tray Multi-purpose tray
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3 

System requirements

Microsoft® Windows®

 

 

 

• Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating systems.

• Users who have administrator rights can install the software.

• Windows Terminal Services is compatible with your machine.

 

Operating system
Requirement (recommended)

CPU RAM free HDD space

Windows® XP Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (256 MB) 1.5 GB

Windows Server® 2003 Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (512 MB) 1.25 GB to 2 GB

Windows Server® 2008 Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz) 512 MB (2 GB) 10 GB

Windows Vista® Intel® Pentium® IV 3 GHz 512 MB (1 GB) 15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher 1 GB (2 GB) 16 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).

• DVD-R/W Drive

Windows Server® 2008 R2 Intel® Pentium® IV 1 GHz (x86) or 1.4 GHz (x64) processors (2 GHz or faster) 512 MB (2 GB) 10 GB
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Mac

 

 

Operating system
Requirements (Recommended)

CPU RAM Free HDD space

Mac OS X 10.4 • Intel® processors

• PowerPC G4/G5

• 128 MB for a powerPC based Mac (512 MB)

• 512 MB for an Intel-based Mac (1 GB)

1 GB

Mac OS X 10.5 • Intel® processors

• 867 MHz or faster Power PC G4/G5

512 MB (1 GB) 1 GB

Mac OS X 10.6 • Intel® processors 1 GB (2 GB) 1 GB

Mac OS X 10.7 • Intel® processors 2 GB 4 GB
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Linux

 

 

Unix

Items Requirements

Operating system Redhat® Enterprise Linux WS 4, 5 (32/64 bit)

Fedora 5 ~ 13 (32/64 bit)

SuSE Linux 10.1 (32 bit)

OpenSuSE® 10.2, 10.3, 11.0, 11.1, 11.2 (32/64 bit)

Mandriva 2007, 2008, 2009, 2009.1, 2010 (32/64 bit)

Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10, 9.04, 9.10, 10.04 (32/64 bit)

SuSE Linux Enterprise Desktop 10, 11 (32/64 bit)

Debian 4.0, 5.0 (32/64 bit)

CPU Pentium IV 2.4GHz (Intel Core™2)

RAM 512 MB (1 GB)

Free HDD space 1 GB (2 GB)

Items Requirements

Operating system

Sun Solaris 9, 10 (x86, SPARC) 

HP-UX 11.0, 11i v1, 11i v2, 11i v3 (PA-RISC, Itanium) 

IBM AIX 5.1, 5.2, 5.3, 5.4

Free HDD space Up to 100 MB
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4 

Network environment

 

Network and wireless models only (see "Features by models" on page 7).

 

You need to set up the network protocols on the machine to use it as your network machine. The following table shows the network environments supported by the 
machine.

 

 

Items Specifications
Network interface • Ethernet 10/100/1000 Base-TX Wired Lan

• 802.11b/g/n Wireless LAN
Network operating system • Windows® XP, Windows Server® 2003, Windows Vista®, Windows® 7, Windows Server® 2008 R2

• Various Linux OS

• Mac OS X 10.4 ~10.7

• UNIX OS
Network protocols • TCP/IPv4

• DHCP, BOOTP

• DNS, WINS, Bonjour, SLP, UPnP

• Standard TCP/IP Printing (RAW), LPR, IPP, WSD

• SNMPv 1/2/3, HTTP, IPSec

• TCP/IPv6 (DHCP, DNS, RAW, LPR, SNMPv 1/2/3, HTTP, IPSec)
Wireless security • Authentication: Open System, Shared Key, WPA Personal, WPA2 Personal (PSK)

• Encryption: WEP64, WEP128, TKIP, AES
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Regulatory information
This machine is designed for a normal work environment and certified with 
several regulatory statements.

5 

Laser safety statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 
CFR, chapter 1 Subchapter J for Class I(1) laser products, and elsewhere is 
certified as a Class I laser product conforming to the requirements of IEC 60825-
1 : 2007.

Class I laser products are not considered to be hazardous. The laser system and 
printer are designed so there is never any human access to laser radiation above 
a Class I level during normal operation, user maintenance or prescribed service 
condition.

Warning 

Never operate or service the printer with the protective cover removed from 
laser/scanner assembly. The reflected beam, although invisible, can damage 
your eyes.

When using this product, these basic safety precautions should always be 
followed to reduce risk of fire, electric shock, and injury to persons:
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6 

Ozone safety

7 

Power saver

8 

Recycling

9 

China only

This product’s ozone emission rate is under 0.1 ppm. Because 
ozone is heavier than air, keep the product in a place with good 
ventilation.

This printer contains advanced energy conservation technology that 
reduces power consumption when it is not in active use.

When the printer does not receive data for an extended period of 
time, power consumption is automatically lowered. 

ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 

For more information on the ENERGY STAR program see http://
www.energystar.gov

For ENERGY STAR certified models, the ENRGY STAR label will be on 
your machine. Check if your machine is ENERGY STAR certified.

Recycle or dispose of the packaging material for this product in an 
environmentally responsible manner.

http://www.energystar.gov


Regulatory information

1155. Appendix

10 

Correct disposal of this product (Waste electrical & 
electronic equipment)

(Applicable in the european union and other 
european countries with separate collection 
systems)

(The United States of America only)

Dispose unwanted electronics through an approved recycler. To find the nearest 
recycling location, go to our website: www.samsung.com/recyclingdirect Or 
call, (877) 278 - 0799

11 

Taiwan only

12 

Radio frequency emissions

FCC information to the user

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: 

• This device may not cause harmful interference, and

• This device must accept any interference received, including interference 
that may cause undesired operation.

This marking on the product, accessories or literature indicates that the 
product and its electronic accessories (e.g. charger, headset, USB cable) 
should not be disposed of with other household waste at the end of 
their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these 
items from other s of waste and recycle them responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for details of 
where and how they can take these items for environmentally safe 
recycling.

Business users should contact their supplier and check the terms and 
conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for 
disposal.
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This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user's authority to operate the 
equipment.

 

Canadian radio interference regulations

This digital apparatus does not exceed the Class B limits for radio noise 
emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and 
Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques 
applicables aux appareils numériques de Classe B prescrites dans la norme sur le 
matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et 
Sciences Canada.

13 

United States of America

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15

Low power, Radio LAN devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 
your printer system. This section is only applicable if these devices are present. 
Refer to the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the 
United States of America if an FCC ID number is on the system label.
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The FCC has set a general guideline of 20 cm (8 inches) separation between the 
device and the body, for use of a wireless device near the body (this does not 
include extremities). This device should be used more than 20 cm (8 inches) 
from the body when wireless devices are on. The power output of the wireless 
device (or devices), which may be embedded in your printer, is well below the 
RF exposure limits as set by the FCC.

This transmitter must not be collocated or operation in conjunction with any 
other antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired 
operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

 

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination 
the radio frequency exposure limit of 1m W/cm2 may be exceeded at 
distances close to the antenna installed. Therefore, the user must maintain 
a minimum distance of 20cm from the antenna at all times. This device 
cannot be colocated with another transmitter and transmitting antenna.

 

14 

Russia only

15 

Germany only
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16 

Turkey only

17 

Replacing the Fitted Plug (for UK Only)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug 
and has a 13 amp fuse. When you change or examine the fuse, you must re-fit 
the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost 
the fuse cover, do not use the plug until you have another fuse cover. 

Contact the people from you purchased the machine.

The 13 amp plug is the most widely used in the UK and should be suitable. 
However, some buildings (mainly old ones) do not have normal 13 amp plug 
sockets. You need to buy a suitable plug adaptor. Do not remove the moulded 
plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you 
plug it into a socket.

 

Important warning: 

If the wires in the mains lead do not match the colors marked in your plug, do 
the following:

You must connect the green and yellow wire to the pin marked by the letter “E” 
or by the safety ‘Earth symbol’ or colored green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter “N” or 
colored black.

You must connect the brown wire to the pin which is marked with the letter “L” 
or colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

You must earth this machine.

The wires in the mains lead have the following color code:

• Green and Yellow: Earth

• Blue: Neutral

• Brown: Live
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Declaration of conformity (European countries)

Approvals and Certifications

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of 
the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC, approximation of the laws of 
the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity. A full declaration, defining the relevant Directives and referenced 
standards can be obtained from your Samsung Electronics Co., Ltd. 
representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal 
Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European 
single terminal connection to the analogue public switched telephone network 
(PSTN) in accordance with Directive 1999/5/EC. The product has been designed 
to work with the national PSTNs and compatible PBXs of the European 
countries:

In the event of problems, you should contact the Euro QA Lab of Samsung 
Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21. To assist in the use and application 
of terminal equipment which complies with this standard, the European 
Telecommunication Standards Institute (ETSI) has issued an advisory document 
(EG 201 121) which contains notes and additional requirements to ensure 
network compatibility of TBR21 terminals. The product has been designed 
against, and is fully compliant with, all of the relevant advisory notes contained 
in this document.

Hereby, Samsung Electronics, declares that this [CLP-41xN Series/CLP-
68xND Series] is in compliance with the essential requirements and 
other relevant provisions of Low Voltage Directive (2006/95/EC), EMC 
Directive (2004/108/EC).

Hereby, Samsung Electronics, declares that this [CLP-41xNW Series/
CLP-68xDW Series] is in compliance with the essential requirements 
and other relevant provisions of R&TTE Directive 1999/5/EC.

The declaration of conformity may be consulted at 
www.samsung.com, go to Support > Download center and enter 
your printer (MFP) name to browse the EuDoC. 

http://www.samsung.com
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European radio approval information (for products 
fitted with EU-approved radio devices)

Low power, Radio LAN type devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4 GHz/5 GHz band, may be present 
(embedded) in your printer system which is intended for home or office use. This 
section is only applicable if these devices are present. Refer to the system label 
to verify the presence of wireless devices.

The power output of the wireless device or devices that may be embedded in 
you printer is well below the RF exposure limits as set by the European 
Commission through the R&TTE directive.

European states qualified under wireless approvals:

EU countries

European states with restrictions on use:

EU

In France, this equipment may only be used indoors.

EEA/EFTA countries

No limitations at this time

19 

Israel only
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Regulatory compliance statements

Wireless guidance

Low power, Radio LAN devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 
your printer system. The following section is a general overview of 
considerations while operating a wireless device.

Additional limitations, cautions, and concerns for specific countries are listed in 
the specific country sections (or country group sections). The wireless devices in 
your system are only qualified for use in the countries identified by the Radio 
Approval Marks on the system rating label. If the country you will be using the 
wireless device in, is not listed, contact your local Radio Approval agency for 
requirements. Wireless devices are closely regulated and use may not be 
allowed.

Wireless devices that may be in your system are only qualified for 
use in the European Union or associated areas if a CE mark with a 
Notified Body Registration Number and the Alert Symbol is on the 
system label.
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The power output of the wireless device or devices that may be embedded in 
your printer is well below the RF exposure limits as known at this time. Because 
the wireless devices (which may be embedded into your printer) emit less 
energy than is allowed in radio frequency safety standards and 
recommendations, manufacturer believes these devices are safe for use. 
Regardless of the power levels, care should be taken to minimize human contact 
during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless 
device and the body, for use of a wireless device near the body (this does not 
include extremities) is typical. This device should be used more than 20 cm (8 
inches) from the body when wireless devices are on and transmitting.

This transmitter must not be collocated or operation in conjunction with any 
other antenna or transmitter.

Some circumstances require restrictions on wireless devices. Examples of 
common restrictions are listed below:

Radio frequency wireless communication can interfere with 
equipment on commercial aircraft. Current aviation regulations 
require wireless devices to be turned off while traveling in an airplane. 
IEEE 802.11 (also known as wireless Ethernet) and Bluetooth 
communication devices are examples of devices that provide wireless 
communication.

In environments where the risk of interference to other devices or 
services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and 
Oxygen or flammable gas laden atmospheres are limited examples 
where use of wireless devices may be restricted or eliminated. When in 
environments where you are uncertain of the sanction to use wireless 
devices, ask the applicable authority for authorization prior to use or 
turning on the wireless device.

Every country has different restrictions on the use of wireless devices. 
Since your system is equipped with a wireless device, when traveling 
between countries with your system, check with the local Radio 
Approval authorities prior to any move or trip for any restrictions on 
the use of a wireless device in the destination country.

If your system came equipped with an internal embedded wireless 
device, do not operate the wireless device unless all covers and shields 
are in place and the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any 
way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

Only use drivers approved for the country in which the device will be 
used. See the manufacturer System Restoration Kit, or contact 
manufacturer Technical Support for additional information.
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Copyright
© 2012 Samsung Electronics Co., Ltd. All rights reserved.

This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.

Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and the Samsung logo are trademarks of Samsung Electronics Co., Ltd.

• Microsoft, Windows, Windows Vista, Windows 7, and Windows Server 2008 R2 are either registered trademarks or trademarks of Microsoft Corporation.

• Google, Picasa, Google Docs, Android and Gmail are either registered trademarks or trademarks of Google Inc.

• Google Cloud Print is a trademark of Google Inc.

•  iPad, iPhone, iPod touch, Mac and Mac OS are trademarks of Apple Inc., registered in the U.S and other countries. AirPrint and the AirPrint logo are trademarks 
of Apple Inc.

• All other brand or product names are trademarks of their respective companies or organizations.

Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.

REV.1.02
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User’s Guide

This guide provides information about installation, advanced configuration, 
operation and troubleshooting on various OS environments. 
Some features may not be available depending on models or countries.

BASIC
This guide provides information concerning installation, basic operation and troubleshooting 
on windows.
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1. Software Installation
This chapter provides instructions for installing essential and helpful software for use in an environment where the 
machine is connected via a cable. A locally connected machine is a machine directly attached to your computer using 
the cable. If your machine is attached to a network, skip the following steps below and go on to installing a network 
connected machine’s driver (see "Installing driver over the network" on page 137).

• Installation for Mac 128
• Reinstallation for Mac 129
• Installation for Linux 130
• Reinstallation for Linux 131
 

• If you are a Windows OS user, refer to the Basic Guide for installing the machine’s driver (see 
"Installing the driver locally" on page 21).

• Only use a USB cable no longer then 3 meter (118 inches).
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Installation for Mac
1 Make sure that the machine is connected to your computer and 

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your Mac desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5 Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 When the message that warns that all applications will close on your 
computer appears, click Continue.

9 Click Continue on the User Options Pane.

10 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

11 Enter the password and click OK.

12 Installing software requires you to restart your computer. Click Continue 
Installation.

13 After the installation is finished, click Quit or Restart.

14 Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5 -10.7, open the Applications folder > System 
Preferences and click Print & Fax.

15 Click Add on the Printer List.

• For Mac OS X 10.5 -10.7, click the “+” folder icon; a display window 
will pop up.

16 Click Default Browser and find the USB connection.

• For Mac OS X 10.5-10.7, click Default and find the USB connection.

17 For Mac OS X 10.4, if Auto Select does not work properly, select Samsung 
in Print Using and your machine name in Model.

• For Mac OS X 10.5-10.7, if Auto Select does not work properly, select 
Select a driver to use... and your machine name in Print Using. 

Your machine appears on the Printer List, and is set as the default 
machine.

18 Click Add.
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Reinstallation for Mac
If the printer driver does not work properly, uninstall the driver and reinstall it.

1 Make sure that the machine is connected to your computer and 
powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your Mac desktop.

4 Double-click the MAC_Installer folder > Uninstaller OS X icon.

5 Enter the password and click OK.

6 When the uninstall is done, click OK.

 

If a machine has already been added, delete it from the Print Setup Utility 
or Print & Fax.
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Installation for Linux
You need to download Linux software packages from the Samsung website to 
install the printer software (http://www.samsung.com > find your product > 
Support or Downloads).

1 

Installing the Unified Linux Driver

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

 

You must log in as a super user (root) to install the machine software. If you 
are not a super user, ask your system administrator.

 

3 From the Samsung website, download the Unified Linux Driver package 
to your computer.

4 Right-click the Unified Linux Driver package and extract the package. 

5 Double click cdroot > autorun.

6 When the welcome screen appears, click Next.

7 When the installation is complete, click Finish.

The installation program added the Unified Driver Configurator desktop icon 
and the Unified Driver group to the system menu for your convenience. If you 
have any difficulties, consult the on-screen help that is available through your 
system menu or from the driver package Windows applications, such as Unified 
Driver Configurator or Image Manager.

http://www.samsung.com 
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Reinstallation for Linux
If the printer driver does not work properly, uninstall the driver and reinstall it. 

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

You must log in as a super user (root) to uninstall the printer driver. If you 
are not a super user, ask your system administrator.

3 Open the Terminal program. When the Terminal screen appears, type in 
the following.

[root@localhost root]#cd /opt/Samsung/mfp/uninstall/

[root@localhost uninstall]#./uninstall.sh

4 Click Next. 

5 Click Finish.



2. Using a Network-
Connected Machine

This chapter gives you step-by-step instructions for setting up a network connected machine and software.

• Useful network programs 133
• Wired network setup 134
• Installing driver over the network 137
• IPv6 configuration 145
• Wireless network setup 148
• Samsung MobilePrint 171
• AirPrint 172
• Google Cloud Print™ 174
 

Supported optional devices and features may differ according to your model (see "Features by 
models" on page 7).
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Useful network programs
There are several programs available to setup the network settings easily in a 
network environment. For the network administrator especially, managing 
several machines on the network is possible. 

 

• Before using the programs below, set the IP address first. 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

 

1 

SyncThru™ Web Service

The web server embedded on your network machine allows you to do the 
following tasks (see "Using SyncThru™ Web Service" on page 220).

• Check the supplies information and status.

• Customize machine settings.

• Set the email notification option. When you set this option, the machine 
status (toner cartridge shortage or machine error) will be sent to a certain 
person's email automatically.

• Configure the network parameters necessary for the machine to connect to 
various network environments.

2 

SyncThru™ Web Admin Service

Web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of managing 
network devices and lets you remotely monitor and troubleshoot network 
machines from any site with corporate internet access. 

• Download this program from http://solution.samsungprinter.com.

3 

SetIP wired network setup

This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol.

• See "IPv4 configuration using SetIP (Windows)" on page 134.

• See "IPv4 configuration using SetIP (Mac)" on page 135.

• See "IPv4 configuration using SetIP (Linux)" on page 136.

 

• The machine that does not support the network port, it will not be able 
to use this feature (see "Rear view" on page 18).

• TCP/IPv6 is not supported by this program.

 

http://solution.samsungprinter.com
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Wired network setup
4 

Printing a network configuration report

You can print Network Configuration Report from the machine’s control panel 
that will show the current machine’s network settings. This will help you to set 
up a network.

Press the  (Menu) button on the control panel and select Network > 

Network Conf.

Using this Network Configuration Report, you can find your machine’s MAC 
address and IP address.

For example:

• MAC Address: 00:15:99:41:A2:78

• IP Address: 169.254.192.192

5 

Setting IP address

 

• The machine that does not support the network interface, it will not be 
able to use this feature (see "Rear view" on page 18).

• TCP/IPv6 is not supported by this program.

 

First, you have to set up an IP address for network printing and managements. 
In most cases a new IP address will be automatically assigned by a DHCP 
(Dynamic Host Configuration Protocol) server located on the network.

IPv4 configuration using SetIP (Windows)

Before using the SetIP program, disable the computer firewall from Control 
Panel > Security Center > Windows Firewall.

1 Install this program from the supplied CD-ROM by double-click 
Application > SetIP > Setup.exe.

2 Follow the instructions in the installation window.

3 Connect your machine to the network with a network cable.

4 Turn on the machine.

5 From the Windows Start menu, select All Programs > Samsung 
Printers > SetIP > SetIP.

6 Click the  icon (third from left) in the SetIP window to open the TCP/
IP configuration window.
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7 Enter the machine’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this information 
assigned by a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 134) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

8 Click Apply, and then click OK. The machine will automatically print the 
Network Configuration Report. Confirm that all the settings are 
correct.

IPv4 configuration using SetIP (Mac)

Before using the SetIP program, disable the computer firewall from System 
Preferences > Security > Firewall.

 

The following instructions may vary from your model.

 

1 Connect your machine to the network with a network cable.

2 Insert the Installation CD-ROM, and open the disk window, select 
MAC_Installer > MAC_Printer > SetIP > SetIPapplet.html.

3 Double-click the file and Safari will automatically open, then select 
Trust. The browser will open the SetIPapplet.html page that shows the 
printer’s name and IP address information. 

4 Click the  icon (third from left) in the SetIP window to open the TCP/
IP configuration window.

5 Enter the machine’s new information into the configuration window. In 
a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.
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Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 134) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

6 Select Apply, then OK, and OK again.

7 Quit Safari.

IPv4 configuration using SetIP (Linux)

Before using the SetIP program, disable the computer firewall from System 
Preferences or Administrator.

 

The following instructions may vary from your model or operating systems.

 

1 Open /opt/Samsung/mfp/share/utils/.

2 Double-click the SetIPApplet.html file. 

3 Click to open the TCP/IP configuration window. 

4 Enter the machine’s new information into the configuration window. In 
a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 134) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

5 The machine will automatically print the Network Configuration 
Report. 
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Installing driver over the network
 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

• The machine that does not support the network interface, it will not be 
able to use this feature (see "Rear view" on page 18).

• You can install the printer driver and software when you insert the 
software CD into your CD-ROM drive.
For windows, select the printer driver and software in the Select 
Software to Install window.

 

6 

Windows

1 Make sure that the machine is connected to the network and powered 
on. Also, your machine’s IP address should have been set (see "Setting IP 
address" on page 134).

 

If the “Found New Hardware Wizard” appears during the installation 
procedure, click Cancel to close the window.

 

2 Insert the supplied software CD into your CD-ROM drive.

3 Select Install Now.

4 Read License Agreement, and select I accept the terms of the License 
Agreement. Then, click Next.

 

If your machine is not found on the network or locally, an error message 
appears. Select the option you want and click Next.

 

5 Choose the option in Using Enhanced Features and Participating in 
Printer Usage Information Collection Program. Then, click Next.
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6 Select Network connection on the Printer Connection Type screen.

7 If the Connect Device window appears, check that the machine is 
connected to your network. Then, click Next.

 

The firewall software might be blocking network communication. Before 
connecting the device to the network, disable the computer’s firewall.

 

8 The searched machines will be shown on the screen. Select the one you 
wish to use and click OK.

9 Follow the instructions in the installation window.

Silent installation Mode

Silent installation mode is an installation method that does not require any user 
intervention. Once you start the installation, the machine driver and software 
are automatically installed on you computer. You can start the silent installation 
by typing /s or /S in the command window.

Command-line Parameters

Following table shows commands that can be used in the command window.

 

Following command-line are effective and operated when command is 
used with /s or /S. But /h, /H or /? are exceptional commands that can be 
operated solely.

 

Command- line Definition Description

/s or

/S

Starts silent installation. Installs machine drivers 
without prompting any UIs or 
user intervention.

/p”<port name>” or

/P”<port name>”

Specifies printer port.

 

Network Port will be 
created by use of 
Standard TCP/IP 
Port monitor. For 
local port, this port 
must exist on 
system before 
being specified by 
command.

 

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name or IEEE1284 port name.

For example:

•  /p”xxx.xxx.xxx.xxx” in 
where, “xxx.xxx.xxx.xxx” 
means IP address for 
network printer. /
p”USB001”, /P”LPT1:”, /
p”hostname”
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/a”<dest_path>” or

/A”<dest_path>”

Specifies destination path 
for installation.

 

The destination 
path should be a 
fully qualified path.

 

Since machine drivers should 
be installed on the OS specific 
location, this command 
applies to only application 
software.

/n”<Printer name>” 
or

/N”<Printer name>”

Specifies printer name. 
Printer instance shall be 
created as specified printer 
name.

With this parameter, you can 
add printer instances as your 
wishes.

/nd or

/ND

Commands not to set the 
installed driver as a default 
machine driver.

It indicates installed machine 
driver will not be the default 
machine driver on your 
system if there are one or 
more printer drivers installed. 
If there is no installed 
machine driver on your 
system, then this option 
won’t be applied because 
Windows OS will set installed 
printer driver as a default 
machine driver.

Command- line Definition Description

/x or

/X

Uses existing machine 
driver files to create printer 
instance if it is already 
installed.

This command provides a 
way to install a printer 
instance that uses installed 
printer driver files without 
installing an additional driver.

/up”<printer 
name>” or

/UP”<printer 
name>”

Removes only specified 
printer instance and not the 
driver files.

This command provides a 
way to remove only specified 
printer instance from your 
system without effecting 
other printer drivers. It will 
not remove printer driver files 
from your system.

/d or

/D

Uninstalls all device drivers 
and applications from your 
system.

This command will remove all 
installed device drivers and 
application software from 
your system.

/v”<share name>” or

/V”<share name>”

Shares installed machine 
and add other available 
platform drivers for Point & 
Print.

It will install all supported 
Windows OS platform’s 
machine drivers to system 
and share it with specified 
<share name> for point and 
print.

/o or 

/O

Opens Printers and Faxes 
folder after installation.

This command will open 
Printers and Faxes folder 
after the silent installation.

Command- line Definition Description
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7 

Mac

1 Make sure that the machine is connected to your network and powered 
on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your Mac desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5  Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 When the message which warns that all applications will close on your 
computer appears, click Continue.

9 Click Continue on the User Options Pane.

 

If you have not set the IP address yet, click Set IP address and refer to "IPv4 
configuration using SetIP (Mac)" on page 135. If you want to set the wireless 
setting, refer to "Setup using Mac" on page 158.

 

10 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

11 Enter the password and click OK.

12 Installing software requires you to restart your computer. Click Continue 
Installation.

13 After the installation is finished, click Quit or Restart.

/f”<log filename>” 
or

/F”<log filename>”

Specifies log filename.

The default log file is 
created in the system temp 
folder if not specified.

It will create a log file to a 
specified folder.

/h, /H or /? Shows Command-line Usage.

Command- line Definition Description
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14 Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5-10.7, open the Applications folder > System 
Preferences and click Print & Fax.

15 Click Add on the Printer List.

• For Mac OS X 10.5-10.7, click the “+” icon. A display window will pop 
up. 

16 For Mac OS X 10.4, click IP Printer.

• For Mac OS X 10.5-10.7, click IP.

17 Select HP Jetdirect - Socket in Protocol.

 

When printing a document containing many pages, printing performance 
may be enhanced by choosing Socket for Printer Type option.

 

18 Enter the machine’s IP address in the Address input field.

19 Enter the queue name in the Queue input field. If you cannot determine 
the queue name for your machine server, try using the default queue 
first.

20 For Mac OS X 10.4, if Auto Select does not work properly, select Samsung 
in Print Using and your machine name in Model. 

• For Mac OS X 10.5-10.7, if Auto Select does not work properly, choose 
Select Printer Software and your machine name in Print Using.

21 Click Add.

Your machine appears in the Printer List, and is set as the default 
machine.

8 

Linux

You need to download Linux software packages from the Samsung website to 
install the printer software (http://www.samsung.com > find your product > 
Support or Downloads).

Install the Linux driver and add network printer

1 Make sure that the machine is connected to your network and powered 
on. Also, your machine’s IP address should have been set. 

2 From the Samsung website, download the Unified Linux Driver package 
to your computer.

3 Right-click the Unified Linux Driver package and extract the package. 

4 Double-click the cdroot > autorun.

http://www.samsung.com 
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5 The Samsung installer window opens. Click Next.

6 The add printer wizard window opens. Click Next.

7 Select network printer and click Search button.

8 The machine’s IP address and model name appears on list field.

9 Select your machine and click Next.

10 Input the printer description and Next.

11 After the machine is added, click Finish.

12 When installation is done, click Finish.

Add a network printer

1 Double-click the Unified Driver Configurator.

2 Click Add Printer.

3 The Add printer wizard window opens. Click Next.

4 Select Network printer and click the Search button.

5 The printer’s IP address and model name appears on list field.

6 Select your machine and click Next.

7 Enter the printer description and click Next.

8 After the machine is added, click Finish.
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UNIX

 

• Make sure your machine supports the UNIX operating system before 
installing the UNIX printer driver (see "Operating System" on page 7).

• The commands are marked with “”, when typing the commands, do not 
type “”.

• Some features and optional goods may not be available depending on 
model or country (see "Operating System" on page 7).

 

To use the UNIX printer driver, you have to install the UNIX printer driver 
package first, then setup the printer. You can download the UNIX printer driver 
package from the Samsung website ((http://www.samsung.com > find your 
product > Support or Downloads).

Installing the UNIX printer driver package

The installation procedure is common for all variants of UNIX OS mentioned.

http://www.samsung.com 
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1 From the Samsung website, download and unpack the UNIX Printer 
Driver package to your computer. 

2 Acquire root privileges.

“su -”

3 Copy the appropriate driver archive to the target UNIX computer.

 

See administration guide of your UNIX OS for details.

 

4 Unpack the UNIX printer driver package.

For example, on IBM AIX, use the following commands.

“gzip -d < enter the package name | tar xf -”

5 Go to the unpacked directory.

6 Run the install script.

“./install -i”

install is the installer script file which is used to install or uninstall the 
UNIX Printer Driver package.

Use “chmod 755 install” command to give the permission to the 
installer script.

7 Execute the “. /install –c” command to verify installation results.

8 Run “installprinter” from the command line. This will bring up the Add 
Printer Wizard window. Setup the printer in this window referring to 
the following procedures.

 

On some UNIX OS, for example on Solaris 10, just added printers may not be 
enabled and/or may not accept jobs. In this case run the following two 
commands on the root terminal:

“accept <printer_name>”

“enable <printer_name>”

 

Uninstalling the printer driver package

 

The utility should be used to delete the printer installed in the system.

a Run “uninstallprinter” command from the terminal.
It will open the Uninstall Printer Wizard.
The installed printers are listed in the drop-down list.

b Select the printer to be deleted.
c Click Delete to delete the printer from the system.
d Execute the “. /install –d” command to uninstall the whole package.
e To verify removal results, execute the “. /install –c” command.

 

To re-install it, use the command “. /install -i” to reinstall the binaries.
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Setting up the printer

To add the printer to your UNIX system, run ‘installprinter’ from the command 
line. This will bring up the Add Printer Wizard window. Setup the printer in this 
window according to the following steps:

1 Type the name of the printer.

2 Select the appropriate printer model from the model list.

3 Enter any description corresponding to the type of the printer in the 
Type field. This is optional.

4 Specify any printer description in the Description field. This is optional.

5 Specify the printer location in the Location field.

6 Type the IP address or DNS name of the printer in the Device textbox for 
network-connected printers. On IBM AIX with jetdirect Queue type, 
only the DNS name is possible-numeric IP address is not allowed.

7 Queue type shows the connection as lpd or jetdirect in the 
corresponding list box. Additionally, usb type is available on Sun Solaris 
OS.

8 Select Copies to set the number of copies.

9 Check the Collate option to receive copies already sorted.

10 Check the Reverse Order option to receive copies in the reverse order.

11 Check the Make Default option to set this printer as default.

12 Click OK to add the printer.
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IPv6 configuration
 

IPv6 is supported properly only in Windows Vista or higher.

 

 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7 or "Menu 
overview" on page 25).

• If the IPv6 network seems to not be working, set all the network setting 
to the factory defaults and try again using Clear Setting.

 

The machine supports the following IPv6 addresses for network printing and 
managements.

• Link-local Address: Self-configured local IPv6 address (Address starts with 
FE80).

• Stateless Address: Automatically configured IPv6 address by a network 
router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

In the IPv6 network environment, follow the next procedure to use the IPv6 
address.
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From the control panel

Activating IPv6

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > IPv6 Activate.

3 Select On and press OK.

4 Turn the machine off and turn it on again.

 

When you install the printer driver, do not configure both IPv4 and 

IPv6. We recommend to configure either IPv4 or IPv6 (see "Installing 

driver over the network" on page 137).

 

DHCPv6 address configuration

If you have a DHCPv6 server on your network, you can set one of the following 
options for default dynamic host configuration.

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > DHCPv6 Config.
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3 Press OK to select the required value you want.

• DHCPv6 Addr.: Always use DHCPv6 regardless of router request.

• DHCPv6 Off: Never use DHCPv6 regardless of router request.

• Router: Use DHCPv6 only when requested by a router.
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From the SyncThru™ Web Service

Activating IPv6

1 Access a web browser, such as Internet Explorer, from Windows. Enter 
the machine IP address (http://xxx.xxx.xxx.xxx) in the address field and 
press the Enter key or click Go.

2 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000 

3 When the SyncThru™ Web Service window opens, move the mouse 
cursor over the Settings of the top menu bar and then click Network 
Settings.

4 Click TCP/IPv6 on the left pane of the website.

5 Check the IPv6 Protocol check box to activate IPv6.

6 Click the Apply button.

7 Turn the machine off and turn it on again.

 

• You can also set the DHCPv6.

• To manually set the IPv6 address:
Check the Manual Address check box. Then, the Address/Prefix text 
box is activated. Enter the rest of the address 
(e.g.,:3FFE:10:88:194::AAAA. “A” is the hexadecimal 0 through 9, A 
through F).

 

IPv6 address configuration

1 Start a web browser, such as Internet Explorer, that supports IPv6 
addressing as a URL.

2 Select one of the IPv6 addresses (Link-local Address, Stateless Address, 
Stateful Address, Manual Address) from Network Configuration Report 
(see "Printing a network configuration report" on page 134).

• Link-local Address: Self-configured local IPv6 address (Address starts 
with FE80).

• Stateless Address: Automatically configured IPv6 address by a network 
router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.
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• Manual Address: Manually configured IPv6 address by a user.

3 Enter the IPv6 addresses (e.g.,: http://[FE80::215:99FF:FE66:7701]).

 

Address must be enclosed in '[ ]' brackets.
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Wireless network setup
 

• Make sure your machine supports wireless networking. Wireless 
networking may not be available depending on the model (see "Features 
by models" on page 7).

• If the IPv6 network seems to not be working, set all the network settings 
to the factory defaults and try again using Clear Setting.
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Getting started

Understanding your network type

Typically, you can only have one connection between your computer and the 
machine at a time.

Wireless network name and network key

Wireless networks require higher security, so when an access point is first set up, 
a network name (SSID), the type of security used, and a Network Key are created 
for the network. Ask your network administrator about this information before 
proceeding with the machine installation.

Infrastructure mode

This is an environment generally used for homes and SOHOs 
(Small Office/ Home Office). This mode uses an access point to 
communicate with the wireless machine.

Ad hoc mode

This mode does not use an access point. The wireless 
computer and wireless machine communicate directly. 
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Introducing wireless set up methods

You can set wireless settings either from the machine or the computer. Choose the setting method from the below table.

 

Some wireless network installation types may not be available depending on the model or country.

 

 

 

 

If problems occur during wireless set up or driver installation, refer to the troubleshooting chapter (see "Troubleshooting for wireless network" on page 167).

 

Set up method Connecting method Description & Reference

With Access Point

From th computer Windows user, see "Access point via USB cable (recommended)" on page 154. A

Mac user, see "Access point via USB cable (recommended)" on page 159. B

See "Using a network cable" on page 162. C

From th machine’s control panel • See "Machines with a display screen" on page 151.

• See "Machines without a display screen" on page 152.

D

See "Using the menu button" on page 153. E

Without Access Point From th computer Windows user, see "Ad hoc via USB cable" on page 156. F

Mac user, see "Ad hoc via USB cable" on page 160. G

Wi-Fi Direct setup See "Setting the Wi-Fi Direct for mobile printing" on page 165. H
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Using the WPS button 

If your machine and an access point (or wireless router) support Wi-Fi Protected 
Setup™ (WPS), you can easily configure the wireless network settings by 

pressing the  (WPS) button on the control panel without a computer.

 

• If you want to use the wireless network using the infrastructure mode, 
make sure that the network cable is disconnected from the machine. 
Using the WPS (PBC) button or entering the PIN from the computer to 
connect to the access point (or wireless router) varies depending on the 
access point (or wireless router) you are using. Refer to the user's guide 
of the access point (or wireless router) you are using.

• When using the WPS button to set the wireless network, security settings 
may change. To prevent this, lock the WPS option for the current wireless 
security settings. The option name may differ depending on the access 
point (or wireless router) you are using.

 

Items to prepare

• Check if the access point (or wireless router) supports Wi-Fi Protected 
Setup™ (WPS).

• Check if your machine supports Wi-Fi Protected Setup™ (WPS).

• Networked computer (PIN mode only)

Choosing your type

There are two methods available to connect your machine to a wireless network 

using the  (WPS) button on the control panel.

The Push Button Configuration (PBC) method allows you to connect your 

machine to a wireless network by pressing both the  (WPS) button on the 
control panel of your machine and the WPS (PBC) button on a Wi-Fi Protected 
Setup™ WPS-enabled access point (or wireless router) respectively.

The Personal Identification Number (PIN) method helps you connect your 
machine to a wireless network by entering the supplied PIN information on a Wi-
Fi Protected Setup™ WPS-enabled access point (or wireless router).

Factory default in your machine is PBC mode, which is recommended for a 
typical wireless network environment.

 

You can change the WPS mode in control panel (  (Menu) > Network > 

Wireless > WPS Setting).
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Machines with a display screen

Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for more than 
2 seconds.

The machine starts waiting for up to two minutes until you press the WPS 
(PBC) button on the access point (or wireless router).

2 Press the WPS (PBC) button on the access point (or wireless router).

The messages are displayed on the display screen in the order below:

a Connecting: The machine is connecting to the access point (or 
wireless router).

b Connected: When the machine is successfully connected to the 
wireless network, the WPS LED light stays on.

c AP SSID: After completing the wireless network connection process, 
the AP’s SSID information appears on the display.

3 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.

Connecting in PIN mode

1 Press and hold the  (WPS) button on the control panel for more than 
2 seconds.

2 The eight-digit PIN appears on the display. 

You need to enter the eight-digit PIN within two minutes on the 
computer that is connected to the access point (or wireless router).

The messages are displayed on the display screen in the order below:

a Connecting: The machine is connecting to the wireless network.

b Connected: When the machine is successfully connected to the 
wireless network, the WPS LED light stays on.

c SSID: After completing the wireless network connection process, 
the AP’s SSID information is displayed on the LCD display.

3 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.
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Machines without a display screen

Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for about 2 - 4 
seconds until the status LED blinks quickly.

The machine starts connecting to the wireless network. The LED blinks 
slowly for up to two minutes until you press the PBC button on the 
access point (or wireless router).

2 Press the WPS (PBC) button on the access point (or wireless router).

a The light blinks fast on the WPS LED. The machine is connecting to 
the access point (or wireless router). 

b When the machine is successfully connected to the wireless 
network, the WPS LED light stays on.

3 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.

Connecting in PIN mode

1 The network configuration report, including PIN, must be printed (see 
"Printing a network configuration report" on page 134).

In ready mode, press and hold the  (Cancel or Stop/Clear) button on 
the control panel for about 5 seconds. You can find your machine’s PIN.

2 Press and hold the  (WPS) button on the control panel for more than 
4 seconds until the status LED stays on.

The machine starts connecting to the access point (or wireless router).

3 You need to enter the eight-digit PIN within two minutes on the 
computer that is connected to the access point (or wireless router).

The LED blinks slowly for up to two minutes until you enter the eight-
digit PIN.

The WPS LED blinks in the order below:

a The light blinks fast on the WPS LED. The machine is connecting to 
the access point (or wireless router).

b When the machine is successfully connected to the wireless 
network, the WPS LED light stays on.

4 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.
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Re-connecting to a network

When the wireless function is off, the machine automatically tries to re-connect 
to the access point (or wireless router) with the previously used wireless 
connection settings and address.

 

In the following cases, the machine automatically re-connects to the 
wireless network:

• The machine is turned off and on again.

• The access point (or wireless router) is turned off and on again.

 

Canceling the connection process

To cancel the wireless network connection when the machine is connecting to 

the wireless network, press and release the  (Cancel or Stop/Clear) on the 
control panel. You need to wait 2 minutes to re-connect to the wireless 
network.

Disconnecting from a network

To disconnect the wireless network connection, press the  (WPS) button on 
the control panel for more than two seconds.

• When the Wi-Fi network is in idle mode: The machine is immediately 
disconnected from the wireless network and the WPS LED turns off.

• When the Wi-Fi network is being used: While the machine waits until the 
current job is finished, the light blinks fast on the WPS LED. Then, the 
wireless network connection is automatically disconnected and the WPS 

LED turns off.
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Using the menu button

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

Before starting, you will need to know the network name (SSID) of your wireless 
network and the network key if it is encrypted. This information was set when 
the access point (or wireless router) was installed. If you do not know about your 
wireless environment, please ask the person who set up your network.
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After completing the wireless network connection, you need to install a 
machine driver to print from an application (see "Installing driver over the 
network" on page 137).

 

1 Press the  (Menu) button on the control panel.

2 Press Network > Wireless > WLAN Settings.

3 Press the OK to select the setup method you want.

• Wizard (recommended): In this mode, the setup is automatic. The 
machine will display a list of available networks from which to 
choose. After a network is chosen then printer will prompt for the 
corresponding security key.

• Custom: In this mode, users can give or edit manually their own SSID 
, or choose the security option in detail. 
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Setup using Windows

 

Shortcut to the Wireless Setting program without the CD: If you have 
installed the printer driver once, you can access the Wireless Setting 
program without the CD. From the Start menu, select Programs or All 
Programs > Samsung Printers > your printer driver name > Wireless 
Setting Program.

 

Access point via USB cable (recommended)

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Creating the infrastructure network

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.

3 Insert the supplied software CD into your CD-ROM drive.

4 Click Install Now.

5 Read the License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

6 Choose the option in Using Enhanced Features and Participating in 
Printer Usage Information Collection Program. Then, click Next.
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7 Select Configure the wireless network connection using USB cable 
on the Printer Connection Type screen. Then click Next.

8 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you want to use and click Next.

If the wireless network is already set up, the Wireless Network 
Information window appears. Select I want to install software with 
the current settings. (Recommended). Then, click Next.

 

If you cannot find the network name you want to choose, or if you want to 
set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on a WPA Pre-Shared Key. This uses a shared secret key 
(generally called Pre Shared Key pass phrase), which is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption (None, WEP64, WEP128, TKIP, AES, 
TKIP AES).

• Network Password: Enter the encryption network password value.

• Confirm Network Password: Confirm the encryption network 
password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

 

 

The wireless network security window appears when the access point has 
security settings.

Enter the Network Password of the access point (or router).

 

9 When the network connection window appears, disconnect the network 
cable. Then, click Next. The network cable connection can interfere with 
searching for wireless devices.
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10 If your printer supports Wi-Fi Direct, the following screen appears. 

Click Next.

 

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager 
(see "Setting up Wi-Fi Direct" on page 166).

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name 
and the maximum length is 22 characters.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

 

11 When the wireless network set up is completed, disconnect the USB 
cable between the computer and machine. Click Next.

12 Click Next when the Printers Found window appears.

13 Select the components to be installed. Click Next.

14 After selecting the components, you can also change the machine name, 
set the machine to be shared on the network, set the machine as the 
default machine, and change the port name of each machine. Click Next.

15 If you want to register your machine with the Samusng web site and 
receive useful information, click On-line Registration. If not, click 
Finish.

Ad hoc via USB cable

If you do not have an access point (AP), you may still connect the machine 
wirelessly to your computer by setting up an ad-hoc wireless network by 
following the simple steps below.

Items to prepare

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable
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Creating the ad hoc network in Windows

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer and the wireless network machine.

3 Insert the supplied software CD into your CD-ROM drive.

4 Click Install Now.

5 Read the License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

6 Choose the option in Using Enhanced Features and Participating in 
Printer Usage Information Collection Program. Then, click Next.

7 Select Configure the wireless network connection using USB cable 
on the Printer Connection Type screen. Then click Next.

8 After searching the wireless networks, a list of wireless networks your 
machine has searched appears. Click Advanced Setting.

 

• Enter the wireless Network Name: Enter the SSID name you want (SSID 
is case-sensitive).

• Operation Mode: Select ad hoc.

• Channel: Select the channel. (Auto Setting or 2412 MHz to 2467 MHz).

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.

• Encryption: Select the encryption (None, WEP64, WEP128).

• Network Password: Enter the encryption network password value.

• Confirm Network Password: Confirm the encryption network 
password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the ad hoc network 
has security enabled.

Select Open System or Shared Key for the authentication and click Next.

• WEP (Wired Equivalent Privacy) is a security protocol preventing 
unauthorized access to your wireless network. WEP encrypts the data 
portion of each packet exchanged on a wireless network using a 64-bit 
or 128-bit WEP encryption key.

 

9 The window showing the wireless network setting appears. Check the 
settings and click Next.
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Before entering the IP address for the machine, you must know the 
computer’s network configuration information. If the computer’s network 
configuration is set to DHCP, the wireless network setting should also be 
DHCP. Likewise, if the computer’s network configuration is set to Static, the 
wireless network setting should also be Static.

If your computer is set to DHCP and you want to use the Static wireless 
network setting, you must contact the network administrator to get the 
static IP address.

• For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is shown in 
the Wireless Network Setting Confirm window. If it shows Static, click 
Change TCP/IP to change the assignment method to Receive IP 
address automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if Static is shown in 
the Wireless Network Setting Confirm window. If it shows DHCP, click 
Change TCP/IP to enter the IP address and other network configuration 
values for the machine.
For example,
If the computer’s network information is as shown follows:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as below:

- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

- Gateway: 169.254.133.1

 

10 The Wireless Network Setting Complete window appears. Click Next.

11 When the wireless network settings are completed, disconnect the USB 
cable between the computer and machine. Click Next.

12 Click Next when the Printers Found window appears.

13 Select the components to be installed. Click Next.

14 After selecting the components, you can also change the machine name, 
set the machine to be shared on the network, set the machine as the 
default machine, and change the port name of each machine. Click Next.

15 If you want to register your machine with the Samusng web site and 
receive useful information, click On-line Registration. If not, click 
Finish.
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Setup using Mac

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface
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• USB cable

Access point via USB cable (recommended)

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.

3 Insert the supplied software CD into your CD-ROM drive.

4 Double-click the CD-ROM icon that appears on your Mac desktop.

5 Double-click the MAC_Installer folder > Installer OS X icon.

6 Click Continue.

7 Read the license agreement and click Continue.

8 Click Agree to agree to the license agreement.

9 When the message that warns that all applications will close on your 
computer appears, click Continue.

10 Click Wireless Network Setting button on the User Options Pane.

11 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you want to use and click Next.

If the wireless network is already set up, the Wireless Network 
Information window appears. Select I want to install software with 
the current settings. (Recommended). Then, click Next.

 

When you set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on the WPA Pre-Shared Key. This uses a shared secret 
key (generally called Pre Shared Key pass phrase) that is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption. (None, WEP64, WEP128, TKIP, AES, 
TKIP, AES)

• Network Password: Enter the encryption network password value.

• Confirm Network Password: Confirm the encryption network 
password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.
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The wireless network security window appears when the access point has 
security enabled.

Enter the Network Password of the access point (or router).

 

12 If your printer supports Wi-Fi Direct, the following screen appears. 

Click Next.

 

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager 
(see "Setting up Wi-Fi Direct" on page 166).

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name 
and the maximum length is 22 characters.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

 

13 When the wireless network settings are completed, disconnect the USB 
cable between the computer and machine.

14 Wireless network set up is completed. After the installation is finished, 
click Quit.

 

After completing the wireless network connection, you need to install a 
machine driver to print from an application (see "Installation for Mac" on 
page 128).

 

Ad hoc via USB cable

If you do not have an access point (AP), you may still connect the machine 
wirelessly to your computer by setting up an ad hoc wireless network by 
following these simple directions.

Items to prepare

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable
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Creating the ad hoc network in Mac

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer and the wireless network machine.

3 Insert the supplied software CD into your CD-ROM drive.

4 Double-click the CD-ROM icon that appears on your Mac desktop.

5 Double-click the MAC_Installer folder > Installer OS X icon.

6 Click Continue.

7 Read the license agreement and click Continue.

8 Click Agree to agree to the license agreement.

9 When the message that warns that all applications will close on your 
computer appears, click Continue.

10 Click Wireless Network Setting button on the User Options Pane.

11 After searching the wireless networks, a list of wireless networks your 
machine has searched appears. Click Advanced Setting.

 

• Enter the wireless Network Name: Enter the SSID name (SSID is case-
sensitive).

• Operation Mode: Select ad hoc.

• Channel: Select the channel (Auto Setting or 2412 MHz to 2467 MHz).

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.

• Encryption: Select the encryption (None, WEP64, WEP128).

• Network Password: Enter the encryption network password value.

• Confirm Network Password: Confirm the encryption network 
password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the ad hoc network 
has security setting.

Select Open System or Shared Key for the authentication and click Next.

• WEP (Wired Equivalent Privacy) is a security protocol preventing 
unauthorized access to your wireless network. WEP encrypts the data 
portion of each packet exchanged on a wireless network using a 64-bit 
or 128-bit WEP encryption key.

 

12 The window showing the wireless network settings appears. Check the 
settings and click Next.
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Before entering the IP address for the machine, you must know the 
computer’s network configuration information. If the computer’s network 
configuration is set to DHCP, the wireless network setting should also be 
DHCP. Likewise, if the computer’s network configuration is set to Static, the 
wireless network setting should also be Static.

If your computer is set to DHCP and you want to use Static wireless network 
setting, you must contact the network administrator to get the static IP 
address.

• For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is shown in 
the Wireless Network Setting Confirm window. If it shows Static, click 
Change TCP/IP to change the assignment method to Receive IP 
address automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if Static is shown in 
the Wireless Network Setting Confirm window. If it shows DHCP, click 
Change TCP/IP to enter the IP address and other network configuration 
values for the machine.
For example,
If the computer’s network information is shown as follows:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as shown below:

- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

- Gateway: 169.254.133.1

 

13 When the window that tells you that the network cable connection is 
confirmed appears, disconnect the network cable and click Next.

If the network cable is connected, it may have trouble finding the 
machine when configuring the wireless network.

14 The wireless network connects according to the network configuration.

15 Wireless network set up is completed. After installation is finished, click 
Quit.

 

After completing the wireless network connection, you need to install a 
machine driver to print from an application (see "Installation for Mac" on 
page 128).
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Using a network cable

 

Machines that do not support the network port will not be able to use this 
feature (see "Rear view" on page 18).

 

Your machine is a network compatible machine. To enable your machine to 
work with your network, you will need to perform some configuration 
procedures.
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• After completing the wireless network connection, you need to install a 
machine driver to print from an application (see "Installing driver over 
the network" on page 137).

• See your network administrator, or the person that set up your wireless 
network, for information about your network configuration.

 

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• Network cable

Printing a network configuration report

You can identify the network settings of your machine by printing a network 
configuration report.

See "Printing a network configuration report" on page 134.

IP setting using SetIP Program (Windows)

This program is used to manually set the network IP address of your machine 
using its MAC address to communicate with the machine. The MAC address is 
the hardware serial number of the network interface and can be found in the 
Network Configuration Report. 

See "Setting IP address" on page 134.

Configuring the machine’s wireless network

Before starting you will need to know the network name (SSID) of your wireless 
network and the network key if it is encrypted. This information was set when 
the access point (or wireless router) was installed. If you do not know about your 
wireless environment, please ask the person who set up your network.

To configure wireless parameters, you can use SyncThru™ Web Service.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, check the cable connection 
status. 
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1 Check whether or not the network cable is connected to the machine. If 
not, connect the machine with a standard network cable.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service website.

4 Type in the ID and Password then click Login. We recommend you to 
change the default password for security reasons.

• ID: admin 

• Password: sec00000

5 When the SyncThru™ Web Service window opens, click Network 
Settings.

6 Click Wireless > Wizard.

 

Wizard will help you setup the wireless network configuration. However, if 
you want to set the wireless network directly, select Custom.

 

7 Select the one Network Name(SSID) in the list.

• SSID: SSID (Service Set Identifier) is a name that identifies a wireless 
network, access points, and wireless devices attempting to connect 
to a specific wireless network must use the same SSID. The SSID is 
case sensitive.

• Operation Mode: Operation Mode refers to the type of wireless 
connections (see "Wireless network name and network key" on page 
148).

- Ad-hoc: Allows wireless devices to communicate directly with 
each other in a peer-to-peer environment.

- Infrastructure: Allows wireless devices to communicate with 
each other through an access point.

 

If your network’s Operation Mode is Infrastructure, select the SSID of the 
access point. If the Operation Mode is Ad-hoc, select the machine’s SSID. 
Note that “portthru” is the default SSID of your machine.

 

8 Click Next.

If the wireless security setting window appears, enter the registered 
password (network password) and click Next.

9 The confirmation window appears, please check your wireless setup. If 
the setup is right, click Apply.
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Disconnect the network cable (standard or network). Your machine should 
then start communicating wirelessly with the network. In case of Ad-hoc 
mode, you can use a wireless LAN and wired LAN simultaneously.

 

10 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.
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Turning the Wi-Fi network on/off

 

If your machine has a display, you can also turn on/off the Wi-Fi from the 
machine’s control panel using the Network menu.

 

1 Check whether the network cable is connected to the machine. If not, 
connect the machine with a standard network cable.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service website.

4 Type in the ID and Password, then click Login. We recommend you to 
change the default password for security reasons.

• ID: admin 

• Password: sec00000 

5 When the SyncThru™ Web Service window opens, click Network 
Settings.

6 Click Wireless > Custom.

You can also turn the Wi-Fi network on/off.
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Setting the Wi-Fi Direct for mobile printing

Wi-Fi Direct is an easy-to-setup peer-to-peer connection method between the 
Wi-Fi Direct certified printer and a mobile device that provides a secure 
connection and better throughput than ad hoc mode.

With Wi-Fi Direct, you can connect your printer to a Wi-Fi Direct network while 
concurrently connecting to an access point, You can also use a wired network 
and a Wi-Fi Direct network simultaneously so multiple users can access and print 
documents both from Wi-Fi Direct and from a wired network.
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• You cannot connect your mobile device to the internet through the 
printer’s Wi-Fi Direct.

• The supported protocol list may differ from your model, Wi-Fi Direct 
networks do NOT support IPv6, network filtering, IPSec, WINS, and SLP 
services. 

• The maximum number of devices that can be connected via Wi-Fi Direct 
is 3.

 

Setting up Wi-Fi Direct

You can enable Wi-Fi Direct feature by one of the following methods.

From the USB cable-connected computer(recommended)

After the driver installation is complete, Samsung Easy Printer Manager can be 
set and changes in the Wi-Fi Direct can be made.

 

Samsung Easy Printer Manager is Available for Windows

and Mac OS users only.

 

- From the Start menu, select Programs or All Programs > Samsung 
Printers > Samsung Easy Printer Manager > Device Settings > 
Network.

▪ Wi-Fi Direct On/Off: Select On to enable.

▪ Device Name: Enter the printer’s name for searching for your 
printer on a wireless network. By default, the device name is the 
model name.

▪ IP Address: Enter the IP address of the printer. This IP address is 
used only for the local network and not for the infrastructure wired 
or wireless network. We recommend using the default local IP 
address (the default local IP address of the printer for Wi-Fi Direct is 
192.168.3.1 )

▪ Group Owner: Activate this option to assign the printer the Wi-Fi 
Direct group’s owner. The Group Owner acts similar to a wireless 
access point. We recommend activating this option.

▪ Network Password: If your printer is a Group Owner, a Network 
Password is required for other mobile devices to connect to your 
printer. You can configure a network password yourself, or can 
remember the given Network Password that is randomly generated 
by default.

From the machine (Machines with a display screen)
 

Accessing menus may differ from model to model (see "Accessing the 
menu" on page 25 ).

 

• Select Setup> Machine Setup >Next > Network Setup > Wireless > Wi-Fi 
Direct on the touch screen.

• Enable Wi-Fi Direct.
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From the network-connected computer

If your printer is using a network cable or a wireless access point, you can enable 
and configure Wi-Fi Direct from SyncThru™ Web Service.

• Access SyncThru™ Web Service, select Settings > Network Settings > 
Wireless > Wi-Fi Direct.

• Enable or disable Wi-Fi Direct and set other options.

 

• For Linux OS users,

- Print an IP network configuration report to check the output (see 
"Printing a network configuration report" on page 134).

- Access SyncThru Web Service, select Settings > Network Settings 
> Wireless > Wi-Fi Direct.

- Enable or disable Wi-Fi Direct.

 

Setting up the mobile device

• After setting up Wi-Fi Direct from the printer, refer to the user manual of the 
mobile device you are using to set its Wi-Fi Direct.

• After setting up Wi-Fi Direct, you need to download the mobile printing 
application (For example: Samsung Mobile printer) to print from your 
smartphone.

 

• When you have found the printer you want to connect to from your 
mobile device, select the printer and the printer's LED will blink. Press the 
WPS button on the printer and it will be connected to your mobile 
device.

•  If your mobile device does not support Wi-Fi Direct, you need to enter 
the "Network Key" of a printer instead of pushing the WPS button.
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Troubleshooting for wireless network

Problems during setup or driver installation

Printers Not Found

• Your machine may not be turned on. Turn on your computer and the 
machine.

• USB cable is not connected between your computer and machine. Connect 
the machine to your computer using the USB cable.

• The machine does not support wireless networking. Check the machine's 
user's guide included on the software CD supplied with your machine and 
prepare a wireless network machine.
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Connecting Failure - SSID Not Found

• The machine is unable to find the network name (SSID) you have selected or 
entered. Check the network name (SSID) on your access point and try 
connecting again. 

• Your access point is not turned on. Turn on your access point.

Connecting Failure - Invalid Security

• Security is not configured correctly. Check the configured security on your 
access point and machine.

Connecting Failure - General Connection Error

• Your computer is not receiving a signal from your machine. Check the USB 
cable and your machine’s power.

Connecting Failure - Connected Wired Network

• Your machine is connected with a wired network cable. Remove the wired 
network cable from your machine.

Connecting Failure - Assigning the IP address

• Cycle the power for the access point (or wireless router) and machine.

PC Connection Error

• The configured network address is unable to connect between your 
computer and machine.

- For a DHCP network environment

The machine receives the IP address automatically (DHCP) when 
computer is configured to DHCP.

 

If the printing job is not working in DHCP mode, the problem may be caused 
by the automatically changed IP address. Compare the IP address between 
the product's IP address and the printer port's IP address.

How to compare:
1 Print the network information report of your printer, and then check the 

IP address (see "Printing a network configuration report" on page 134).
2 Check the printer port's IP address from your computer.

a Click the Windows Start menu. 
b For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows 7, select Control Panel > Devices and Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

c Right-click your machine.
d For Windows XP/2003/2008/Vista, press Properties.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.
If Printer properties item has ► mark, you can select other printer 
drivers connected with selected printer.
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e Click Port tab.
f Click Configure Port... button.
g Check if Printer Name or IP Address: is the IP address on the network 

configuration Sheet.
3 Change the printer port's IP address if it is different from the network 

information report's.
If you  want to use the software installation CD to change the port IP, 
connect to a network printer. Then reconnect the IP address.

 

- For a Static network environment

The machine uses the static address when the computer is configured 
to static address.

For example,

If the computer’s network information is as shown below:

▪ IP address: 169.254.133.42

▪ Subnet Mask: 255.255.0.0

Then the machine’s network information should be as below:

▪ IP address: 169.254.133.43

▪ Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

▪ Gateway: 169.254.133.1

Other problems

If problems occur while using the machine on a network, check the following: 

 

For information on the access point (or wireless router), refer to its own 
user's guide. 

 

• Your computer, access point (or wireless router), or machine may not be 
turned on.

• Check the wireless reception around the machine. If the router is far from 
the machine or there is an obstacle, you might have difficulty receiving the 
signal. 

• Cycle the power for the access point (or wireless router), machine, and 
computer. Sometimes cycling the power can recover network 
communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 

If the computer and the machine are connected on the same network and it 
cannot be found when searching, firewall software might be blocking the 
communication. Refer to the user's guide for the software to turn it off and 
try searching for the machine again.

• Check whether the machine's IP address is allocated correctly. You can 
check the IP address by printing the network configuration report.

• Check whether the access point (or wireless router) has a configured 
security (password). If it has a password, refer to the access point (or wireless 
router) administrator.
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• Check the machine's IP address. Reinstall the machine driver and change the 
settings to connect to the machine on the network. Due to the 
characteristics of DHCP, the allocated IP address could change if the 
machine is not used for a long time or if the access point has been reset.

Register the product's MAC address when you confogure the DHCP server 
on the access point (or wireless router). Then you can always use the IP 
address that is set with the MAC address. You can identify the Mac address 
of your machine by printing a network configuration report (see "Printing a 
network configuration report" on page 134).

• Check the wireless environment. You might not be able to connect to the 
network in the infrastructure environment where you need to type in a 
user's information before connecting to the access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless 
communication types (e.g., Bluetooth) are not supported.

• When using the ad hoc mode, in operating systems such as Windows Vista, 
you might need to set the wireless connection setting every time you use 
the wireless machine. 

• You cannot use infrastructure mode and ad hoc mode at the same time for 
Samsung wireless network machines.

• The machine is within the range of the wireless network.

• The machine is located away from obstacles that could block the wireless 
signal.

Remove any large metal objects between the access point (or wireless 
router) and the machine.

Make sure the machine and wireless access point (or wireless router) are not 
separated by poles, walls, or support columns containing metal or concrete.

• The machine is located away from other electronic devices that may 
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including a microwave 
oven and some Bluetooth devices.

• Whenever the configuration of your access point (or wireless router) 
changes, you must do the product's wireless network setup again.

• The maximum number of device that can be connected via Wi-Fi Direct is 3. 

• If Wi-Fi Direct is ON, the connection between the access point (or wireless 
router) and the machine will be the 802.11b/g interface. 
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Samsung MobilePrint
22 

What is Samsung MobilePrint?

Samsung MobilePrint is a free application that enables users to print photos, 
documents, and web pages directly from your smartphone or tablet. Samsung 
MobilePrint is not only compatible with your Android, Windows and iOS smart 
phones but also with your iPod Touch and tablet PC. It connects your mobile 
device to a network connected Samsung printer or to a wireless printer through 
a Wi-Fi access point. Installing a new driver or configuring network settings isn’t 
necessary – just simply install the Samsung MobilePrint application, and it will 
automatically detect compatible Samsung printers. Besides printing photos, 
web pages, and PDFs, scanning is also supported. If you have Samsung 
multfunction printer, scan any document into a JPG, PDF, or PNG format for 
quick and easy viewing on your mobile device. 
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Downloading Samsung MobilePrint

To download Samsung MobilePrint, go to the application store (Samsung 
Apps, Android Market, App Store, Marketplace) on your mobile device, and just 
search for “Samsung MobilePrint.” You can also visit iTunes for Apple devices 
or Marketplace for Windows devices on your computer.
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Supported Mobile OS 

• Android OS 2.1 or higher 

• iOS 4.0 or higher

• Windows Phone 7 or higher
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Supported devices

• iOS 4.0 or higher: iPod Touch, iPhone, iPad

• Android 2.1 or higher: Galxy S, Galaxy S2, Galaxy Tab, and Android mobile 
devices

• Windows Phone 7 or higher: Samsung Focus, Omnia7, and OmniaW, and 
Windows mobile devices
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AirPrint
 

CLP-41xN Series/CLP-41xNW Series only.
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Setting up AirPrint

Bonjour(mDNS) and IPP protocols are required on your machine to use the 
AirPrint feature. You can enable the AirPrint feature by one of the following 
methods.

1 Check whether the machine is connected to the network.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login in the upper right of the SyncThru™ Web Service website.

4 Type in the ID and Password, then click Login. Type in the below default 
ID and password. We recommend you to change the default password 
for security reasons.

• ID: admin 

• Password: sec00000 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings.

6 Click Raw TCP/IP, LPR, IPP or mDNS .

You can enable the IPP protocol or mDNS protocol.
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Printing via AirPrint

For example, the iPad manual provides these instructions:

1 Open your email, photo, web page, or document you want to print.

2 Touch the action icon( ).

3 Select your printer driver name and option menu to set up.

4 Touch Print button. Print it out.

AirPrint allows you to wirelessly print directly from iPhone, iPad and 
iPod touch running the latest version of iOS.
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Cancelling print job: To cancel the printing job or view the print summary, 

click the print center icon ( ) in multitasking area. You can click cancel in 

the print center.
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Google Cloud Print™
Google Cloud Print™ is a service that allows you to print to a printer using your 

smart phone, tablet, or any other web-connected devices. Just register your 
Google account with the printer, and you are ready to use the Google Cloud 
Print™ service. You can print your document or email with Chrome OS, Chrome 
browser, or a Gmail™/ Google Docs™ application on your mobile device, so you 

don’t need to install the printer driver on the mobile device. Refer to the Google 
website (http://www.google.com/cloudprint/learn/ or http://
support.google.com/cloudprint) for more information about Google Cloud 
Print™.
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Registering your Google account to the printer

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet. 

• You should create your Google account in the advance. 

 

1 Open the Chrome browser.

2 Visit www.google.com.

3 Sign in to the Google website with your Gmail™ address.

4 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

5 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

6 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000 

 

If the network environment is using a proxy server, you need to configure 
the proxy’s IP and port number from Settings > Network Settings > 
Google Cloud Print > Proxy Setting. Contact your network service 
provider or network administrator for more information. 

 

7 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Google Cloud Print.

8 Enter your printer’s name and description.

9 Click Register.

The confirmation pop-up window appears.

 

If you set the browser to block pop-ups, the confirmation window will not 
appear. Allow the site to show pop-ups. 
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10 Click Finish printer registration.

11 Click Manage your printers.

Now your printer is registered with Google Cloud Print™ service.

Google Cloud Print™-ready devices will appear in the list.
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Printing with Google Cloud Print™

The printing procedure varies depending on the application or the device you 

are using. You can see the application list that supports Google Cloud Print™ 
service.

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet. 

 

Printing from an application on mobile device

The following steps are an example of using the Google Docs™ app from 
Android mobile phone.

1 Install the Cloud Print application on your mobile device. 

 

If you do not have the application, download it from the application store 

such as Android Market or App Store. 

 

2 Access the Google Docs™ application from your mobile device.

3 Tap the option  button of the document that you want to print.

4 Tap the send  button.

5 Tap the Cloud Print  button.

6 Set the printing options if you want.

7 Tap Click here to Print.

Printing from the Chrome browser

The following steps are an example of using the Chrome browser.

1 Run Chrome.

2 Open the document or email that you want to print.

3 Click the wrench icon  in the browser’s top right corner.

4 Click Print. A new tab for printing appears.
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5 Select Print with Google Cloud Print.

6 Click the Print button.



3. Useful Setting Menus
This chapter explains how to browse the current status of your machine, and the method of setting for advanced 
machine setup. 

• Before you begin reading a chapter 178
• Information 179
• Layout 180 
• Paper 182
• Graphic 183
• System Setup 184
• Emulation 188
• Image Mgr. 189
• Network 190
• Direct USB 192
• Job Manage 193
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Before you begin reading a chapter
This chapter explains all the features available for this series' models to help users  easily understand the features.

You can check the features available for each model in the Basic Guide (see "Menu overview" on page 25).

The following are tips for using this chapter

• The control panel provides access to various menus to set up the machine or use the machine’s functions. These menus can be accessed by pressing  (Menu).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• For models that do not have the  (Menu) on the control panel, this feature is not applicable (see "Control panel overview" on page 19).

• Some menu names may differ from your machine depending on its options or the models.
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Information
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Information on the control panel.

Item Description

Menu Map
Prints the menu map which shows the layout and 
current settings of this machine.

Configuration Prints a report on the machine's overall configuration.

Supplies Info. Prints supplies’ information page. 

Demo Page
Prints the demo page to check whether your machine is 
printing properly or not.

PCL Font List Prints the PCL font list.

PS Font List Prints the PS font list.

Usage Counter
Prints a usage page. The usage page contains the total 
number of pages printed.

Account
This is used only available when Job Accounting is 
enabled from the SyncThru™ Web Admin Service. You 
can print a report of printout counts for each user.
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Layout
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Layout on the control panel.

Item Description

Orientation

Selects the direction in which information is printed on a 
page.

• Portrait

• Landscape

Common Margin

• Simplex: Sets the margin for one-sided printing.

• Duplex: Sets the margin for double-sided printing.

• Binding: When printing on both sides of the paper, side 
A's margin closest to the binding will be the same as side 
B's margin closest to the binding. Likewise, the sides' 
margins farthest from the binding will be the same. 

MP Tray

Sets the paper margins in multi-purpose tray.

• Simplex: Sets the margin for one-sided printing.

• Duplex: Sets the margins for double-sided printing.

Manual Feeder Sets the paper margins in manual feeder tray.

<Tray X>

Sets the paper margins for the paper trays.

• Simplex: Sets the margin for one-sided printing.

• Duplex: Sets the margins for double-sided printing.

Emulation Mar.

Sets the paper margins for emulation print page.

• Top Margin: Sets the top margin.

• Left Margin: Sets the left margin.

Item Description
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Duplex

To print on both sides of the paper, choose the binding 
edge.

• Off: Disables this option.

• Long Edge

• Short Edge

Item Description
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Paper
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Paper on the control panel.

Item Description

Copies Selects the number of copies.

MP Tray/ [Tray <x>]
• Paper Size: Selects the default paper size.

• Paper Type: Selects the paper type currently loaded 
in the tray.

Paper Source

Sets the default paper tray to use.

 

Auto: You can set the machine to automatically 
to the tray with the same sized paper when the 
tray in use is empty.
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Graphic
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Graphic on the control panel.

Item Description

Resolution
Specifies the number of dots printed per inch (dpi). The 
higher the setting, the sharper printed characters and 
graphics.

Clear Text Prints text darker than on a normal document.

Edge Enhance
It allows user to enhance sharpness of text and graphics 
for improving readability.

Trapping
It reduces the white gap caused by misalignment of color 
channels in color printing mode. Also black text will be 
overprinted on other colors.

Screen
This option allows you to select options to convert a 
continous-tone image into printable binary image.
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System Setup
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > System Setup on the control panel.

Item Description

Date & Time Sets the date and time.

Clock Mode
Selects the format for displaying time between 12 hr 
and 24 hr.

Language
Sets the language of the text that appears on the 
control panel display.

Power Save

Sets how long the machine waits before going to 
power save mode.

When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered.

Wakeup Event

When this option is On, you can wake up the machine 
from the power saving mode with the following 
actions:

• Pressing any button on the control panel.

• Loading paper in a tray.

• Opening or closing the front cover.

• Pulling a tray out or pushing a tray in.

 

If the machine does not have the touch screen, 
you can wake up the machine from the power 
saving mode by pressing any button on the 
control panel regardless of this option’s setting.

 

Job Timeout

When there is no input for a certain period of time, the 
machine cancels the current job. You can set the 
amount of time the machine will wait before canceling 
the job.

Import Setting
Imports data stored on a USB memory stick to the 
machine ("Backing up data" on page 50).

Export Setting
Exports data stored on a USB memory stick to the 
machine ("Restoring data" on page 50).

Altitude Adj.
Optimize print quality according to the machine’s 
altitude ("Altitude adjustment" on page 195).

Item Description
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Humidity Optimizes print quality according to the humidity in the 
environment.

Auto Continue

Determine whether or not the machine continues 
printing when it detects the paper does not match the 
paper settings.

• Off: If a paper mismatch occurs, the machine waits 
until you insert the correct paper.

• On: If a paper mismatch occurs, an error message 
will display. The machine waits for about 30 second, 
then automatically clear the message and continue 
printing.

Auto CR
Allows you to append the required carriage return to 
each line feed, which is useful for Unix or DOS users.

Auto Tray Swi.

Determine whether or not the machine continues 
printing when it detects the paper does not match. For 
example, if both tray 1 and tray 2 are filled with the 
same size paper, the machine automatically prints from 
tray 2 after the tray 1 runs out of paper.

 

This option does not appear if you selected 
Auto for Paper Source from printer driver.

 

Item Description

Paper Substit.

Automatically substitutes the printer driver’s paper size 
to prevent the paper mismatch between Letter and A4. 
For example, if you have A4 paper in the tray but you 
set the paper size to Letter in the printer driver, the 
machine prints on A4 paper and vice versa.

Tray Protect
Decides to use or not use the Auto Tray Swi. feature. If 
you set tray 1 to on, for example, then tray 1 is excluded 
during tray switching.

Print BlankPage
The printer detects the printing data from computer 
whether a page is empty or not. You can set to print or 
skip the blank page.

Item Description
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Maintenance

• CLR Empty Msg.:  This option appears only when 
toner cartridge is empty.

• Supplies Life: Allows you to check how many pages 
are printed and how much toner is left in the 
cartridge.

• TonerLow Alert: If toner in the cartridge has run 
out, a message informing the user to change the 
toner cartridge appears. You can set the option for 
this message to appear or not.

• Paper Stacking: If you use a machine in a humid 
area, or you are using the damp print media caused 
by a high humidity, the print-outs on the output tray 
may be curled and may not be stacked properly. In 
this case, you can set the machine to use this 
function to let print-outs stacked firmly. But, using 
this function will make the print speed slow.

• Ram Disk: Enables/disables RAM disk to manage 
jobs.

Item Description

Eco Setup

Allows you to save print resources and enables eco-
friendly printing (see "Eco printing" on page 45).

• Default Mode: Select whether to turn the Eco mode 
on or off.

 

On Force: Sets the Eco mode on. If a user wants 
to turn the Eco mode off, the user needs to 
enter the password.

 

• Change Temp.: Selects the eco template set from 
the SyncThru™ Web Service.

Vapor Mode You can reduce the amount of water vapor produced 
during printing.

• On: Enables vapor mode.

• Off: Disables vapor mode.

• Auto: Automatically enters vapor mode according 
to time in high humidity environments.

 

Enabling the Vapor Mode option can make the 
printing speed slower.

 

Item Description
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Auto Power Off Turns power off automatically when the machine has 
been in power save mode for the length of time set in 
Auto Power Off > On > Timeout.

 

• To turn the machine on again, press the  

(Power) button on the control panel (make 
sure the main power switch is on).

• If you run the printer driver or Samsung Easy 
Printer Manager, the time automatically 
extends.

• While the machine is connected to the 
network or working on a print job, Auto 
Power Off feature doesn't work.

 

Item Description
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Emulation
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Emulation on the control panel.

Item Description

Emulation Type
The machine language defines how the computer 
communicates with the machine.

Setup Sets the detailed settings for the selected emulation type.
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Image Mgr.
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Image Mgr. on the control panel.

Option Description

Custom Color This menu allows you to adjust contrast, color by 
color.

• Default: Optimizes colors automatically. 

• Print Density: Allows you to manually adjust 
color density for print. Adjust the print density.

It is recommended to use the Default setting for best 
color quality.

Auto Color Reg. The machine virtually prints certain patterned image 
to calibrate the color printing position. This feature 
enhances the colored image sharper and 
clearer,which means the machine prints the colored 
image on the paper more like the one in the monitor.

 

If you have moved the machine, it is strongly 
recommended to operate this menu 
manually.

 

Tone Adjust. • Default: The machine automatically calibrate the 
toner density of machine for the best possible 
color print quality. 
If you select Off, the machine is calibrated by the 
factory default toner density.

• Auto Tone Adj.: Allows you to automatically 
adjust tone for the best possible print quality.

• Cal. ID Sensor: Automatically calculates the 
reduced or worn out supplies like toner or 
machine parts and uses this information to adjust 
the color density. For example, if the yellow toner 
is running out, the machine calculates the amount 
of remaining yellow toner and adjusts color 
density so the printouts are fine.

Option Description
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Network
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Network on the control panel.

 

You can also use this feature from the SyncThru™ Web Service. Open the 
Web browser from your networked computer and type the IP address of 
your machine. When SyncThru™ Web Service opens, click Settings > 
Network Settings (see "Using SyncThru™ Web Service" on page 220).

 

Option Description

TCP/IP (IPv4)

Selects the appropriate protocol and configure 
parameters to use the network environment (see "Setting 
IP address" on page 134).

 

There are lots of parameters to be set. If you are 
not sure, leave as is, or consult the network 
administrator.

 

TCP/IP (IPv6)
Selects this option to use the network environment 
through IPv6 (see "IPv6 configuration" on page 145).

Ethernet Speed

Configure the network transmission speed.

 

Turn the power off and on after you change this 
option.

 

802.1x
You can selects the user authentication for network 
communication. For detailed information consult the 
network administrator.

Wireless
Selects this option to use the wireless network (see 
"Wireless network setup" on page 148).

Clear Setting

Reverts the network settings to the default values.

 

Turn the power off and on.

 

Network Conf.
This list shows information on your machine’s network 
connection and configuration (see "Printing a network 
configuration report" on page 134).

Net. Activate

You can sets whether to use Ethernet on or off.

 

Turn the power off and on after you change this 
option.

 

Option Description
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Http Activate

You can sets whether to use SyncThru™ Web Service or 
not.

 

Turn the power off and on after you change this 
option.

 

WINS

You can configure the WINS server. WINS(Windows 
Internet Name Service) is used in the Windows operating 
system. 

 

Turn the power off and on after you change this 
option.

 

SNMP V1/V2
You can set SNMP (Simple Network Management 
Protocol). Administrator’s can use SNMP to monitor and 
manage machines on the network.

SNTP

You can set SNTP (Simple Network Time Protocol) 
settings. SNTP synchronizes the clocks of the computer 
systems through the Internet (NTP) so there would not be 
a time difference when exchanging data.

Option Description

UPnP(SSDP)

You can set UPnP (SSDP) protocol.

 

Turn the power off and on after you change this 
option.

 

MDNS
You can set mDNS (Multicast Domain Name System) 
settings.

SetIP You can set SetIP settings.

SLP

You can configure SLP (Service Location Protocol) 
settings. This protocol allows host applications to find 
services in a local area network without prior 
configuration.

 

Turn the power off and on after you change this 
option.

 

Option Description
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Direct USB
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

If you want to use this feature, you need to insert a USB memory device into the 
USB memory port on your machine. 

To change the menu options:

• Press  (Menu) > Direct USB on the control panel (see "Using USB memory 
device" on page 48).

Item Description

USB Print
You can directly print files stored on a USB memory 
device.

File Manage
You can delete image files stored on a USB memory 
device one by one or all at once by reformatting the 
device.

Check Space
You can check the amount of memory space available 
for saving documents.
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Job Manage
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 25).

 

To change the menu options:

• Press  (Menu) > Job Manage on the control panel.

Item Description

Active Job Shows the print job lists that are waiting to be printed.

Secured Job Shows the print job lists that are secured on the disk.

Stored Job Shows the print job lists that are stored on the disk.

File Policy
If the memory already has the same name when you 
entered a new file name, you can rename or overwrite it.



4. Special Features
This chapter explains special printing features.

• Altitude adjustment 195
• Entering various characters 196
• Printing features 197
• Using optional device features 213
 

• The procedures in this chapter are mainly based on Windows 7.

• It may be necessary to press OK to navigate to lower-level menus for some models.
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Altitude adjustment
Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

1 High 3
2 High 2
3 High 1
4 Normal

You can set the altitude value from Device Settings in Samsung Easy Printer 

Manager program.

• For Windows and Mac users, you set from Samsung Easy Printer Manager 

> (Switch to advanced mode) > Device Settings, see "Device 
Settings" on page 225.

 

• If your machine is connected to the network, you can set the altitude via 
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 
220).

• You can also set the altitude in System Setup option on the machine’s 
display (see "Machine’s basic settings" on page 28).
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Entering various characters
 

CLP-68xND Series/ CLP-68xDW Series only.

 

As you perform various tasks, you may need to enter names and numbers.

1 

Entering alphanumeric characters

Press the button until the correct letter appears on the display. For example, to 
enter the letter O, press 6, labeled with MNO. Each time you press 6, the display 
shows a different letter, M, N, O, m, n, o and finally 6. To find the letter that you 
want to enter, see "Keypad letters and numbers" on page 196.

 

• You can enter a space by pressing 1 twice.

• To delete the last digit or character, press the arrow button.

 

2 

Keypad letters and numbers

 

• Special character sets may differ from your machine depending on its 
options or the models.

• Some of the follow key values may not appear depending on the job you 
are doing.

 

Key Assigned numbers, letters, or characters

1 @ / . ’ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

* * % ^ _ ~ ! # $ ( ) [ ]

(These symbols are available when you type for network authentication.)

# # = | ? " : { } < > ;

(These symbols are available when you type for network authentication.)
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Printing features
 

• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 42).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

3 

Changing the default print settings

1 Click the Windows Start menu. 

2 Select Control Panel > Devices and Printers.

3 Right-click on your machine.

4 Select Printing preferences.

 

If Printing preferences has a ▶, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences. 

 

4 

Setting your machine as a default machine

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

If Printing preferences has a ▶, you can select other printer drivers 
connected to the selected printer.
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5 

Using advanced print features

 

• See "Features by models" on page 7.

• XPS printer driver: used to print XPS file format. 

- The XPS printer driver can be installed only on Windows Vista OS or 
higher.

- Install optional memory when an XPS job does not print because the 
printer is out of memory.

- You can install the XPS printer driver when you insert the software CD 
into your CD-ROM drive. For windows, select the printer XPS driver in 
the Select Software to Install window.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or click the  button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" 
on page 44).

 

 

Item Description

Multiple Pages per 
Side

Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet. 
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Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.

Booklet Printinga

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 
a booklet.

 

• If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media. 

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see what 
paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or  
mark).

 

• Double-sided 
Printing

• Double-sided 
Printing (Manual)a

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other page of 
the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the Double-sided Printing (Manual) option.

 

Item Description

8 9
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• Double-sided 
Printing

• Double-sided 
Printing (Manual)a

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the control panel of the machine. 
This option is available only when you use the PCL/XPS printer driver.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing. This option is not available when you 
use Double-sided Printing (Manual).

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease the 
document.

Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Item Description
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Watermark

(Creating a 
watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box. 

You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a 
watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Overlaya

This option is available only when you use the PCL/SPL printer driver (see "Software" on page 7).

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Item Description
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Overlaya

(Creating a new page 
overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create. 
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 

C:\Formover).
e Click Save. The name appears on the Overlay List. 
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Overlaya

(Using a page overlay)

a Click the Advanced tab. 
b Select the desired overlay from the Text drop-down list. 
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file you 

want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 
List box. 

d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm printing an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

e Click OK or Print until you exit the Print window. 

Overlaya

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
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Print Mode

(CLP-68xND Series/
CLP-68xDW Series 
only)

 

•  This feature is available only if you have installed the optional memory or mass storage device (HDD) (see "Variety feature" on page 8).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• To enable this feature, check Storage Options (see "Setting Device Options" on page 68).

• Without installing the mass storage device (HDD) in the machine, the Ram Disk feature provides only 3 options: Normal, Proof, and 
Confidential.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the memory. 

- Normal: This mode prints without storing your document in the optional memory. 

- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print the rest of the copies later. 

- Confidential: This mode is used for printing confidential documents. You need to enter a password to print. 

- Store: Select this setting to save a document in the mass storage device (HDD) without printing. 

- Store and Print: This mode is used when printing and storing document at the same time. 

- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer spools the document into the 
mass storage device (HDD) and then prints it from the mass storage device (HDD) queue, decreasing the computer’s work load.

- Print Schedule: Select this setting to print the document at a specified time.

 

• Job Name: This option is used when you need to find a stored file using the control panel.

• User ID: This option is used when you need to find a stored file using the control panel. The user name automatically appears as the 
user name that you use to log on Windows.

• Enter Password: If the Property of the document you selected is secured, you have to enter the password for the document. This 
option is used for loading a stored file using the control panel. 

• Confirm Password: Re-enter the password to confirm it.

 

Item Description
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Job Accounting

This option allows you to print with the given permission.

• User permission: If you check this option, only users with user permission can start a print job.

• Group permission: If you check this option, only groups with group permission can start a print job.

 

• Click the question mark( ) from the upper-right corner of the window and click on any option you want to know about.

• Administrators can enable job accounting and configure permissions in the control panel or SyncThru™ Web Admin Service.

 

a. This option is not available when you use XPS driver.

Item Description
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6 

Using Direct Printing Utility

 

•  Direct Printing Utility may not be available depending on model or 
optional goods (see "Software" on page 7). 

• Available for Windows OS users only.

 

What is Direct Printing Utility?

Direct Printing Utility is a program that sends the PDF files directly to your 
machine to print without having to opening the file.

To install this program:

Download the software from the Samsung website then unpack and install it: 
(http://www.samsung.com > find your product > Support or Downloads).

 

• Optional memory or mass storage device (HDD) should be installed on 
your machine, to print files using this program (see "Variety feature" on 
page 8).

• You cannot print PDF files that are restricted. Deactivate the printing 
restriction feature and retry printing.

• You cannot print PDF files that are restricted by a password. Deactivate 
the password feature, and retry printing.

• Whether or not a PDF file can be printed using the Direct Printing Utility 
program depends on how the PDF file was created.

• The Direct Printing Utility program supports PDF version 1.7 and below. 
For higher versions, you must open the file to print it.

 

Printing

There are several ways you can print using the Direct Printing Utility.

1 From the Start menu select Programs or All Programs > Samsung 
Printers > Direct Printing Utility > Direct Printing Utility.

The Direct Printing Utility window appears.

2 Select your machine from the Select Printer drop-down list and click 
Browse.

3 Select the file you wish to print and click Open.

The file is added in the Select Files section.

4 Customize the machine settings for your needs. 

5 Click Print. The selected PDF file is sent to the machine.
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Using the right-click menu

1 Right-click on the PDF file to print and select Direct Printing.

The Direct Printing Utility window appears with the PDF file is added.

2 Select the machine to use.

3 Customize the machine settings. 

4 Click Print. The selected PDF file is sent to the machine.

7 

Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 
application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.
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Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.

Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 8).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.
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Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 
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Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open an application, and select Print from the File menu

2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your machine from the 
printer list and click Properties.

4 Change the print job properties using the following four tabs displayed 
at the top of the window.

• General: Changes the paper size, the paper type, and the 
orientation of the documents. It enables the duplex feature, adds 
start and end banners, and changes the number of pages per sheet.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Text: Specifies the page margins and set the text options, such as 
spacing or columns.

• Graphics: Sets image options that are used when printing image 
files, such as color options, image size, or image position.
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• Advanced: Sets the print resolution, paper source, and destination.

5 Click Apply to apply the changes and close the Properties window.

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the status of your 
print job.

To abort the current job, click Cancel.

Printing files

You can print many different types of files on your machine using the standard 
CUPS, directly from the command line interface. The CUPS lpr utility allows you 
to do that, but the driver’s package replaces the standard lpr tool by a much 
more user-friendly LPR GUI program.

To print any document file:

1 Enter lpr <file_name> from the Linux shell command line and press 
Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2 In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3 Click OK to start printing.

Configuring Printer Properties

Using the Printer Properties window provided by the Printers configuration, 
you can change the various properties for your machine as a printer.

1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click Properties.

3 The Printer Properties window appears.

The following five tabs display at the top of the window:

• General: Allows you to change the printer location and name. The 
name entered in this tab displays on the printer list in Printers 
configuration.

• Connection: Allows you to view or select another port. If you change 
the machine port from USB to parallel or vice versa while in use, you 
must re-configure the machine port in this tab.

• Driver: Allows you to view or select another machine driver. By 
clicking Options, you can set the default device options.

• Jobs: Shows the list of print jobs. Click Cancel job to cancel the 
selected job and select the Show completed jobs check box to see 
previous jobs on the job list.

• Classes: Shows the class that your machine is in. Click Add to Class 
to add your machine to a specific class or click Remove from Class 
to remove the machine from the selected class.
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4 Click OK to apply the changes and close the Printer Properties window.

9 

Unix printing 

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Features by models" on 
page 7).

 

Proceeding the print job

After installing the printer, choose any of the image, text, or PS files to print.

1 Execute “printui <file_name_to_print>” command.

For example, if you are printing “document1”

printui document1

This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2 Select a printer that has been already added.

3 Select the printing options from the window such as Page Selection.

4 Select how many copies are needed in Number of Copies.

 

To take advantage of the printer features provided by your printer driver, 
press Properties.

 

5 Press OK to start the print job.

Changing the machine settings

The UNIX printer driver Print Job Manager in which the user can select various 
print options in printer Properties.

The following hot keys may also be used: “H” for Help, “O” for OK, “A” for Apply, 
and “C” for Cancel.

General tab

• Paper Size: Set the paper size as A4, Letter, or other paper sizes, according 
to your requirements.

• Paper Type: Choose the type of the paper. Options available in the list box 
are Printer Default, Plain, and Thick.

• Paper Source: Select from which tray the paper is used. By default, it is Auto 
Selection.

• Orientation: Select the direction in which information is printed on a page.

• Duplex: Print on both sides of paper to save paper.
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Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Multiple pages: Print several pages on one side of the paper.

• Page Border: Choose any of the border styles (e.g., Single-line hairline, 
Double-line hairline)

Image tab
In this tab, you can change the brightness, resolution, or image position of your 
document.

Text tab
Set the character margin, line space, or the columns of the actual print output.

Margins tab
• Use Margins: Set the margins for the document. By default, margins are not 

enabled. The user can change the margin settings by changing the values in 
the respective fields. Set by default, these values depend on the page size 
selected.

• Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings tab

Select various options in the JCL and General frames to customize various 
settings. These options are specific to the printer and depend on the PPD file.
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Using optional device features
 

• CLP-68xND Series/ CLP-68xDW Series only.

• Some features may not be available depending depending on model or 
optional goods (see "Variety feature" on page 8).
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From the printer driver

If you install the optional device, you can use advanced printing features, such 
as proofing a job and printing a private job in the Print window. Check the mass 
storage (HDD) or RAM disk option in Device Options, then you can select the 
various features from Print Mode (see "Setting Device Options" on page 68).

1 Open the document you want to print.

2 Select Print from the File menu. The Print window appears. 

3 Select your printer driver from the Select Printer list.

4 Click Properties or Preferences .

5 Click the each tab then select Print Mode.

6 Select the option you want (see "Understanding special printer features" 
on page 199).

11 

From the control panel

If your machine has optional mass storage device (HDD) or ram disk, you can use 

these features from the  (Menu) button> System Setup > Job Manage. 
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Some menus may not appear on the display depending on options or 
models. If so, it is not applicable to your machine.

 

• Active Job: All of the print jobs waiting to be printed are listed in the active 
job queue in the order you sent them to the printer. You can delete a job 
from the queue before printing, or promote a job to print sooner.

• Secured Job: You can print or delete a secured job. Shows the list of secured 
jobs the user has set in the printer driver. You need to enter the user name 
and password set in the printer driver.

• Stored Job: You can print or delete a stored job.

• File Policy: You can choose the file policy for generating file name before 
you proceed with the job through optional memory. If the optional memory 
already has the same name when you entered a new file name, you can 
rename or overwrite it.



5. Useful Management 
Tools

This chapter introduces management tools provided to help you make full use of your machine. 

• Easy Capture Manager 216
• Samsung AnyWeb Print 217
• Samsung Easy Color Manager 218
• Easy Eco Driver 219
• Using SyncThru™ Web Service 220
• Using Samsung Easy Printer Manager 223
• Using Samsung Printer Status 226
• Using the Linux Unified Driver Configurator 228
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Easy Capture Manager
 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows OS users only (see "Software" on page 7).

 

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key. Now you can easily print your captured screen as captured or edited.
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Samsung AnyWeb Print
 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

 

This tool helps you screen-capture, preview, scrap, and print Windows Internet Explorer pages more easily, than when you use an ordinary program. 

Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Samsung Easy Color Manager
Samsung Easy Color Manager helps users do fine adjustments with 6 color tones and other properties, such as brightness, contrast, and saturation. Color tone 
changes can be saved as a profile and can be used from the driver or from inside of the machine.

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

 

Helps Samsung color laser printer users to adjust color as they like.

Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Easy Eco Driver
 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows OS users only (see "Software" on page 7).

 

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing. To use this application, Start Easy Eco Driver before printing job 
checkbox in the printer properties should be checked. 

Easy Eco Driver also allows you simple editing such as removing images and texts, changing fonts, and more. You can save frequently used settings as a preset.

How to use: 

1 Open a document to print.

2 Print the document.

A preview window appears.

3 Select the options you want to apply to the document.

You can see the preview of the applied features.

4 Click Print.
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Using SyncThru™ Web Service
 

• Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

• SyncThru™ Web Service explanation in this user’s guide may differ from 
your machine depending on its options or models.

• Network model only (see "Software" on page 7).

 

1 

Accessing SyncThru™ Web Service

1 Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in 
the address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

Logging into SyncThru™ Web Service

Before configuring options in SyncThru™ Web Service, you need to log-in as an 
administrator. You can still use SyncThru™ Web Service without logging in but 
you won’t have access to Settings tab and Security tab. 

1 Click Login on the upper right of the SyncThru™ Web Service website.

2 Type in the ID and Password then click Login. Type in the below default 
ID and password. We recommend you to change the default password 
for security reasons.

• ID: admin 

• Password: sec00000 

2 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.
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Information tab

This tab gives you general information about your machine. You can check 
things, such as remaining amount of toner. You can also print reports, such as an 
error report.

• Active Alerts: Shows the alerts that have occurred in the machine and their 
severity.

• Supplies: Shows how many pages are printed and amount of toner left in 
the cartridge.

• Usage Counters: Shows the usage count by print types: simplex and 
duplex.

• Current Settings: Shows the machine’s and network’s information. 

• Print information: Prints reports such as system related reports, e-mail 
address, and font reports.

Settings tab

This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network environment. Sets 
options such as TCP/IP and network protocols. 

Security tab

This tab allows you to set system and network security information. You need to 
log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information and also 
enables or disables machine features.

• Network Security: Sets settings for HTTPs, IPSec, IPv4/IPv6 filtering, 802.1x, 
and Authentication servers.

• User Access Control: Classifies users into several groups according to each 
user’s role. Each user’s authorization, authentication and accounting will be 
controlled by the group’s role definition.

Maintenance tab

This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or check 
information.

• License Management: License management provides settings installed 
applications and application license.

• Cloning: You can import or export (transfer) various settings (machine 
setting, network information, address book, etc.) between devices that have 
the Cloning feature in SyncThru™ Web Service.
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3 

E-mail notification setup

You can receive emails about your machine’s status by setting this option. By 
setting information such as IP address, host name, e-mail address and SMTP 
server information, the machine status (toner cartridge shortage or machine 
error) will be sent to a certain person's e-mail automatically. This option may be 
used more frequently by a machine administrator. 
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Settings tab, select Machine Settings > E-mail Notification. 
 

If you have not configured outgoing server environment, go to Settings > 
Network Settings > Outgoing Mail Server(SMTP) to configure network 
environment before setting e-mail notification. 

 

4 Select Enable check box to use the E-mail Notification.

5 Click Add button to add e-mail notification user. 

Set the recipient name and e-mail address(es) with notification items 
you want to receive an alert for.

6 Click Apply.
 

If the firewall is activated, the e-mail may not be sent successfully. In that 
case, contact the a network administrator.

 

4 

Setting the system administrator’s information

This setting is necessary for using the e-mail notification option.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Security tab, select System Security > System Administrator

4 Enter the name of the administrator, phone number, location, and email 
address. 

5 Click Apply. 
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Using Samsung Easy Printer Manager 
 

• This feature may not be available depending on model or optional goods 
(see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Samsung Easy Printer Manager is an application that combines Samsung 
machine settings into one location. Samsung Easy Printer Manager combines 
device settings as well as printing environments, settings/actions and 
launching. All of these features provide a gateway to conveniently use your 
Samsung machine. Samsung Easy Printer Manager provides two different user 
interfaces for the user to choose from: the basic user interface and the advanced 
user interface. Switching between the two interfaces is easy: just click a button.
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Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Easy Printer Manager > Samsung Easy Printer Manager.

For Mac,

Open the Applications folder > Samsung folder > Samsung Easy Printer 
Manager.

The Samsung Easy Printer Manager interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer List displays printers installed on your computer 

and network printers added by network discovery (Windows 
only).
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Select the Help menu or click the  button from the window and click on 
any option you want to know about. 

 

6 

Advanced settings user interface overview

The advanced user interface is intended to be used by the person responsible 
for managing the network and machines.

2

Printer 
information

This area gives you general information about your 
machine. You can check information, such as the machine’s 
model name, IP address (or Port name), and machine status.

 

You can view the online User’s Guide.

 Troubleshooting button: This button opens the 
Troubleshooting Guide when an error occurs. You 
can directly open the necessary section in the user’s 
guide. 

 

3

Application 
information

Includes links for changing to the advanced 
settings(switching UI), refresh, preference setting, summary, 
help, and about.

 

The  button is used to change the user interface 
to the advanced settings user interface (see 
"Advanced settings user interface overview" on 
page 224).

 

4

Quick links Displays Quick links to machine specific functions. This 
section also includes links to applications in the advanced 
settings.

 

If you connect your machine to a network, the 
SyncThru™ Web Service icon is enabled.

 

5

Contents area Displays information about the selected machine, 
remaining toner level, and paper. The information will vary 
based on the machine selected. Some machines do not have 
this feature.

6
Order supplies Click on the Order button from the supply ordering window. 

You can order replacement toner cartridge(s) from online.
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Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

Device Settings

You can configure various machine settings such as machine setup, paper, 
layout, emulation, network, and print information.

Alert Settings (Windows only)

This menu includes settings related to error alerting. 

• Printer Alert: Provides settings related to when alerts will be received.

• Email Alert: Provides options relating to receiving alerts via email.

• Alert History:  Provides a history of device and toner related alerts.

Job Accounting

Provides querying of quota information of the specified job accounting user. 
This quota information can be created and applied to devices by job accounting 
software such as SyncThru™ or CounThru™ admin software.
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Using Samsung Printer Status 
The Samsung Printer Status is a program that monitors and informs you of the 
machine status. 

 

• The Samsung Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "Specifications" on page 102).

• Available for Windows OS users only (see "Software" on page 7).
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Samsung Printer Status overview

If an error occurs while operating, you can check the error from the Samsung 
Printer Status. Samsung Printer Status is installed automatically when you install 
the machine software. 

You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might occur 
in the future. For example, it might be in toner low 
status, which may lead to toner empty status. 

Error The machine has at least one error.

1

Toner Level You can view the level of toner remaining in each 
toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.
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2 Option You can set printing job alert related settings. 

3
Order Supplies You can order replacement toner cartridge(s) from 

online.

4

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting 
Guide when an error occurs. You can directly 
open the troubleshooting section in the 
user’s guide. 

 

5 Close Close the window.
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Using the Linux Unified Driver Configurator
The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified Driver 
Configurator (see "Installation for Linux" on page 130).

After the driver is installed on your Linux system, the Unified Driver Configurator 
icon will automatically be created on your desktop.

8 

Opening Unified Driver Configurator

1 Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2 Click each button on the left to switch to the corresponding 
configuration window.

1 Printer Configuration 
2 Port Configuration 
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 To use the on screen help, the Help or  button from the window.

 

3 After changing the configurations, click Exit to close the Unified Driver 
Configurator.

9 

Printers configuration

Printers configuration has the two tabs: Printers and Classes.

Printers tab

View the current system’s printer configuration by clicking on the machine icon 
button on the left side of the Unified Driver Configurator window.

1 Switches to Printers configuration.

2 Shows all of the installed machines.

3 Shows the status, model name, and URI of your machine.



Using the Linux Unified Driver Configurator

2305.  Useful Management Tools

The printer control buttons are, as follows:

• Refresh: Renews the available machines list.

• Add Printer: Allows you to add a new machines.

• Remove Printer: Removes the selected machine.

• Set as Default: Sets the current selected machine as a default machine.

• Stop/Start: Stops/starts the machine.

• Test: Allows you to print a test page to ensure the machine is working 
properly.

• Properties: Allows you to view and change the printer’s properties. 

Classes tab

The Classes tab shows a list of available machine classes.

• Refresh: Renews the classes list.

• Add Class: Allows you to add a new machine class.

• Remove Class: Removes the selected machine class.

1 Shows all of the machine classes.

2
Shows the status of the class and the number of machines 
in the class.
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Ports configuration

In this window, you can view the list of available ports, check the status of each 
port and release a port that is stalled in a busy state when its owner has 
terminated the job for any reason.

• Refresh: Renews the available ports list.

• Release port: Releases the selected port.

1 Switches to Ports configuration.

2 Shows all of the available ports.

3
Shows the port type, device connected to the port, and 
status.



6. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Paper feeding problems 233
• Power and cable connecting problems 234
• Printing problems 235
• Printing quality problems 239
• Operating system problems 247
 

 For errors that occur  during the wireless software installation and settings, refer to the 
troubleshotting section in the wireless setting chapter (see "Troubleshooting for wireless 
network" on page 167).
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Paper feeding problems

Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, use the 
manual feeding in tray.

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the front cover and remove any debris.

Envelopes skew or fail to feed correctly. Ensure that the paper guides are against both sides of the envelopes.
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Power and cable connecting problems

 Click this link to open an animation about solving power problems.

 

 

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

• Connect the machine to the electricity supply first. If the machine has a  (Power) button on the control, press it. 

• Disconnect the machine’s cable and reconnect it.

../common/swf/jam_tray1.htm
../common/swf/jam_tray1.htm
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Printing problems

Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Connect the machine to the electricity supply first. If the machine has a  (Power) 

button on the control, press it. 

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The cover is not closed. Close the cover.

• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 81).

• No paper is loaded. Load paper (see "Loading paper in the tray" on page 31).

• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 62).

• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 62).

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 18).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.
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The machine does not 
print.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 
materials from the wrong 
paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening printing preferences" on page 43). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 44).

A print job is extremely 
slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening printing preferences" on 
page 43). See the printer driver help screen (see "Using help" on page 44).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.

Or, ensure that the paper size in the printer driver settings matches the paper selection 
in the software application settings you use (see "Opening printing preferences" on 
page 43).

The machine prints, but 
the text is wrong, 
garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

Condition Possible cause Suggested solutions
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The wrong printer driver was selected. Check the application’s printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 
blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

• See "Redistributing toner" on page 60.

• See "Replacing the toner cartridge" on page 62.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 
print PDF files correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Before printing, the 
machine emits vapor near 
the output tray.

Using damp paper can cause vapor during 
printing.

This is not a problem. Just keep printing.

Condition Possible cause Suggested solutions
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The machine does not 
print custom-sized paper, 
such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening printing preferences" on page 43).

The printed billing paper 
is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thin (see "Opening printing preferences" on page 43).

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, there 
might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 62).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 74).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
74). If these steps do not correct the problem, contact a service representative.

The top half of the paper is 
printed lighter than the rest of 
the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 43).
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Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 74).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 74).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick (see "Opening 
printing preferences" on page 43).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 74).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 74).

If these steps do not correct the problem, contact a service representative.

Condition Suggested solutions
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Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the toner cartridge and 
install a new one (see "Replacing the toner cartridge" on page 62).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
74). If these steps do not correct the problem, contact a service representative.

Black or color background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old toner cartridge and install a new one (see "Replacing the toner cartridge" on page 62).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 60).

Toner smear • Clean the inside of the machine (see "Cleaning the machine" on page 74).

• Check the paper type and quality.

• Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on page 62).

Condition Suggested solutions
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Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install a new one (see 
"Replacing the toner cartridge" on page 62).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams 
on the reverse side. Printing on seams can cause problems.
Or select Thick from the Printing Preferences window (see "Opening printing preferences" on page 43).

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences (see "Opening printing preferences" on page 43). Ensure the correct paper type is selected. For example: 
If Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 60).

Toner particles are around bold 
characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 43).

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, an overcharging 
can occur causing this copy quality problem.

Condition Suggested solutions

A
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Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested solutions
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Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 74).

Solid color or black pages • The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 62).

• The machine may require repairing. Contact a service representative.

Condition Suggested solutions
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Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 74).

• Check the paper type, thickness, and quality.

• Remove the toner cartridge and then, install a new one (see "Replacing the toner cartridge" on page 62).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 62).

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested solutions
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Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening printing preferences" on page 43).

• An unknown image 
repetitively appears on a few 
sheets

• Loose toner

• Light print or contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for your machine (see 
"Altitude adjustment" on page 195).

Condition Suggested solutions
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Operating system problems
1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 
“Exception OE”, “Spool 32”, or 
“Illegal Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.
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2 

Common Mac problems

 

 

 

Refer to the Mac User’s Guide that came with your computer for further information on Mac error messages.

 

Condition Suggested solutions

The machine does not print PDF files 
correctly. Some parts of graphics, text, or 
illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Mac with 
Acrobat Reader 6.0 or higher, colors 
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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3 

Common Linux problems

condition Suggested solutions

The machine does not print. • Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the Printers tab 
in Printers configuration window to look at the list of available machines. Make sure that your machine is displayed 
on the list. If not, open Add new printer wizard to set up your device.

• Check if the machine is started. Open Printers configuration and select your machine on the printers list. Look at the 
description in the Selected printer pane. If its status contains Stopped string, press the Start button. After that normal 
operation of the machine should be restored. The “stopped” status might be activated when some problems in printing 
occurred.

• Check if your application has special print option such as “-oraw”. If “-oraw” is specified in the command line parameter, 
then remove it to print properly. For Gimp front-end, select “print” -> “Setup printer” and edit command line parameter 
in the command item.

Some color images come out all black. This is a known bug in Ghostscript (until GNU Ghostscript version 7.05) when the base color space of the document is 
indexed color space and is converted through CIE color space. Because Postscript uses CIE color space for Color Matching 
System, you should upgrade Ghostscript on your system to at least GNU Ghostscript version 7.06 or later. You can find 
recent Ghostscript versions at www.ghostscript.com.

Some color images come out in 
unexpected colors.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.xx) when the base color space of the document is 
indexed RGB color space and it is converted through CIE color space. Because Postscript uses CIE color space for Color 
Matching System, you should upgrade Ghostscript on your system to at least GNU Ghostscript version 8.xx or later. You 
can find recent Ghostscript versions at www.ghostscript.com.

The machine does not print whole pages, 
and output is printed on half the page.

It is a known problem that occurs when a color machine is used on version 8.51 or earlier of Ghostscript, 64-bit Linux OS, 
and has been reported to bugs.ghostscript.com as Ghostscript Bug 688252.The problem is solved in AFPL Ghostscript v. 
8.52 or above. Download the latest version of AFPL Ghostscript from http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.
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Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

I encounter error “Cannot open port 
device file” when printing a document.

Avoid changing print job parameters (via LPR GUI, for example) while a print job is in progress. Known versions of CUPS 
(Common UNIX Printing System) server break the print job whenever print options are changed and then try to restart the 
job from the beginning. Since Unified Linux Driver locks the port while printing, the abrupt termination of the driver keeps 
the port locked and unavailable for subsequent print jobs. If this situation occurs, try to release the port by selecting 
Release port in Port configuration window.

When printing a document over the 
network in SuSE 9.2, the printer does not 
print.

The CUPS (Common UNIX Printing System) version distributed with SuSE Linux 9.2 (cups-1.1.21) has a problem with ipp 
(Internet Printing Protocol) printing. Use the socket printing instead of ipp or install later version of CUPS (Common UNIX 
Printing System) (cups-1.1.22 or higher).

condition Suggested solutions
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4 

Common PostScript problems

The following situations are PS language specific and may occur when several printer languages are used.

 

 

Problem Possible cause Solution

The PostScript file cannot be 
printed

The PostScript driver may not be installed 
correctly.

• Install the PostScript driver (see "Software Installation" on page 127).

• Print a configuration page and verify that the PS version is available for 
printing.

• If the problem persists, contact a service representative.

Limit Check Error report prints The print job was too complex. You might need to reduce the complexity of the page or install more memory.

A PostScript error page prints The print job may not be PostScript. Make sure that the print job is a PostScript job. Check to see whether the software 
application expected a setup or PostScript header file to be sent to the machine.

The optional tray is not 
selected in the driver

The printer driver has not been configured to 
recognize the optional tray.

Open the driver properties, select the Device Options tab, and set the tray option 
(see "Setting Device Options" on page 68).

When printing a document in 
Mac with Acrobat Reader 6.0 or 
higher, colors print incorrectly

The resolution setting in the printer driver may 
not be matched with the one in Acrobat Reader.

Make sure that the resolution setting in your printer driver matches the one in 
Acrobat Reader.
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Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung products, contact 
the Samsung customer care center.

Country/Region Customer Care Center Web Site

ALBANIA 42 27 5755 www.samsung.com

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555 www.samsung.com

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA
0810-SAMSUNG (7267864, € 
0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555 www.samsung.com

BAHRAIN 8000-4726 www.samsung.com

BELARUS 810-800-500-55-500 www.samsung.com

BELGIUM

02-201-24-18 www.samsung.com/be 
(Dutch)

www.samsung.com/
be_fr (French)

BOLIVIA 800-10-7260 www.samsung.com

BOSNIA 05 133 1999 www.samsung.com

BRAZIL
0800-124-421

4004-0000

www.samsung.com

BULGARIA 07001 33 11 www.samsung.com

CAMEROON 7095-0077 www.samsung.com

CANADA

1-800-SAMSUNG (726-7864) www.samsung.com/ca

www.samsung.com/
ca_fr (French)

CHILE
800-SAMSUNG (726-7864)

From mobile 02-482 82 00

www.samsung.com

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

COTE D’LVOIRE 8000 0077 www.samsung.com

CROATIA 062 SAMSUNG (062 726 7864) www.samsung.com

CYPRUS 8009 4000 only from landline www.samsung.com

CZECH REPUBLIC

800-SAMSUNG (800-726786) www.samsung.com

Samsung Electronics Czech and Slovak, s.r.o., Oasis Florenc, 
Sokolovská 394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 08000-726786 www.samsung.com

Country/Region Customer Care Center Web Site

http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com/be
http://www.samsung.com/be_fr
http://www.samsung.com/be
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com/ca
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com/ca_fr
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com


Contact SAMSUNG worldwide

253 Contact SAMSUNG worldwide

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY
01805 - SAMSUNG (726-7864 € 
0,14/min)

www.samsung.com

GEORGIA 8-800-555-555 www.samsung.com

GHANA
0800-10077

0302-200077

www.samsung.com

GREECE

80111-SAMSUNG (80111 726 
7864) only from land line

(+30) 210 6897691 from mobile 
and  land line

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-27919267 www.samsung.com

HONG KONG

(852) 3698-4698 www.samsung.com/hk

www.samsung.com/
hk_en/

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

INDIA

1800 1100 11

3030 8282

1800 3000 8282

1800 266 8282

www.samsung.com

INDONESIA
0800-112-8888

021-5699-7777

www.samsung.com

IRAN 021-8255 www.samsung.com

ITALY 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 (GSM:7799) www.samsung.com

KENYA 0800 724 000 www.samsung.com

KOSOVO +381 0113216899 www.samsung.com

KUWAIT 183-2255 www.samsung.com

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

Country/Region Customer Care Center Web Site

http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
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http://www.samsung.com/hk
http://www.samsung.com/hk_en/
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http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
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Contact SAMSUNG worldwide

254 Contact SAMSUNG worldwide

MALAYSIA 1800-88-9999 www.samsung.com

MACEDONIA 023 207 777 www.samsung.com

MEXICO 01-800-SAMSUNG (726-7864) www.samsung.com

MOLDOVA 00-800-500-55-500 www.samsung.com

MONGOLIA www.samsung.com

MONTENEGRO 020 405 888 www.samsung.com

MOROCCO 080 100 2255 www.samsung.com

NIGERIA 0800-726-7864 www.samsung.com

NETHERLANDS
0900-SAMSUNG (0900-7267864) 
(€ 0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 786) www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG (726-7864) www.samsung.com

PANAMA 800-7267 www.samsung.com

PERU 0-800-777-08 www.samsung.com

Country/Region Customer Care Center Web Site

PHILIPPINES

1-800-10-SAMSUNG(726-7864) 
for PLDT

1-800-3-SAMSUNG(726-7864) for 
Digitel

1-800-8-SAMSUNG(726-7864) for 
Globe

02-5805777

www.samsung.com

POLAND
0 801-1 SAMSUNG (172-678)

+48 22 607-93-33

www.samsung.com

PORTUGAL 808 20-SAMSUNG (808 20 7267) www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

ROMANIA

08010 SAMSUNG (08010 726 
7864) only from landline

(+40) 21 206 01 10 from mobile 
and land line

www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com

SENEGAL 800-00-0077 www.samsung.com

SERBIA 0700 SAMSUNG (0700 726 7864) www.samsung.com

SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com

SLOVAKIA 0800-SAMSUNG (0800-726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
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http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
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SOUTH AFRICA 0860-SAMSUNG (726-7864) www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 678) www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

SWITZERLAND

0848-SAMSUNG (7267864, CHF 
0.08/min)

www.samsung.com/ch

www.samsung.com/
ch_fr(French)

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN
0800-329-999

0266-026-066

www.samsung.com

TANZANIA 0685 88 99 00 www.samsung.com

THAILAND
1800-29-3232

02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

UGANDA 0800-300 300 www.samsung.com

U.K 0330 SAMSUNG (7267864) www.samsung.com

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

UKRAINE

0-800-502-000 www.samsung.com/ua

www.samsung.com/
ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Region Customer Care Center Web Site

http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com/ch
http://www.samsung.com
http://www.samsung.com/ch_fr
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.ua
http://www.samsung.com/ua_ru
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com
http://www.samsung.com


256 Glossary

Glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 
802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 
Mbps. 802.11b/g/n devices may occasionally suffer interference from 
microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 
wireless communication devices together on wireless local area networks 
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 
feed an original sheet of paper so that the machine can scan some amount of the 
paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Mac (1984) and is now 
deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 
color of a single pixel in a bitmapped image. Higher color depth gives a broader 
range of distinct colors. As the number of bits increases, the number of possible 
colors becomes impractically large for a color map. 1-bit color is commonly 
called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file format 
on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 
address automatically. This is usually done in the bootstrap process of 
computers or operating systems running on them. The BOOTP servers assign 
the IP address from a pool of addresses to each client. BOOTP enables 'diskless 
workstation' computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 
Locking mechanism is also used to hold the CCD module to prevent any damage 
when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 
selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 
instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 
example, 5% coverage means that an A4 sided paper has about 5% image or text 
on it. So, if the paper or original has complicated images or lots of text on it, the 
coverage will be higher and at the same time, a toner usage will be as much as 
the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 
data between disparate applications. The file format, as it is used in Microsoft 
Excel, has become a de facto standard throughout the industry, even among 
non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 
automatically feed and turn over an original sheet of paper so that the machine 
can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 
reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 
protocol. A DHCP server provides configuration parameters specific to the DHCP 
client host requesting, generally, information required by the client host to 
participate on an IP network. DHCP also provides a mechanism for allocation of 
IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 
a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 
with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 
runs back and forth on the page and prints by impact, striking an ink-soaked 
cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 
printing. Generally, higher DPI results in a higher resolution, more visible detail 
in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 
service which enables a user to use a single telephone line to answer several 
different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer equipped with 
a Duplex Unit can print on both sides of paper during one print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 
month. Generally the printer has the lifespan limitation such as pages per year. 
The lifespan means the average capacity of print-outs, usually within the 
warranty period. For example, if the duty cycle is 48,000 pages per month 
assuming 20 working days, a printer limits 2,400 pages a day.
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ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 
fax machines or fax modems. It automatically detects and corrects errors in the 
fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 
that the second system behaves like the first system. Emulation focuses on exact 
reproduction of external behavior, which is in contrast to simulation, which 
concerns an abstract model of the system being simulated, often considering its 
internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, and frame 
formats and protocols for the media access control (MAC)/data link layer of the 
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 
was included in the original Mac (1984) and is now deprecated by Apple in favor 
of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 
third party device such as a coin operated device or a card reader. Those devices 
allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol (such as the Internet or an 
intranet).

Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 
a heat roller and a pressure roller. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the paper 
permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

A connection between computer networks, or between a computer network 
and a telephone line. It is very popular, as it is a computer or a network that 
allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image when color 
images are converted to grayscale; colors are represented by various shades of 
gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 
colored areas consist of a large number of dots, while lighter areas consist of a 
smaller number of dots.

Mass storage device (HDD)

Mass storage device (HDD), commonly referred to as a hard drive or hard disk, is 
a non-volatile storage device which stores digitally-encoded data on rapidly 
rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 
non-profit, professional organization for the advancement of technology 
related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 
type on the end of the parallel cable that attaches to the peripheral (for example, 
a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of an 
organization's information or operations with its employees. Sometimes the 
term refers only to the most visible service, the internal website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 
identify and communicate with each other on a network utilizing the Internet 
Protocol standard.
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IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 
rate indicates the number of single-sided sheets a printer can complete within 
one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 
well as managing print jobs, media size, resolution, and so forth. IPP can be used 
locally or over the Internet to hundreds of printers, and also supports access 
control, authentication, and encryption, making it a much more capable and 
secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 
networking protocol used by the Novell NetWare operating systems. IPX and 
SPX both provide connection services similar to TCP/IP, with the IPX protocol 
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 
primarily designed for local area networks (LANs), and is a very efficient protocol 
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 
standard-setting body composed of representatives from national standards 
bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 
established to standardize and regulate international radio and 
telecommunications. Its main tasks include standardization, allocation of the 
radio spectrum, and organizing interconnection arrangements between 
different countries to allow international phone calls. A -T out of ITU-T indicates 
telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 
no loss of accuracy or quality, which was designed for compression of binary 
images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 
method of lossy compression for photographic images. It is the format used for 
storing and transmitting photographs on the World Wide Web.



Glossary

262 Glossary

LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 
querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 
of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 
network adapter. MAC address is a unique 48-bit identifier usually written as 12 
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 
and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 
functionality in one physical body, so as to have a printer, a copier, a fax, a 
scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the amount of 
data that needs to be transmitted between the fax machines to transfer the 
image recommended by ITU-T T.4. MH is a codebook-based run-length 
encoding scheme optimized to efficiently compress white space. As most faxes 
consist mostly of white space, this minimizes the transmission time of most 
faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-
T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 
demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 
encodes the first scanned line using MH. The next line is compared to the first, 
the differences determined, and then the differences are encoded and 
transmitted.
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NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the network 
protocols were based on the archetypal Xerox XNS stack. Today NetWare 
supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 
print using a laser beam emitted from a laser printer, and it is usually green or 
rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 
in the printer, and it should be replaced appropriately since it gets worn from 
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 
which is copied, reproduced or translated to produce others, but which is not 
itself copied or derived from something else.

OSI

Open Systems Interconnection (OSI) is a model developed by the International 
Organization for Standardization (ISO) for communications. OSI offers a 
standard, modular approach to network design that divides the required set of 
complex functions into manageable, self-contained, functional layers. The layers 
are, from top to bottom, Application, Presentation, Session, Transport, Network, 
Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 
developed by HP as a printer protocol and has become an industry standard. 
Originally developed for early inkjet printers, PCL has been released in varying 
levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems for representing two dimensional documents in a device 
independent and resolution independent format.
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PostScript

PostScript (PS) is a page description language and programming language used 
primarily in the electronic and desktop publishing areas. - that is run in an 
interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 
printer.

Print Media

The media like paper, envelopes, labels, and transparencies which can be used 
in a printer, a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 
a printer works, meaning the number of pages a printer can produce in one 
minute.

PRN file

An interface for a device driver, this allows software to interact with the device 
driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 
public circuit-switched telephone networks which, on industrial premises, is 
usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 
user authentication and accounting. RADIUS enables centralized management 
of authentication data such as usernames and passwords using an AAA 
(authentication, authorization, and accounting) concept to manage network 
access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 
the greater the resolution.
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SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 
printers, serial ports, and miscellaneous communications between nodes on a 
network. It also provides an authenticated Inter-process communication 
mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 
across the Internet. SMTP is a relatively simple, text-based protocol, where one 
or more recipients of a message are specified, and then the message text is 
transferred. It is a client-server protocol, where the client transmits an email 
message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 
wireless devices in a WLAN use the same SSID in order to communicate with 
each other. The SSIDs are case-sensitive and have a maximum length of 32 
characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 
which part of the address is the network address and which part is the host 
address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 
communications protocols that implement the protocol stack on which the 
Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 
such as job status, transmission result and number of pages sent. This report can 
be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 
format. TIFF describes image data that typically come from scanners. TIFF 
images make use of tags, keywords defining the characteristics of the image that 
is included in the file. This flexible and platform-independent format can be 
used for pictures that have been made by various image processing 
applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 
toner. Toner is a powder used in laser printers and photocopiers, which forms 
the text and images on the printed paper. Toner can be fused by by a 
combination of heat/pressure from the fuser, causing it to bind to the fibers in 
the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 
scanner with a TWAIN-compliant program, a scan can be initiated from within 
the program. It is an image capture API for Microsoft Windows and Apple Mac 
operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 
in Window NT and other Microsoft products. The format of a UNC path is: 
\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what protocol to 
use, the second part specifies the IP address or the domain name where the 
resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike the 
parallel port, USB is designed to concurrently connect a single computer USB 
port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 
when viewed by transmitted light. Watermarks were first introduced in Bologna, 
Italy in 1282; they have been used by papermakers to identify their product, and 
also on postage stamps, currency, and other government documents to 
discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 
provide the same level of security as that of a wired LAN. WEP provides security 
by encrypting data over radio so that it is protected as it is transmitted from one 
end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 
introduced in Windows Me and Windows XP. A scan can be initiated from within 
these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 
computer networks, which was created to improve upon the security features of 
WEP.



Glossary

267 Glossary

WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 
home users. A shared key, or password, is configured in the wireless access point 
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 
key for each session between a wireless client and the associated WAP for more 
advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 
network. If your wireless access point supports WPS, you can configure the 
wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 
(PDL) and a new document format, which has benefits for portable document 
and electronic document, developed by Microsoft. It is an XML-based 
specification, based on a new print path and a vector-based device-
independent document format.
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